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CHAPTER 1

Introduction
Flare Desktop's workspace is flexible, uses a modern Multiple Document Interface (MDI), and gives
you several options to work the way that you want. This manual focuses on some of the more
important parts of the workspace. For more information about other areas of the interface, see the
Help system.

Main Interface Areas and Activities

n "Main Sections of the Interface" on page 7

n "Start Page" on page 12

n "Primary Window Panes" on page 17

n "Primary Editors" on page 74

n "Primary Dialogs" on page 173

n "Ribbons and Toolbars" on page 236

n "Customizing the Workspace" on page 359
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CHAPTER 2

Main Sections of the Interface
The user interface consists of the following major sections:

n Top—Ribbons This area is used to access features.
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n Left—Explorers and Window Panes This is the default location for many different explorers
and window panes (e.g., Content Explorer, Project Organizer), which can be used to create,
open, and view various elements in the project.
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n Middle—Editors and Start Page This is the default location for the many editors in Flare
Desktop (e.g., XML Editor, TOC Editor, Stylesheet Editor), which are used to enter and design
the vast majority of the content for your project. It also displays some window panes (e.g.,
File List, Analysis Summary window) and the Start Page, which is used for quickly performing
high-level tasks and accessing information.
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n Right—Window Panes Like the left side, this is the default location for many different window
panes (e.g., Dynamic Help, Styles window pane).
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n Bottom—Window Panes This is the default location for yet more window panes (e.g., Builds
window pane).

For the most part, the explorers and window panes on the edges of the interface are used to
support the work that you do in the middle. You have the flexibility to close or move elements
around as you like, so it is not mandatory that every window pane remain permanently in its default
location.
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CHAPTER 3

Start Page
The Start Page is a handy window pane that displays when you first launch Flare Desktop and
remains open unless you close it. You can use the Start Page to open and create projects, view the
Help system, and see news and updates. If you do not see it, select View > Start Page.
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This chapter discusses the following:

Page Options on Left 14

License Expiration Banner 15

Responsive to Window Size 16
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Page Options on Left
A series of options on the left side of the Start Page can be used to access different information or
perform specific actions.

n Your Work Displays recent files, with a filter field at the top.

n Resources Displays various resources, which you can click to see more information.

n Open Lets you open an existing Flare project.

n New Project Opens the wizard so that you can create a new Flare project.
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License Expiration Banner
Depending on your type of license (e.g., subscription, maintenance, trial), a banner displays when a
deadline for renewing or purchasing is approaching. You can click a link to take action (e.g., Contact
Sales). If you have more than 90 days left, you will not see a banner.

Subscription

Maintenance

Trial
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Responsive to Window Size
The layout of the Start Page changes depending on the size of the window.

For example, if the window is large, the page options are shown on the left, and the information
banner is at the top. But if the window is reduced in size, the page options are shown at the top, and
the information banner is at the bottom. A horizontal bar might also appear if the window becomes
narrow enough.
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CHAPTER 4

Primary Window Panes
Flare Desktop has numerous window panes in the interface that are used for a variety of purposes.
The two panes that you are likely to use most are the Project Organizer and Content Explorer.

Some of these panes are located by default on the left side of the workspace, some on the right
side, some in the middle, and some at the bottom.

If more than one window pane is open in the same location in the interface, the panes are organized
in an accordion or tab structure. This means they are stacked on top of each other, with the active
window pane displayed in front of the others. You can click any accordion bar or tab to bring that
particular window pane in front so you can work in it.

Certain window panes are most commonly used in Flare Desktop.

This chapter discusses the following:

Content Explorer 18

Project Organizer 32

File List Window Pane 44

Styles Window Pane 53

Builds Window Pane 63
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Content Explorer
The Content Explorer (along with the Project Organizer) is one of the most often used areas of the
Flare Desktop interface. Just as it sounds, the Content Explorer is used to hold all of the content-
related items in your project—both topics and non-topic files.

TIP You can drag and drop files from Windows into the Content Explorer.

TIP If you have a content file open and want to quickly find where it is stored in the Content
Explorer, you can right-click the file and select Locate in Explorer. You can also open the
Project ribbon and click Locate in Explorer. Flare Desktop opens the Content Explorer,
expanding folders to show where the file is located.

TIP You can quickly insert a text hyperlink to a file (e.g., topic, image, snippet) in the
Content Explorer. To do this, click and drag the destination file from the Content Explorer to
the location in the topic where you want to insert it. As you drag the file into the topic, a
vertical red bar acts as a guide to help you place the link in the topic. When you release the
mouse button, the Insert Hyperlink dialog opens. You can modify any fields in the dialog (if
necessary) and click OK to insert the hyperlink.

NOTE If you are working with HTML Help and import a RoboHelp project that has been
merged with other CHM files or includes shortcut controls, the linked files are placed in a
special subfolder in the Content Explorer (Resources > CHMSupport).

NOTE If you import Microsoft Word documents containing embedded images into a
project, Flare Desktop places copies of those image files in subfolders within the
Resources > Images folder. This is done in order to avoid naming conflicts with embedded
images from other Word documents that you might import. The subfolders are named after
the Word documents being imported.
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Opening the Content Explorer
You can open the Content Explorer from the View ribbon or via shortcut keys.

How to Open the Content Explorer
Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Content Explorer.

n Keyboard Shortcut Press CTRL+J on your keyboard.
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Where Content Files are Stored
You can store new content files anywhere you like in the Content Explorer, either in the root Content
folder or in any subfolders under it.

We recommend that you store non-topic content files in subfolders under Resources.
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Non-Topic File Type Recommended Default Folder in Content Explorer

Branding Resources > Branding

Image Resources > Images

Micro Content Resources > MicroContent

Multimedia Resources > Multimedia

Page Layout Resources > PageLayouts

Snippet Resources > Snippets

Stylesheet Resources > Stylesheets

Table Stylesheet Resources > TableStyles

Template Page Resources > TemplatePages
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What You Can Do in the Content Explorer
Following are the primary tasks that you can perform in the Content Explorer.

Feature Description

3D Models (Insert) You can click on a U3D file in the Content Explorer and drag it to the
XML Editor. This inserts a 3D model into that file.

Audio (Insert) You can click on an audio file in the Content Explorer and drag it to the
XML Editor. This creates an audio object.

Branding (Add/Open) You can double-click the Branding.css file to open the Branding Editor.
This is a stylesheet that specifically holds branding elements in your
project for editing items such as colors, font, logo, and hero image.

Cross-References
(Insert)

You can click on a topic file in the Content Explorer and drag it to the
XML Editor. This creates a cross-reference.

Folders (Add) In order to keep your topics and other files organized and easier to find,
you can create subfolders in the Content Explorer and move topics into
them.

Images (Insert) You can click on an image file in the Content Explorer and drag it to the
XML Editor. This inserts the image.

Images (Add/Open) You can open an image that you have added to your project. When you
open the image, it displays in the Image Viewer within Flare Desktop.
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Feature Description

Micro Content
(Add/Open)

Micro content is short, concise information that stands alone and is
easily consumable. In Flare Desktop, it begins with the creation of a
collection of brief phrases and corresponding responses, such as
questions and answers. After generating HTML5 output, these
phrase/response combinations can be used in different ways as users
interact with your output. For example, it can greatly improve the user
experience when people search in your HTML5 output. It can also be
used to create field-level context-sensitive Help. 

Movies (Insert) You can click on a movie file in the Content Explorer and drag it to the
XML Editor. This inserts the movie.

Page Layouts
(Add/Open)

A page layout is used for page specifications (e.g., size, margins) and
to apply certain content (e.g., headers, footers, page numbers) to many
(or all) topics in print-based output. It allows for easy configuration
through the use of content frames, bleeds, crop marks, registration
marks, margins, padding, alignment features, and more. You might
create multiple page layouts for different purposes (e.g., title page,
TOC, chapters, appendix). Page layouts are similar to template pages,
but are more flexible and easier to use. The general rule is that page
layouts are recommended for print-based output, and template pages
continue to be the best method for automatically adding headers,
footers, breadcrumbs, and more in multiple topics for online output.
Another difference between page layouts and template pages is that
page layouts can be used for Adobe PDF, Microsoft Word or Microsoft
PowerPoint, whereas template pages can be used only for Microsoft
Word when creating print-based output. 

Properties Dialog
(Open)

You can open the properties dialog for individual content items by
selecting them and clicking . From the Properties dialog you can
perform a variety of tasks, depending on the type of file you selected.
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Feature Description

Snippets (Add/Open) A snippet is a chunk of formatted content that is heavily used in single-
sourcing. Snippets can include text, tables, images, and whatever else
can be included in a normal topic. You can insert snippets into one or
more topics throughout your project, thus allowing you to reuse
content that is maintained in one place. You can even insert them into
other snippets, creating nested snippets. Snippets are not usually
intended for single words or very short phrases that change frequently.
In those cases, you probably want to use variables instead.

Snippets (Insert) You can click on a snippet file in the Content Explorer and drag it to the
XML Editor. This inserts the snippet.

Stylesheets
(Add/Open)

A stylesheet is a file with a .css extension (cascading stylesheet) that
holds styles, properties, and values. You need to apply a stylesheet at
the project, target, or file level if you want to use the styles in the
associated topics, snippets, or template pages.

Table Stylesheets
(Add/Open)

This is a stylesheet that lets you create and use different styles that
pertain specifically to tables in your project. Using a table stylesheet
makes it easier to have multiple looks for tables throughout your
project.

Template Pages
(Add/Open)

A template page lets you automatically apply certain content—such as
breadcrumbs, menus, toolbars, search bars, footer text, or mini-TOCs—
to multiple topics in the output. A template page is primarily used in
online outputs. However, it can be used in Word output as well. For
Word output, a template page lets you determine page specifications
(such as size or orientation) and to apply certain content (e.g., header
text or page numbers) to many topics in a manual. For print-based
outputs other than Word, page layouts are used instead of template
pages.
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Feature Description

Topics (Add/Open) A topic is a file containing information about a particular subject.
Topics might be the most important part of a project. Everything else is
contained within topics (e.g., cross-references, text, images) or points
toward topics (e.g., tables of contents). The very reason end users
open a Help system or manual is to find information, a little direction.
They find that help within individual topics.

TIP When adding a new file to the Content Explorer, the recommended method is to right-
click on the folder in the Content Explorer and use the New menu option. This is the most
efficient way to direct the new file to the folder where you want to store it. That's because
the Add File dialog opens when you add a new content file, and this method ensures that
the folder you want is already selected in that dialog.
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Buttons and Sections of the Content Explorer
Option Description

Toggles between showing or hiding the subfolders in the Content
Explorer.

Splits the Content Explorer into two halves. When you select a
folder on the left side, the folders and files within it are shown on
the right side. Also, you can select multiple files on the right side,
which lets you perform the same action on all of them at the
same time.

You can use the down arrow to view the files on the right in a list
format or in a tile format.

Expands all of the folders so that you can see all of the files
under each one.

Collapses all of the folders so that you can no longer see all of
the files under each one.

Lets you show or hide the small squares next to each folder and
file, which are used to show colors representing condition tags
that have been applied.

Moves up one folder in the hierarchy. This button becomes
enabled if you use the Split View button and select a file or
folder on the right side of the split view.

Refreshes the window pane so that the latest information is
shown.

Opens the selected item.
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Option Description

Opens the Properties dialog for the selected item.

Creates a new custom folder, which you can use to organize your
files.

Opens the Add File dialog, which lets you create a new topic or
import one from outside the project.

Lets you limit the files that are displayed by file format.

n All Files Displays all files.

n Topic Files Displays only the topic (HTM and HTML) files.

n Template Page Files Displays only the template page
(FLMSP) files.

n Page Layout Files Displays only the page layout (FLPGL)
files.

n Snippet Files Displays only the snippet (FLSNP) files.

n Micro Content Files Displays only the micro content
(FLMCO) files.

n Stylesheet Files Displays only the stylesheet (CSS) files.

n Image Files Displays only the image files.

n Multimedia Files Displays only multimedia (audio, video,
and 3D model) files.

n GIF Files Displays only GIF files.

n JPEG Files Displays only JPG and JPEG files.

n PNG Files Displays only PNG files.

n Flash Movie Files Displays only SWF files.

CHAPTER 4  27



Option Description

Displays the color of condition tags that are associated with the
file (if any). Condition tags are used to determine specific content
or files to be included in some targets but not in others.

n Git and Subversion This indicates that the file has been
modified. You can commit the file when you are ready. If
your project is bound to Subversion, you can commit the
file when you are ready (if you are the user who has
modified it, or if you have stolen the lock on the file from
another user).

n Perforce Helix Core This indicates that the file has been
checked out from source control. You can submit the file
when you are ready (if you are the user who has checked it
out).

n TFS and VSS This indicates that the file has been checked
out from source control. You can check in the file when you
are ready (if you are the user who has checked it out).

This indicates that you have a file in your project but have not yet
added it to the integrated source control application. This might
occur, for example, if you create a new topic and do not add the
file to source control during the topic creation process. To
resolve this, simply right-click on the file and select Source
Control > Add.

This indicates that the file is added to source control but is not
currently checked out, which means that it contains a "Read Only"
designation in its properties. In order to edit the file, you must
check it out from source control.

You will see this icon if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.
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Option Description

This indicates that another user has locked the file. You will often
see this icon in conjunction with the icon, indicating that
another user is both using the file and has locked the file. You
can make changes to this file even if another user has locked it.

If your project is bound to Subversion and you need to commit
the file in while another user is working on it, you can steal their
lock. To do this, right-click on the file and select Source Control >
Lock. In the Lock dialog, select Steal the lock, then click Lock.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce Helix Core, or Subversion.

This indicates that you have locked the file. You will often see
this icon in conjunction with the icon, indicating that you have
both locked and modified the file. Other users can make changes
to this file even if you have locked it.

If your project is bound to Subversion, other users can steal your
lock.

If you are using Team Foundation Server, you can lock a file
when you check it out.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, or Perforce Helix Core, or Subversion.
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Option Description

n Perforce Helix Core and Subversion This indicates that the
file is currently being modified by another user. You will
often see this icon in conjunction with the icon,
indicating that another user is both using the file and has
locked the file.

n TFS This indicates that the file is currently checked out to
another user. You can send a request to the user, asking
that person to check in the file so that you can check it out.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce Helix Core, or Subversion.

This indicates that the file is not current (i.e., the local copy of the
file is older than the source control copy). This might happen if
another user checks out the file, makes changes to it, and checks
it back in to source control. If this occurs, you can check the file
out or get the latest version of the file from source control.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce Helix Core, or Subversion.

This indicates that a file has been renamed, but not modified in
any other way. If you make any additional changes to the file,
such as editing the text or adding a condition tag, the renamed
icon is replaced by a icon.

You will see this icon if your project is bound to Subversion.

This indicates that the file is deleted from source control, but you
still have a copy of the file on your local machine. If necessary,
you can add the file to source control.

You will see this icon if your project is bound to Microsoft Team
Foundation Server.
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Option Description

This indicates that the file is mapped to an external resource or
SharePoint file.

[Preview Bar] This is the area at the bottom of the Content Explorer. When you
click on a folder or file, this bar shows its name, size, and last
modified date.

When you click on an image file, a small copy of that image is
shown, as well as its resolution and dimensions.

If you have set the online or print DPI for an image using MadCap
Capture, these values are also shown.
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Project Organizer
The Project Organizer (along with the Content Explorer) is one of the most often used areas of the
Flare Desktop interface. Just as it sounds, the Project Organizer contains and organizes all of your
project-related files.

TIP If you have a project file open and want to quickly find where it is stored in the Project
Organizer, you can right-click the tab of the file and select Locate in Explorer. You can also
open the Project ribbon and click Locate in Explorer. Flare Desktop opens the Project
Organizer, expanding folders to show where the file is located.

TIP You can drag and drop files from Windows into the Project Organizer.
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Opening the Project Organizer
You can open the Project Organizer from the View ribbon or via shortcut keys.

How to Open the Project Organizer
Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Project Organizer.

n Keyboard Shortcut Press CTRL+[ on your keyboard.
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What You Can Do in the Project Organizer
Following are the primary tasks that you can perform in the Project Organizer.

Feature Description

Auto Suggestion List
Files (Add/Open)

When you first start typing content in a topic, a popup may display
below your text as you type. This is the Auto Suggestion feature,
which analyzes text as you type and compares it to other content (e.g.,
phrases, variables, snippets) that already exists in the project. This
means you can quickly select existing content from the popup so that
you do not have to finish typing it.

Browse Sequences
(Add/Open)

If you have several topics that you think end users should read in
order, you can create browse sequences. When users view the
compiled Help system, they can use your browse sequences to
"browse" through topics in a particular order.

Conditions
(Add/Open/Apply)

A condition tag set is used to hold condition tags you create for your
project. A condition is a single-sourcing feature that you can apply to
files or different areas of your content. Conditions can determine
whether certain information displays in some outputs but not in
others. You can also control whether content displays on a certain
device or screen size. If you want to apply a condition to content, you
can click and drag it from the Project Organizer to the content in the
XML Editor.

Confluence—Import
File (Add/Open)

A Confluence import file is used to import Atlassian Confluence pages
into a project.

Context-Sensitive
Help—Alias Files
(Add/Open)

An alias file is used to populate a header file with the information
necessary for producing context-sensitive Help (CSH). In Flare
Desktop, you can open an alias file and use the Alias Editor to create
and assign identifiers for the header file.
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Feature Description

Context-Sensitive
Help—Header Files
(Add/Open/Export)

A header file is a simple text file that contains basic information about
connecting the dialogs or windows in a software application to the
corresponding topics in the Help system. Both you and the software
developer need access to this file.

DITA—Import File
(Add/Open)

A DITA import file is used to import DITA file content into a project.

Excel—Import File
(Add/Open)

An Excel import file is used to import Excel files into a project.

Export File
(Add/Open)

An export file is used to export an entire Flare project, or parts of one,
to another location.

File Tag Sets
(Add/Open)

A file tag set is used to assign "tags" to topics and any other files in
Flare, even folders. You can use file tags for many different purposes,
such as assigning authors or milestones to topics. Flare Desktop lets
you generate reports based on the tags that are assigned. This makes
project development easier to track, manage, and schedule.

Flare Project—Import
File (Add/Open)

A Flare project import file is used to import Flare files from other
projects.

Folders (Create) When you add project files, they are added to various folders in the
Project Organizer. As your list of files grows, it may become
somewhat difficult to find a specific file when you want to work on it.
In order to keep your files organized and easier to find, you can create
subfolders in the Project Organizer and move files into them.

FrameMaker—Import
File (Add/Open)

A FrameMaker import file is used to import FrameMaker documents
into a project.
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Feature Description

Glossaries
(Add/Open)

A glossary is a feature that you can add to your output to help users
understand the meaning of individual terms.

HTML—Import File
(Add/Open)

An HTML import file is used to import HTML files into a project.

Indexes—Auto-
Indexes (Add/Open)

An auto-index lets you automatically add words and phrases in your
project to a generated index, rather than inserting the index markers
manually. In the Project Organizer, you can add and open an auto-
index phrase set.

Indexes—Link Sets
(Add/Open)

This is an index entry that links to another index entry. There are three
kinds of index links: "See," "See Also," and "Sort As." In the Project
Organizer, you can add and open an index link set.

Language Skins
(Add/Open)

Flare Desktop provides language skins for certain languages, such as
French, German, and Spanish (i.e., many values are already
translated). These languages are identified as being "localized" skins.
You can edit these default translations by creating a language skin for
the language. For languages that do not provide default translations,
you can create language skins so they can be applied to the output
too.

Meta Tag Sets
(Add/Open)

You can add meta tag sets to your project to set up a schema of meta
tags to be used at various file levels.

Publishing
Destinations
(Add/Open)

A publishing destination is a project file that contains the information
needed for publishing output (i.e., copying the files) to another
location (such as a website or a directory on your computer).
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Feature Description

Relationship Tables
(Add/Open)

A relationship table is an element used to link related topics together.
It is similar to concept links or related topics links. Although a
relationship table is a common feature in DITA, you do not need to be
using DITA or know anything about DITA in order to take advantage of
relationship tables. 

Reports (Add/Open) From the Reports folder in the Project Organizer, you can generate
custom reports based on information contained in your project. In
addition, you can design the look and feel of reports, save them for
future access, and open them in a browser window (where you can
print them). 

Search—Filter Sets
(Add/Open)

A search filter lets users narrow their search based on concepts that
you have inserted into topics. Concepts are simply keyword markers
that you insert into topics that have some kind of relationship with
each other. They are also used for inserting concept links into topics.

Search—Synonym
Files (Add/Open)

A synonym file lets you create synonyms for terms in your project so
that users are more likely to find the information they need when
performing searches.

Skins (Add/Open) A skin is a file that contains information about the appearance of the
output window.

Tables of Contents
(Add/Open)

In many cases, Flare Desktop provides you with an initial table of
contents (TOC), which you further develop using the TOC Editor.

Targets (Add/Open) A target is one instance of an output type. When you build your final
output, you are essentially building one or more of the targets in your
project. You can add regular targets, as well as batch targets.
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Feature Description

Variables
(Add/Open/Insert)

A variable set is a file that holds one or more variables. A variable is a
small piece of plain text or auto-generated content that can be edited
in one place but used in many places throughout your project.
Variables are especially useful for text that might change frequently,
such as version numbers and dates. Variables are stored in variable
sets, which can hold multiple variables. Depending on the template
you select when creating a project, Flare Desktop may provide you
with an initial variable set, but you can add as many additional variable
sets and variables as you like. You can expand the variable sets in the
Project Organizer to see the variables within them. If you want to
insert a variable into a document, you can click and drag it from the
Project Organizer to the XML Editor. 

Word—Import File
(Add/Open)

A Word import file is used to import Microsoft Word documents into a
project.

NOTE You can right-click files in the Project Organizer and perform tasks from the context
menu. For example, you can select "Open with" and open the selected file in another
application (e.g., Notepad++).
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Buttons and Sections of the Project Organizer
Option Description

Toggles between showing or hiding the folders in the Project Organizer.

Splits the Project Organizer into two halves. When you select a folder on the
left side, the folders and files within it are shown on the right side. Also, you
can select multiple files on the right side, which lets you perform the same
action on all of them at the same time.

Expands all of the folders so that you can see all of the files under each one.

Collapses all of the folders so that you can no longer see all of the files under
each one.

Lets you show or hide the small squares next to each folder and file, which
are used to show colors representing condition tags that have been applied.

Moves up one folder in the hierarchy. This button becomes enabled if you
use the Split View button and select a file or folder on the right side of
the split view.

Creates a new custom folder, which you can use to organize your files.

Displays the color of condition tags that are associated with the file (if any).
Condition tags are used to determine specific content or files to be included
in some targets but not in others.
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Option Description

n Git and Subversion This indicates that the file has been modified. You
can commit the file when you are ready. If your project is bound to
Subversion, you can commit the file when you are ready (if you are the
user who has modified it, or if you have stolen the lock on the file from
another user).

n Perforce Helix Core This indicates that the file has been checked out
from source control. You can submit the file when you are ready (if you
are the user who has checked it out).

n TFS and VSS This indicates that the file has been checked out from
source control. You can check in the file when you are ready (if you are
the user who has checked it out).

This indicates that you have a file in your project but have not yet added it to
the integrated source control application. This might occur, for example, if
you create a new topic and do not add the file to source control during the
topic creation process. To resolve this, simply right-click on the file and
select Source Control > Add.

This indicates that the file is added to source control but is not currently
checked out, which means that it contains a "Read Only" designation in its
properties. In order to edit the file, you must check it out from source control.

You will see this icon if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.
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This indicates that another user has locked the file. You will often see this
icon in conjunction with the icon, indicating that another user is both using
the file and has locked the file. You can make changes to this file even if
another user has locked it.

If your project is bound to Subversion and you need to commit the file in
while another user is working on it, you can steal their lock. To do this, right-
click on the file and select Source Control > Lock. In the Lock dialog, select
Steal the lock, then click Lock.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce Helix Core, or Subversion.

This indicates that you have locked the file. You will often see this icon in
conjunction with the icon, indicating that you have both locked and
modified the file. Other users can make changes to this file even if you have
locked it.

If your project is bound to Subversion, other users can steal your lock.

If you are using Team Foundation Server, you can lock a file when you check
it out.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, or Perforce Helix Core, or Subversion.

n Perforce Helix Core and Subversion This indicates that the file is
currently being modified by another user. You will often see this icon in
conjunction with the icon, indicating that another user is both using
the file and has locked the file.

n TFS This indicates that the file is currently checked out to another
user. You can send a request to the user, asking that person to check
in the file so that you can check it out.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce Helix Core, or Subversion.
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This indicates that the file is not current (i.e., the local copy of the file is older
than the source control copy). This might happen if another user checks out
the file, makes changes to it, and checks it back in to source control. If this
occurs, you can check the file out or get the latest version of the file from
source control.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce Helix Core, or Subversion.

This indicates that a file has been renamed, but not modified in any other
way. If you make any additional changes to the file, such as editing the text
or adding a condition tag, the renamed icon is replaced by a icon.

You will see this icon if your project is bound to Subversion.

This indicates that the file is deleted from source control, but you still have a
copy of the file on your local machine. If necessary, you can add the file to
source control.

You will see this icon if your project is bound to Microsoft Team
Foundation Server.

Advanced Holds various types of files for different features.

Conditional
Text

Holds the condition tag sets that you add to the project. You can expand the
condition tag sets to see the conditions within them, and you can drag those
conditions to content in the XML Editor.

Destinations Holds the publishing destinations that you add to the project.

Glossaries Holds the glossaries that you add to the project.
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Exports Holds export files that you add to the project. These are used to export your
Flare project (or parts of it) to another location.

Imports Holds import files that you add to the project.

Reports Holds reports that you create in order to track information in your project.

Skins Holds the skins and skin components that you add to the project.

Targets Holds the targets that you add to the project. You can add as many targets
to a project as you need. In addition to regular targets, you can add batch
targets, which are used to generate multiple targets in one batch.

TOCs Holds the tables of contents that you add to the project.

Variables Holds the variable sets that you add to the project. You can expand the
variable sets to see the variables within them, and you can drag those
variables to content in the XML Editor.

[Preview Bar] This is the area at the bottom of the Project Organizer. When you click on a
file or folder, this bar shows an icon, as well as the name of the folder or file.
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File List Window Pane
The File List window pane lets you view all of the content files in your project. You can limit the files
that are displayed by using the file type filter (e.g., click the Filter drop-down and select Snippet
Files).

You can also perform certain tasks from this window pane, such as opening files, applying
condition tags, applying stylesheets, and dragging files to an editor (e.g., XML Editor). And because
you can select multiple files from the list, you can perform some of these tasks for all of the
selected files at the same time.
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Opening the File List Window Pane
You can open the File List window pane from the View ribbon or via shortcut keys.

How to Open the File List Window Pane
Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > File List.

n Keyboard Shortcut Press CTRL+R.
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What You Can Do in the File List Window Pane
Following are the tasks that you can perform in the File List window pane. You can hold the SHIFT
key to select a range, or you can hold the CTRL key to select individual items. For more details and
steps for each, see the Help system.

Feature Description

3D Models (Insert) You can click on a U3D file in the File List window pane and drag it to
the XML Editor. This inserts a 3D model into that file.

Audio (Insert) You can click on an audio file in the File List window pane and drag it to
the XML Editor. This creates an audio object.

Browse Sequence
Entries (Add)

You can click on a topic file in the File List window pane and drag it to
the Browse Sequence Editor. This adds an entry in the browse
sequence to that topic.

Column Information
(Customize)

You can configure the way that the information in the window pane is
shown. For example, you can hide or show certain columns, set a
background color for a column, or increase the width for a column.

Condition Tags
(Apply)

You can apply condition tags to files.

Cross-References
(Insert)

You can click on a topic file in the File List window pane and drag it to
the XML Editor. This creates a cross-reference to that topic.

Data (Export) You can export all or selected data from the File List window pane to a
comma-separated value (CSV) file. This can be quite useful since there
are several columns of data in the window pane.

File Tags (Associate) You can associate tags with files.
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Images (Insert) You can click on an image file in the File List window pane and drag it
to the XML Editor. This inserts the image.

Language (Select) You can select a language to be used.

Movies (Insert) You can click on a movie file in the File List window pane and drag it to
the XML Editor. This inserts the movie.

Read Only You can mark files as "Read Only" so that they cannot be modified.

Related Topics Link
(Insert)

You can click on multiple topic files in the File List window pane and
drag them to the XML Editor. This opens the Insert Related Topics
Control dialog, which lets you create a related topics link.

Snippets (Insert) You can click on a snippet file in the File List window pane and drag it
to the XML Editor. This inserts the snippet.

Source Control (View
Checked Out or
Modified Files)

You can use the Pending Changes window pane and the Source
Control Explorer to view all of the files that you have checked out and
need to check in. You can use the File List window pane and Pending
Changes window pane to view files that are checked out by other
users. If you are using Git or Subversion, you will see files you have
modified.

Stylesheets (Apply) You can apply a stylesheet to topics, snippets, and template pages.

Table of Contents
Entries (Add)

You can click on a topic file in the File List window pane and drag it to
the TOC Editor. This adds an entry in the table of contents to that topic.

Title (Add) You can specify a title for a topic.
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Buttons and Sections of the File List Window
Pane
Option Description

Opens the Columns dialog, which lets you configure the way the
column information is shown.

Opens the selected item.

Opens the Properties dialog for the selected item.

Refreshes the window pane so that the latest information is
shown.

Exports all of the data in the window pane to a comma-separated
value (CSV) file.

Exports only the selected data in the window pane to a comma-
separated value (CSV) file.
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Lets you limit the files that are displayed by file format.

n All Files Displays all files.

n Topic Files Displays only the topic (HTM and HTML) files.

n Template Page Files Displays only the template page
(FLMSP) files.

n Page Layout Files Displays only the page layout (FLPGL)
files.

n Snippet Files Displays only the snippet (FLSNP) files.

n Micro Content Files Displays only the micro content
(FLMCO) files.

n Stylesheet Files Displays only the stylesheet (CSS) files.

n Image Files Displays only the image files.

n Multimedia Files Displays only multimedia (audio, video,
and 3D model) files.

n GIF Files Displays only GIF files.

n JPEG Files Displays only JPG and JPEG files.

n PNG Files Displays only PNG files.

n Flash Movie Files Displays only SWF files.

Displays the color of condition tags that are associated with the
file (if any). Condition tags are used to determine specific content
or files to be included in some targets but not in others.

Name Displays the file name for the item. You can click in this field and
rename the file.

Path Displays the location in the project where the file is stored.
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Size Displays the size of the file.

Date Modified Displays the most recent date and time when the file was
changed.

Status Displays the status of the file, such as whether you have it
checked out. You can also see if another user has a file checked
out.

User Displays the user name. If you see the name of another user in
this column, it means that the file is checked out by that user
through source control.

Title Displays the title for the topic. This title is used in the following
situations:

n Help Control Links The title displays as a selection when
users click Help control links (i.e., related topics links,
concept or "see also" links, and keyword links) that are
associated with that topic.

n Window Title Bar If the topic is opened in a new window or
outside of the project, the display title is shown in the title
bar of that window.
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Description Displays the meta description for the file. Description meta tags
contain brief summaries of web pages and are recognized by all
major search engines. These tags might not factor into the
search rankings by all search engines, but they are still useful for
search engine optimization in web-based outputs, because they
can help with the click-through rate in HTML5 output. We
recommend that you create a meta tag set file, which adds an
empty description meta tag by default. This is faster than adding
it separately to each topic. This meta tag then becomes available
at lower file levels (including topics), and you can then provide
the value in the topic properties.

Class Displays the topic style class associated with the topic. The
properties for this style class will be applied to the entire topic.

Stylesheet Displays the stylesheet associated with the file.

Conditions Displays the condition tags associated with the file.

Language Displays the language associated with the file.

Dimensions Displays the size of image files.

Resolution Displays the resolution of image files.

Searchable Indicates whether the topic is to be included in searches or not.
This setting can be adjusted in the Properties dialog for the topic.

[File Tags] If you create file tag sets, these will be displayed in columns with
the tag names associated with each file.
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[Preview Bar] This is the area at the bottom of the File List window pane. When
you click on a file, this bar shows its name, size, and last
modified date.

When you click on an image file, a small copy of that image is
shown, as well as its resolution and dimensions.

If you have set the online or print DPI for an image using MadCap
Capture, these values are also shown.
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Styles Window Pane
The Styles window pane displays styles, classes, and identifiers (IDs) contained in the stylesheets
that are associated with the current content file. You can select any of the items in the window
pane to apply that style with the selected content in the open file.
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Opening the Styles Window Pane
You can open the Styles window pane from the View ribbon or via shortcut keys.

How to Open the Styles Window Pane
Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > Style Window.

n Keyboard Shortcut Press F12.
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What You Can Do in the Styles Window Pane
Following are the primary tasks that you can perform in the Styles window pane:

Feature Description

Apply You can apply a style (including a class or ID) to selected content. To
do this, click the style in the Styles window pane to apply it to the
selected content in the XML Editor. Classes are preceded by a period,
and IDs are preceded by a hash (#).

Create You can create a new style class or ID, which you can then apply to
content. To do this, click the Create Style button.

Edit You can modify the settings for the style currently applied to the
selected content. To do this, click the Edit Style button.

Pin You can pin your favorite styles to keep them displayed at the top of
the list.
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Buttons and Sections of the Styles Window
Pane
Option Description

[Style] Displays the style applied to the selected content in the XML Editor.

Edit Style Opens the Stylesheet Editor, with the current style already selected, allowing you
to quickly edit it.

Create Style Opens the Create Style dialog, which lets you create a new class or ID based on
the properties already applied to the selected content.
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Available
Styles

Displays the styles that can be applied to the selected content in the XML Editor.
To apply a style, click on it once.

When applying styles to content, you may notice from time to time that the style
you are looking for is not available from the drop-down list or Styles window
pane when you try to select it.

This can occur if the style exists in a particular medium (e.g., print) but not in the
default medium. So if you are working in the XML Editor with the medium set to
default and you attempt to apply that style to content, you won't see it in the
selection list with all of the other styles. To correct this, make sure the style
exists in the default medium as well.

Another possible reason for this has to do with the location of the cursor in the
topic. Flare Desktop realizes where the cursor is placed and knows that only
certain styles should be applied at that location.

EXAMPLE — Lists

Your cursor is on a regular paragraph and you want to apply a list style
to it in order to turn it into the beginning of a bulleted list. Because it is
not yet a list item, but rather a simple paragraph, you won't see your list
style in the Styles window pane when you try to select it. Instead, you
see several paragraph styles. In order to use the list style, you first need
to turn the paragraph into a bulleted list item, by opening the Home
ribbon and clicking the bullet button .

You might notice that if you have your cursor in a list, you only see li (list
item) styles in the window pane, but not the broader ol (ordered list) and
ul (unordered list) styles. To see these other styles, click at the very
beginning of a list item. Then press the left arrow key. This should
switch the Style window pane from showing li styles to the ol and ul
styles. If you have your structure bars on, you'll see why this happens.
When you initially click in a list, the li block bar is highlighted, so Flare
Desktop assumes you want to do something with that style level. After
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you press your left arrow key enough, the next level up (ol or ul)
becomes highlighted. And if you keep pressing the left arrow key, Flare
Desktop highlights the next level of style (e.g., body). Whatever is
highlighted in the structure bar should become available as styles in the
Style window pane.

EXAMPLE — Paragraph and Character Styles

You've selected multiple paragraphs, or your cursor is simply placed
somewhere within a paragraph. In that case, only block-level styles
(such as paragraph styles) are shown in the Styles window pane.

But if you select only a portion of a paragraph, only character styles are
shown in the Styles window pane. So if you expect to be able to choose
a block-level style, such as a paragraph style, you can't; because only a
portion of the paragraph is selected, Flare Desktop thinks you want to
choose a character-level style.

NOTE If you want to see more or less of the top or bottom of the window pane, you can
click the divider and drag it up or down.
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Showing or Hiding Style Previews
When you attempt to apply a style to content using the Style drop-down in the Home ribbon, the
Styles window pane, or the floating Style Picker, previews of the various styles are shown by
default. This gives you an idea of how each style looks before you apply it to the content.
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If you prefer not to see style previews in these areas of the user interface, you can open the Options
dialog (File > Options) and disable the preview on the XML Editor tab. Remove the check mark from
Show style previews in UI.
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With this option disabled, all of the styles will be presented as plain text when you select them.
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Properties Shown on Hover in the Styles
Window Pane
When you have the Styles window pane or floating Style Picker open, you can quickly see all of the
properties set for a style. To do this, just hover the cursor over the style. A popup displays the style
comment (if any), followed by the properties that are set.
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Builds Window Pane
The Builds window pane shows builds from targets as they are generated in the interface.

Opening the Builds Window Pane
The Builds window pane opens automatically when you generate a target. However, you can also
open it manually by selecting View > Builds or Project > Builds.

Characteristics of the Builds Window Pane
Following are some important characteristics of the Builds window pane:

n Rows in the Grid Each row in the grid represents a build that you have initiated for a target. By
default the top row is the most recent build.

n Status/State The Status and State columns in the grid may display any of the following,
depending on the progress of the target build: Running (Building), Finished (Build
Complete/Build Failed), Queued, or Terminated (Canceled).
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n Warnings and Errors The last three columns display the number of warnings and errors for
the target. You can open the build log to see details for the warnings or errors. In addition, if
you have set Flare Desktop to ignore certain warnings—in the Options dialog (File > Options)
or Target Editor—that number is also given.
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n Background Colors The Progress cells display colored backgrounds, depending on what
happens with the build. When a build is in progress, the background is light green. If the build
finishes with no errors (although there may be warnings), the background turns dark green. If
an error prevents the build from finishing, the background is red. If you manually stop the
build, the background is yellow.

Following are descriptions of the three progress columns:

l Build Progress This column indicates the progress of the entire build for a target.

l Compile Progress This column indicates the progress of individual parts of a target's
build.

l Publish Progress This column indicates the progress of a target that is being published
to a destination you have set up.

n Compile Status As a target is generated, the contents of the Compile Status column change
rapidly (e.g., showing the files being processed).
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n Warning for Changed Files Because this feature lets you continue working while targets are
generated, it's possible that you might change a file that is included in a target while it is still
compiling. If that happens, the target continues to build without those changes, but you will
see a warning in the build log to let you know.

If this happens, will your changes make it into the output? That depends on the file(s) that you
changed. Flare Desktop processes your source files in the order that it finds them. So if the
generation process already passed the point where it would have grabbed a particular source
file, your changes from that file will not make it into the output. However, if Flare Desktop's
build process has not yet reach the file in question, then the changes might make it into the
output. You can refer to the warnings you receive in the build log and then look at the files in
the output to see if your changes made it.
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n Build Logs Anytime you build a target, a build log is automatically created. By default it is
stored at the root level of the output folder for that target (e.g., [project]\Output\[user name]\
[target name]). However, in the Options dialog (File > Options) you can choose where your log
file will be stored when you build a target. As an alternative to the default location, you can
choose to place it in the Reports folder of the Project Organizer, or you can select a custom
location.
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A build log file has an .mclog file extension. The next time you generate the target, the old log
file is replaced with a new one.

In the local toolbar of the Builds window pane, you can click Open Build Log to see it in Flare
Desktop. You can then see more details of any warnings or errors you may have gotten when
building the target.

n Batch Targets In addition to single targets, if you build a batch target, the process for each
one is shown in the Builds window pane.
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Toolbar and Context Menu Options in the Builds
Window Pane
Following are actions you can take in the Builds window pane by clicking a button in the local
toolbar. In most cases you can also right-click on a row and select one of these options from the
context menu.

n Clear Finished This clears all rows from the Builds window pane.

n View Output This opens the output for the selected row if the target finished compiling
without errors. You may need to click on the row (to first give the grid focus) in order to see
this option in an enabled state. You can also double-click a row to open the output for a
successful build. Depending on the type of output, you can select the device or browser you
want to use to view the output from a drop-down menu.

n Open Build Log This opens the log file of the selected row so you can see more information
about any issues with the build. You can also double-click a row to open the log file for a
target that failed to build.

n Stop Build This cancels generation of the target. You will see yellow cells as a result.

n Rebuild Target This rebuilds the target for the selected row.

n Build Targets This lets you build multiple targets. Following are the primary benefits of this
feature:

l You do not need to have a Flare project open at all in order to use this feature.

l You can select targets for any Flare project, even if that project is different from one you
happen to have open at the moment.

l This feature functions sort of like a batch target, in that you can choose to build and/or
publish multiple targets. The difference is that, with this feature, you do not need to first
create a batch target file in Flare Desktop.

NOTE Batch targets have their own advantages over this feature. For example,
they allow you to retain your build and publish settings for each target, so that
you can easily reuse them in the future. Also, you can schedule batch targets to
run any time in the future, even if you're not at your computer.

n Open Output Folder This opens the output folder in Windows for the selected row.

n Clean Target This lets you remove the content from the output folder for the selected target.
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Organizing Columns in the Builds Window Pane
You can reorder or hide columns in the Builds window pane. There are a few ways to do this.

n First, you can click on a column header and drag it to the right or left, dropping it in a new
location.
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n Second, you can right-click any column header, which displays a menu. Click next to the
column titles (adding or removing check marks) to show or hide those columns in the Builds
window pane.
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n Third, from the right-click menu, you can select Columns. This opens the Manage Columns
dialog.
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Again, you can show or hide columns by adding or removing check marks next to the column
titles. You can also click and drag the rows up or down to change the order of the columns in
the Builds window pane. Finally, you can click Reset to Factory Settings if you want to undo
all of your changes and return to how everything was initially set.
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CHAPTER 5

Primary Editors
The large middle section of the workspace is typically used to display many different editors,
depending on the type of element you are working on. You can have many editors open at the same
time—even many different pages of the same editor. For example, you can have five different topics
open, each one displayed in a different instance of the XML Editor.

There are many editors that you will see while working in Flare Desktop, but some are most
commonly used.
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This chapter discusses the following:

XML Editor 76

Internal Text Editor 99

Stylesheet Editor 122

TOC Editor 144

Skin Editor 151

Page Layout Editor 159
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XML Editor
The XML Editor is the primary editor for authoring in Flare Desktop. It displays when you open a
topic, snippet, or template page from the Content Explorer, and provides access to the underlying
XML structure of documents in a comfortable visual authoring environment. This editor is used to
enter, modify, and format the content that users see in the output. Although this editor lets you
produce XML files, you do not need to know anything about XML to use it.
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Opening the XML Editor
Accessing the XML Editor is simply done by opening a content file.

How to Open the XML Editor
1. Open the Content Explorer.

2. Navigate to a topic, snippet, or template page.

3. Double-click the file that you want to open.

CHAPTER 5  77



What You Can Do in the XML Editor
In addition to typing content, there are dozens of things you can do in the XML Editor. Following are
some of the primary tasks that you can perform.

Feature Description

Bookmarks
(Insert/Edit)

A bookmark is a marker, or flag, that lets you create hyperlinks to
specific locations within topics (rather than to another topic file in
general). You can insert a bookmark at a specific location in your
topic (e.g., at a subheading) and then insert a hyperlink that
"connects" to that bookmark. This is a useful feature, for example, if
you have a somewhat lengthy topic and want the user to be able to
locate a specific place in the topic quickly.

Characters and
Symbols (Insert)

You can insert special characters or symbols into content. This can
be done by using the Character dialog, by inserting a quick character
that you have specified, by selecting a favorite character, or by
selecting a recent character.

Code Snippets (Insert) You can create and insert code into documentation in dozens of
languages. The syntax is automatically highlighted according to the
language, similar to text editors such as Sublime Text and
Notepad++. In HTML5 output, users can click a Copy button, then
paste the code into a third-party editor.

Condition Tags (Apply) A condition is a single-sourcing feature that you can apply to files or
different areas of your content. Conditions can determine whether
certain information displays in some outputs but not in others. You
can also control whether content displays on a certain device or
screen size.
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Cross-References
(Insert/Edit)

A cross-reference is an automated link that is based on a format with
commands. This method of linking saves time because you don't
have to type the link text each time, or manage it over time if the
destination content changes. Cross-references are recommended
when you are linking from one place in your project to another (as
opposed to linking to external files or websites). The format can be
controlled in your stylesheet. This lets you keep links consistent and
change them in just one place by using the MadCap|xref style (or a
class of it that you have created). Cross-references are also useful for
converting online links to page number references when you are
producing printed output (by having a separate format for the cross-
reference style in the print medium of the stylesheet).

Drop-Down Text
(Insert/Edit)

A drop-down is a feature that lets you click a hotspot to expand and
collapse specified content (paragraphs, lists, images, tables, videos,
etc.) below it.

Equations (Insert/Edit) From any location in a topic or snippet you can insert an equation.
Although an equation may be composed of many different parts, in
the XML Editor it renders as a single block of content. In that way, it
behaves much like an image.

Expanding Text
(Insert/Edit)

Expanding text is a feature that lets you click a hotspot to expand and
collapse content that appears after it in the same paragraph or other
block element.

Formatting—Local
(Apply)

When you edit the content of a topic, you are working in the XML
Editor. Sometimes called “inline formatting,” local formatting is a way
to change the look and feel of content directly so that the changes are
applied only to that specific content (as opposed to applying the
changes throughout your project via the use of styles). However,
using styles is recommended instead of local formatting when
possible.
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Hyperlinks
(Insert/Edit)

A text hyperlink is one of the most basic forms of a link. It is simply a
hyperlink applied to text. When an end user clicks the hyperlink in the
output, the location specified in the hyperlink opens. The location can
be another topic in the project, a place in the current file (such as a
heading or bookmark), or a file outside of the project (such as a
website or PDF on the internet).

Images (Insert/Edit) You can insert images into content files (e.g., topics, snippets). Flare
Desktop supports the following types of raster and vector image
files: BMP, EMF, EPS, EXPS, GIF, HDP, JPG, JPEG, PDF, PNG, PS, SVG,
SWF, TIF, TIFF, WDP, WMF, XAML, XPS.

Index Keywords
(Insert/Edit)

Unlike some features in Flare Desktop, there is no independent index
file in your project that becomes the index in your output. Instead, the
index is automatically generated when you build output, based on
index keywords that you insert into content files in your project.

Keyword Links
(Insert/Edit)

A keyword link is a Help control that lets you open topics related to
the current topic based on index keywords that they share.

Locate in Content
Explorer

If you have a content file open in the XML Editor and want to quickly
find where it is stored in the Content Explorer, you can right-click in
the file and select Locate in Explorer. Flare Desktop opens the
Content Explorer, expanding folders to show where the file is located.

Locate in TOC If you have a topic open in the XML Editor and want to quickly find
where it is linked in a table of contents, you can right-click in the file
and select Locate in TOC. If the topic is located in more than one TOC,
a dialog opens, listing all of those TOCs. Select the TOC you want to
look in and click Open.
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Micro Content (Create) Micro content is short, concise information that stands alone and is
easily consumable. In Flare Desktop, it begins with the creation of a
collection of brief phrases and corresponding responses, such as
questions and answers. After generating HTML5 output, these
phrase/response combinations can be used in different ways as
users interact with your output. For example, it can greatly improve
the user experience when people search in your HTML5 output. It can
also be used to create field-level context-sensitive Help.

Multimedia
(Insert/Edit)

Not only can you explain concepts and tasks to users in your project,
but you can also show and tell them through the use of multimedia
(video and audio). You can insert links to YouTube and Vimeo movies;
files such as Flash, Windows Media, and Quicktime; MadCap Mimic
video files; and 3D models.

Popups (Insert/Edit) A text popup is a link that opens a popup box containing basic text
that you provide. A topic popup is a text hyperlink that opens a topic
or external file (such as a website) in a popup box.

Preview You can quickly see how a topic (as well as a snippet or template
page) will look in the final output by previewing it. The Preview
window pane is dynamic, allowing you to keep the preview open while
you work and see changes as you make them in the XML Editor.
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Proxies (Insert) A proxy acts as a placeholder for auto-generated content or content
that you have created elsewhere. When you build output, the content
takes the place of that proxy. Proxies are used for online output,
especially HTML5 output. However, some proxies can also be used
for print-based outputs, especially to create elements such as
glossaries. Proxies can be added to template pages (most common),
as well as to regular topics. The difference is that a proxy added to a
topic will display that information in the output only once (wherever
the topic occurs), but if a proxy is added to a template page, the
content will show up everywhere that the template page has been
applied.

QR Codes (Insert/Edit) You can insert a quick response (QR) code into a content file (e.g.,
topic, snippet) using the XML Editor. A QR code is a type of barcode
that can be read by devices such as smart phones. The data encoded
in the QR code can be text, a website URL, an email address, contact
information, or SMS (Short Message Service, which is used for
sending text messages). Basically, QR codes are a way to bridge the
gap between a static print document and search-friendly, more
detailed online information at your fingertips.

Related Topics Links
(Insert/Edit)

A related topics link is a Help control that provides users with list of
links to topics that you've specified as being related to the current
topic. This is similar to a concept link. You might use a related topics
link if you are applying it to a topic that you want to associate with
specific topics but you do not plan to reuse the same link in other
topics.
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Responsive Layouts
(Create/Edit)

Styles and media queries can be used to make your content
responsive in HTML5 output. This lets you present information—both
its substance and structure—differently depending on the size of the
screen or device. Flare Desktop provides a Responsive Layout
window pane that helps you create this kind of content more easily.
You also have the option of using third-party solutions (e.g., Zurb
Foundation grid system) by adding the appropriate styles in your
stylesheets and topics.

See Also (Concept)
Links (Insert/Edit)

A concept link is a Help control that lets users open topics that you've
determined are related to the current topic. It is similar to the related
topics link. However, whereas you associate a related topics link with
specific individual topics (usually for a one-time use), you associate a
concept link with a group of topics (to be reused in different topics).
One great benefit of this type of link is that, if you later want to add or
delete topics from the group, you only need to do so in one place and
the changes are applied to every topic containing that concept link.

Slideshows
(Insert/Edit)

You can add a slideshow as an alternative way to display content,
using navigation controls to move from slide to slide to view different
content. Most kinds of content can be placed into a slideshow,
including snippets, text, tables, and more.

Snippets
(Create/Insert/Edit)

A snippet is a chunk of formatted content that is heavily used in
single-sourcing. Snippets can include text, tables, images, and
whatever else can be included in a normal topic. You can insert
snippets into one or more topics throughout your project, thus
allowing you to reuse content that is maintained in one place. You can
even insert them into other snippets, creating nested snippets.
Snippets are not usually intended for single words or very short
phrases that change frequently. In those cases, you probably want to
use variables instead.
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Styles (Apply) If you are using styles in your project, you can change the look of
content simply by applying styles to it.

Tables (Insert/Edit) A table in Flare Desktop is much like it is in any word processing
program, such as Microsoft Word, or in a printed textbook. It is a
group of intersecting columns and rows that you can add to a topic
for various purposes, such as comparing different elements.

Togglers (Insert/Edit) A toggler is a feature that lets users click a hotspot to reveal one or
more named elements in a topic. A named element (also called the
"toggler target") is a chunk of content that can reside anywhere in the
topic. When users click the toggler hotspot, the output reveals hidden
content elements. When users click the hotspot again, the content is
hidden again.

Variables (Insert) A variable is a small piece of plain text or auto-generated content that
can be edited in one place but used in many places throughout your
project. Variables are especially useful for text that might change
frequently, such as version numbers and dates. Variables are stored
in variable sets, which can hold multiple variables. Depending on the
template you select when creating a project, Flare Desktop may
provide you with an initial variable set, but you can add as many
additional variable sets and variables as you like. There are different
kinds of variables: (1) basic ones that you create, (2) custom
date/time variables that you create, (3) system variables (e.g., date
and time; titles; page count; Chapter, Section, and Volume numbers),
(4) Heading variables, and (5) Running Head variables. Some of these
are especially useful for page headers and footers in print-based
output.
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Buttons and Sections—Top of XML Editor
Option Description

This button lets you preview the topic, snippet, or template page. It also
lets you see how the topic will look with condition tags associated with it
or with specific target settings applied to it. If you click the face of the
button, the preview is shown based on the format specified in the
primary target. If you click the down arrow, you can select any of the
targets in your project from a menu. The preview is then displayed using
the output format specified in that target.

In addition, the preview updates as you save changes in your file; when
you open a new content file (i.e., topic, snippet, template page); when
you change the File, Target, or Conditional Expression fields; and when
you click the refresh button .This ensures you are always seeing the
most current content in the Preview window pane.

NOTE The topic preview feature is not available for Microsoft
Word formats.

Opens the Conditional Text dialog, which lets you associate condition
tags with a file while you edit it. This is similar to the feature that you can
use to preview a document with certain conditions set. The difference is
that this associates the conditions to the document as you edit it in the
XML Editor.
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Flare Desktop provides multiple layout modes when working in the XML
Editor: Web Layout, Web Layout (Tablet), Web Layout (Mobile), and Print
Layout. This lets you see your content in the format that you are most
likely concerned about at the moment.

The default and print mediums are tied to the Web Layout and Print
Layout modes, respectively. The tablet and mobile media queries are
tied to the Web Layout (Tablet) and Web Layout (Mobile) modes,
respectively.

The key is to select the layout first. If you select the medium or media
query, the layout will not automatically change as well.

Clicking the down arrow on this button lets you select a medium or
media query so that you can view the topic with a specific set of styles.

This drop-down field is simply intended to show you how particular
styles make a topic look. By using this feature, you are not telling Flare
Desktop to use that medium in the output for that topic. The way to do
that is to associate the medium with a target.

When (multiple) displays, that is an indication that multiple styles are
applied, and content in the XML Editor is rendered with all applicable
styles (according to the width). However, if only one medium is selected,
then that medium is shown in the drop-down.

If you are viewing content using the Print Layout in the XML Editor, you
can use this drop-down in the local toolbar to choose a specific page
layout.

Opens the Insert Hyperlink dialog, which lets you insert a text hyperlink
on the selected text in the topic.
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Opens the Insert Cross-Reference dialog, which lets you insert a cross-
reference into the topic at the location of the cursor.

Opens a dialog, if you click the face of the button. You can use this
dialog to insert an image. If you click the down arrow on the button, a
drop-down opens, where you can access your pinned images and
recently used images.

Opens the Insert Snippet Link dialog, if you click the face of the button.
You can use this dialog to insert a snippet. If you click the down arrow
on the button, the Insert Snippet drop-down opens, where you can
access your pinned snippets and recently used snippets.

Opens the Variables dialog, if you click the face of the button. You can
use this dialog to insert a variable. If you click the down arrow on the
button, a drop-down opens, where you can access your pinned variables
and recently used variables.

Opens the Character dialog, if you click the face of the button. You can
use this dialog to choose a character to insert or perform many other
tasks. If you click the down arrow on the button, you can select other
options, such as inserting a quick character or choosing one of your
favorite or recent characters.

Activates Index Entry Mode. Click in the text where you want to insert the
keyword and start typing. The words you type are added directly into the
Index window pane. Use this method to do a lot of indexing all at once,
without performing any other tasks in the topic or snippet.
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Activates Concept Entry Mode. Click in the text where you want to insert
the keyword and start typing. The words you type are added directly into
the Concept window pane. Use this method to create concepts in a lot of
topics at once, without performing any other tasks in the topic.

Turns paragraph and space markers on and off. When you turn this
feature on, you can see markers that show where paragraphs end and
where space exists before and after content.
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If you click the face of this button, all of the content changes, showing
the XML tags surrounding the content. If you click the down arrow, you
can select the following options.

n
Caret Tag Neighborhood Turns the caret tag neighborhood
feature on and off (it is off by default).

n
Markers Turns markers on or off in the active topic or other
content file.

n
Inline Markers You can show or hide markers for all inline
elements in the active topic.

n Block Structure Bars Shows or hides the tag block bars. These
bars are displayed to the left of the content area. They show the
different tags for your chunks of content (i.e., block-level tags), as
well as the overall tag structure.

n Span Structure Bars Shows or hides the span bars representing
inline tags. These bars are displayed at the top of the content.

n Expand/Collapse Enables or disables the feature to collapse and
expand tags in the XML Editor.

n Horizontal Ruler Shows or hides a measurement ruler horizontally
at the top of the editor or window pane. If you click the ruler after it
is opened, you can select to convert the ruler to pixels, points,
centimeters, inches, or ems.

n Vertical Ruler Shows or hides a measurement ruler vertically at
the left of the editor or window pane. If you click the ruler after it is
opened, you can select to convert the ruler to pixels, points,
centimeters, inches, or ems.

n Layout Resizer Shows or hides the layout resizer at the top of the
editor. When enabled, you can click the controls on the resizing
slider or enter a breakpoint value in pixels, points, centimeters,
inches, or ems to alter the width setting.

n Invisible Tags Turns invisible tags (e.g., <title>) on or off in the
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active topic. This option is enabled only if you have selected "Show
tags."

n Comments Turns comment tags on or off in the active topic.
Comment tags are those that you have added to a topic in order
include notes behind the scenes (without the comments being
seen in the output).

n Thumbnail Images Toggles between showing images in the XML
Editor as thumbnails or at full size. This is a feature for you as the
author, allowing you to scale all images down to 48 pixels high (if
the original size is larger than that). This lets you see more content
and less of your images as you edit topics. The images are only
scaled for your editing purposes; they are not shown as
thumbnails in the output.

n Tags in Mono-Color Lets you choose whether to display tags in a
color or in black. This option is enabled only if you have selected
"Show tags."

n Tags in Mono-Font Lets you choose whether to display all tags in
the same font or in the font actually applied to each area. This
option is enabled only if you have selected "Show tags."

n Object Positioning Turns object positioning on and off. Object
positioning can be used with text boxes, images, and other objects
that you have inserted into topics. If this option is on, you can
easily position the object in different places in the topic (e.g., to
the right or left of the frame on a page).

n Orphan/Widow Control Turns widow and orphan control on or off.
If this is turned on, you can see the effects in the Print Layout
mode in the XML Editor. Widow control determines the minimum
number of lines in a paragraph to be left at the top of a page or
column. Orphan control determines the minimum number of lines
in a paragraph to be left at the bottom of a page or column. The
default number of lines for both is 2, but you can adjust this
setting.
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n Hidden Elements Shows content that has been designated as
"hidden." In other words, you can have a style where the "display"
property value is set to "none." Normally, content to which this
style is applied will not be seen. But you can display that content
by selecting this option.

n Conditions If you have created and applied condition tags, clicking
this button toggles between showing and hiding them.

n
Snippet Conditions If you have created and applied snippet
condition tags, this command enables or disables a marker that
overlays snippets that have snippet conditions applied to them.

n
Variable Names Lets you choose whether to see the names of
variables in your markers (if you have inserted variables) in the
active topic.

n Bookmark Names Lets you choose whether to see the names of
bookmarks in your markers (if you have inserted bookmarks) in
the active topic.

n Named Elements Lets you choose whether to see the yellow flag
icon next to named elements in your markers (if you have inserted
named elements) in the active topic. Named elements are used for
inserting togglers into topics.

n Locks Locks or unlocks the content designated with the gray
background. After content has been locked, it cannot be edited,
and annotations cannot be added to it.

n Locked Elements Lets you show or hide the gray background
associated with elements that have been locked or selected to be
locked.

n Changes  Displays any tracked changes or annotations (notes)
that have been attached to any content in the topic.

n Marker Width Lets you adjust the width of markers in the active
topic to see more or less of the markers when they are visible.
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Expands all tags in the editor (i.e., blocks of content), so that you can see
any content that was previously collapsed.

Collapses all heading tags in the editor (and the content under them). An
ellipsis icon displays under the main heading.

Opens the file in the Internal Text Editor (for review packages only).
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Buttons and Sections—Bottom of XML Editor in
Web Layout Mode
Option Description

Words Displays the number of words in the open file. If you highlight words in
the file, this area shows you how many words are selected out of the
total count. If a file contains snippets, the words from those snippets
are not included in this word count, because those are separate files.

Reduces the scale of the font by 10% each time you click the button.

Resets the scale of the font to 100%.

Increases the scale of the font by 10% each time you click the button.

Lets you select a specific percentage to scale the font.

Shows or hides colored shading (and in some cases a colored square)
where conditions have been applied.

EXAMPLE Your condition has blue associated with it and you
have applied this tag to a block of content. When you click this
button to show the indicator, the block of content becomes
shaded with a lighter version of blue. If more than one
condition is applied to the block of content, the shading
appears in a pattern that shows all of the applied condition
colors.
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Shows or hides the tag block bars. These bars are displayed to the left
of the content area. They show the different tags for your chunks of
content (i.e., block-level tags), as well as the overall tag structure.

Shows or hides the span bars representing inline tags. These bars are
displayed at the top of the content area.

EXAMPLE If you have a block of text that is bold and you click
it, you will see a "b" in a bar above.

Enables or disables the feature to collapse and expand tags in the XML
Editor.

Shows or hides a measurement ruler horizontally at the top of the
editor or window pane. If you click the ruler after it is opened, you can
select to convert the ruler to pixels, points, centimeters, inches, or
ems.

Shows or hides a measurement ruler vertically at the left of the editor
or window pane. If you click the ruler after it is opened, you can select
to convert the ruler to pixels, points, centimeters, inches, or ems.

Shows or hides the layout resizer at the top of the editor. When
enabled, you can click the controls on the resizing slider or enter a
breakpoint value in pixels, points, centimeters, inches, or ems to alter
the width setting.
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Buttons and Sections—Bottom of XML Editor in
Print Layout Mode
Option Description

Words Displays the number of words in the open file. If you highlight words in
the file, this area shows you how many words are selected out of the
total count. If a file contains snippets, the words from those snippets
are not included in this word count, because those are separate files.

Displays the first page of the topic in Print Layout mode.

Displays the previous page of the topic in Print Layout mode.

Displays the next page of the topic in Print Layout mode.

Displays the last page of the topic in Print Layout mode.

Displays the current page of the topic, as well as the total number of
pages in the topic. You can enter another number in the field or use the
arrow buttons to navigate to a different page.
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The Zoom/Scale button (which looks different depending on the
current selection) opens a drop-down menu so that you can select
from the following options:

n 100% Displays the page at 100% of its actual size.

n 100% (2 pages) Shows two pages of a topic at a time, displaying
each one at 100%.

n Fit Width Resizes the page so that it displays in proportion to the
width of the window pane.

n One Page Displays only one page at a time.

n Two Pages Displays two pages at a time.

n Four Pages Displays three pages at a time.

n Eight Pages Displays four pages at a time.

NOTE This option is available only if you are working in Print
Layout mode. In this mode, additional pages are automatically
created when you add content beyond that which can be held
on a single page.

Reduces the scale of the font by 10% each time you click the button.

Increases the scale of the font by 10% each time you click the button.

Lets you select a specific percentage to scale the font.
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Shows or hides colored shading (and in some cases a colored square)
where conditions have been applied.

EXAMPLE Your condition has blue associated with it and you
have applied this tag to a block of content. When you click this
button to show the indicator, the block of content becomes
shaded with a lighter version of blue. If more than one
condition is applied to the block of content, the shading
appears in a pattern that shows all of the applied condition
colors.

Shows or hides the tag block bars. These bars are displayed to the left
of the content area. They show the different tags for your chunks of
content (i.e., block-level tags), as well as the overall tag structure.

Shows or hides the span bars representing inline tags. These bars are
displayed at the top of the content area.

EXAMPLE If you have a block of text that is bold and you click
it, you will see a "b" in a bar above.

Enables or disables the feature to collapse and expand tags in the XML
Editor.

Shows or hides a measurement ruler horizontally at the top of the
editor or window pane. If you click the ruler after it is opened, you can
select to convert the ruler to pixels, points, centimeters, inches, or
ems.
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Shows or hides a measurement ruler vertically at the left of the editor
or window pane. If you click the ruler after it is opened, you can select
to convert the ruler to pixels, points, centimeters, inches, or ems.
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Internal Text Editor
The Internal Text Editor is a simple editor that you can use to view and modify the true code,
including text, tags, and metadata. There is no requirement to use the Internal Text Editor. Those
who are new to Flare Desktop will usually work in the regular user interface views, but those who
are more advanced will probably find the Internal Text Editor to be quite useful. Most of the files in
your project can be opened and modified in the Internal Text Editor by right-clicking the file and
selecting Open with > Internal Text Editor. The XML Editor includes a tab at the bottom to access
the Internal Text Editor. For topic and snippet files, this editor also lets you show or hide line
numbers, collapse or expand tagged areas (outlines), show or hide syntax coloring, and wrap text.
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Split View With XML Editor
The XML Editor and the Text Editor are closely synchronized with each other. They can be shown in
a single window with options for viewing both at the same time and configuring their appearance.
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How to Use Split View
You can view the XML Editor and Text Editor in a docked state, where only one editor can be seen at
a time, but you can easily access the other editor by clicking on a tab. Alternatively, you can undock
the window and view both the XML Editor and Text Editor in a split view. Buttons allow you to
switch between a horizontal split view and a vertical split view.
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NOTE You can also switch between the XML Editor and Text Editor by pressing CTRL+`
(grave accent) on your keyboard.
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Features of Split View
Not only does split view allow you to see the XML Editor and Text Editor jointly in different ways, but
there are also special features with split view.

n Synchronization of Text

l Highlighting text in one editor automatically highlights the related text in the other editor.
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l Clicking in one editor causes the other editor to jump to the same position.

NOTE If you highlight areas in the XML Editor that matches non-consecutive
sections of XML, no highlight is shown in the Text Editor. For example, in the XML
Editor, you can highlight different parts of a table, but because of the order in which
table markup is written in XHTML, it cannot be similarly highlighted in the Text Editor.
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n Code Validation If you type characters that result in invalid XML, the Text Editor displays an
error with information as to why the error exists.
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In addition, the following rules are in effect, depending on whether the editors are docked or
undocked:

l If the editors are not docked (i.e., you can see the XML Editor), updates (i.e., highlights,
edits) stop going from the code to the XML Editor. If you make an edit in the XML Editor
while erroneous XML is in the Text Editor, the changes in the XML Editor take precedence
over any edits in the Text Editor.

l If the editors are docked (i.e., you cannot see the XML Editor), you will be unable to start a
split view or click the XML Editor tab until the error is resolved.

n Invalid Edits Outside of Flare Desktop If the document being viewed is edited outside of Flare
Desktop with invalid XML and saved, Flare Desktop will prompt you to open the file as text. If
you select “Yes,” the editors remain open in split view, but the Text Editor becomes the main
editor and the XML Editor cannot be shown until the invalid code is fixed.
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Character and Symbol Entities in the Code
Remember that this is an XML editor that follows the W3C XHTML Schema specification.
Therefore, if you want or need to enter entities for characters and symbols (e.g., via a third-party
tool), you need to use the XHTML entity number.

After you add a valid entity into the Text Editor, it is converted to the actual character or symbol
after you switch to the XML Editor view and then back to the Text Editor view.

You can find a list of valid entity numbers for characters and symbols on the W3C website. See:

http://www.w3.org/TR/html401/sgml/entities.html

EXAMPLE You are working in the code and want to add an en dash (—). To do so, you
would enter the following:

&#8211;

Do not enter &ndash; (because it is not valid XML).
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Autocomplete in Internal Text Editor
You can use autocomplete in the Text Editor to quickly select valid tags as you type XHTML and
CSS code. To use this feature, click in the local toolbar of the Text Editor.

If you press < on your keyboard, a popup shows context-aware tags that can be used at that point.
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Editing Topics or Snippets (Split View Version of Text
Editor)
If you are working on topics or snippets in the split view version of the Text Editor, the following
autocomplete features are available.

n Creating a tag If you press < on your keyboard, a popup shows context-aware tags that can
be used at that point.
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As you type, the selected item in the list will jump to the tag that begins with the text you are
typing.

You can select a tag by double-clicking it, or by pressing either the ENTER or > key on your
keyboard. Once a tag is selected, the ending tag is automatically created.
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n Adding attributes for a tag If you press the spacebar while inside of a tag, a popup shows a
list of attributes that can be used at that point.
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As you type, the selected item in the list will jump to the attribute that begins with the text you
are typing.

You can select an attribute by double-clicking it or by pressing the ENTER key on your
keyboard. Once an attribute is selected, the attribute text is completed and an equal sign
followed by quotation marks (="") is added to the end of the text, with the cursor being placed
between the quotation marks.
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Editing Stylesheets (CSS in Text Editor)
You can display a stylesheet in the Text Editor by right-clicking the file in the Content Explorer and
selecting Open with > Internal Text Editor. If you do this, you can use autocomplete to quickly select
valid properties under a style.

If you press CTRL+SPACEBAR on your keyboard, a popup displays CSS3 (and earlier) properties.
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As you type, the selected item in the list will jump to the property that begins with the text you are
typing.

You can select a property by double-clicking it or by pressing the ENTER key on your keyboard.
Once a property is selected, the property text is completed and a colon (followed by a space) is
added to the end of the text. The cursor is placed after the space so you can quickly type a value for
the property.
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The syntax is colored to help you easily distinguish different parts of the syntax.
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Managing Font Size in the Internal Text Editor
Three buttons in the local toolbar of the Internal Text Editor let you manage (increase, decrease,
reset) the font size. These options change the font size in the editor only, making it easier to see the
text as you work. These options do not change the size of the actual content, affecting the output.

In addition to the buttons, you can use corresponding shortcut keys:

n or CTRL+- Decrease size

n or CTRL+0 Reset size

n or CTRL+= Increase size
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Buttons and Sections in the Internal Text Editor
Option Description

Decreases the font size in the editor.

Resets the font size in the editor.

Increases the font size in the editor.

Shows or hides numbered lines in the text editor. This makes it easier to
identify a particular line that requires editing.

You can also see the line and character position in the upper-right corner
of the editor (see below).

Shows or hides small minus and plus buttons next to lines with tags.
These let you collapse or expand those portions of the code.

Shows or hides syntax coloring in the Internal Text Editor. This makes it
easier to identify different parts of the file.

Enables or disables word wrapping in the Internal Text Editor. This makes
it much easier to see all of the words and tags in an area. Without the
word wrap feature, lines in the Internal Text Editor can often be quite long
and require you to use the horizontal scroll bar in order to see text not
shown.

Enables the autocomplete feature.
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[Character:Line] The character and line position of your cursor is shown in the upper-right
corner of the editor.
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Stylesheet Editor
The Stylesheet Editor displays when you open a stylesheet file from the Content Explorer, and is
used to modify styles contained in regular stylesheets. For special table stylesheets, you will use
the Table Style Editor. However, you can also use the Stylesheet Editor to modify standard table
tags (e.g., th, td) that are contained within a regular stylesheet.

Opening the Stylesheet Editor
Accessing the Stylesheet Editor is simply done by opening a stylesheet file from the Content
Explorer.

How to Open the Stylesheet Editor
1. Open the Content Explorer.

2. Locate and double-click a stylesheet (CSS) file.

If you used the default location when you added the stylesheet to the project, the stylesheet is
located in the Resources > Stylesheets subfolder of the Content Explorer.

If you imported the stylesheet from another authoring tool, the stylesheet is located in the
same subfolder (if any) where it was stored in the source project, or at the root level of the
Content Explorer.
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What You Can Do in the Stylesheet
Following are some of the primary tasks that you can perform in the Stylesheet Editor.

Feature Description

Comments (Add) If you are familiar with using cascading stylesheets (CSS) in a text
editor, you probably already know that you can add comments to
styles. This is simply a way to remind you or others about information
related to a style (e.g., which situations are appropriate to use a
certain style). In Flare Desktop you can add, edit, and view these style
comments through the user interface.

CSS Variables
(Create/Insert/Edit)

A CSS variable lets you place the value for a style in one place and
reuse it throughout a stylesheet. As with other kinds of single-
sourcing, this can help with speed, ease of use, and consistency.
Whenever you want to change the value, you only need to do so in one
place and the new value is propagated everywhere that the variable is
referenced. You certainly could use the "find and replace" feature
instead to change the value, but CSS variables are preferred because
you won’t need to worry about inconsistencies in your stylesheet. For
example, some values—such as colors—can be written in various
ways, so in those cases CSS variables make a lot of sense.

Font Sets (Manage) A font set is a collection of font families. You can create a font set in
order to designate the substitute fonts to use when the preferred font
is not available on the user's computer. If the first (i.e., preferred) font
family in the set is not found on the user's computer, the second font
family in the set is used. If the second font family is not found, the
third font family is used, and so on.

CHAPTER 5  123



Feature Description

Media Queries
(Create)

A media query is an alternative group of settings in a stylesheet.
These settings are automatically used under certain conditions, such
as when a screen of a certain size is displaying the output. Media
queries are able to do this because they are configured with specific
criteria (e.g., maximum width of the screen, orientation, resolution).
When the criteria are met, the style settings in the media query are
used to display the output. You do not tell a Flare target to use a media
query; it just happens automatically.

Mediums (Create) A medium is an alternative group of settings in a stylesheet and can
be very useful when you are generating multiple kinds of outputs.
Unless you tell Flare Desktop otherwise, default style settings will be
used for the different outputs you generate. But there may be times
when you want to override a default style setting for a particular
output; that's why you would use a medium. You need to explicitly tell
Flare Desktop which medium you want a particular target to use. This
is done from the Advanced tab of the Stylesheet Editor.

Selectors (Create) A selector is a way to associate XHTML content with style settings
based on various information—most often its type, class, or ID.
Sometimes the word "selector" is used interchangeably with the term
"style," but a selector can be much more than just a simple style.
When you create a new stylesheet, it already has many selectors in it.
If necessary, you can create new selectors of varying levels of
complexity.

Selectors (Rename) You can rename a selector (e.g., class, ID) after you have created it.
However, you cannot rename existing parent styles, such as p, h1, or
span. When you rename a style class or ID, you have the option to
automatically rename all instances of that class or ID in the
stylesheet accordingly.
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Feature Description

Style Property Values
(Cut, Copy, Paste)

In both the Stylesheet Editor and Formatting window pane, you can
display properties in alphabetical view, as opposed to grouped view.
When you are in alphabetical view, you can select multiple properties
for a particular selector.Then you can cut/copy and paste these
properties into another selector; they can also be pasted in the
Stylesheet Editor or in a text-based editor, such as Notepad or the
Internal Text Editor. Declarations can also be copied from a separate
CSS document and into your stylesheet in Flare Desktop.

Style Property Values
(Delete)

In addition to copy, cut, and paste, you can delete the values for those
properties from the current selector.

Styles (Disable) You cannot remove root styles provided by Flare Desktop. However,
you can prevent certain styles from being shown in the Stylesheet
Editor and in the Flare Desktop interface. Rather than being
overwhelmed with the sight of all styles in the stylesheet, you can
ensure that you see only the styles that you tend to use. Those styles
will not be removed from the stylesheet; they will simply be hidden
until you enable them.

Styles (Edit) After you create a new regular stylesheet, you can edit the styles
within it.

Styles (Import) You can manually create new style classes in a stylesheet. Another
option is to import existing styles from another stylesheet.

Stylesheets (Link) If you have more than one stylesheet in your project, you can link
them together. By doing this, one stylesheet can adopt the styles of
the other stylesheet so that they can be used in content files where
that stylesheet is applied.
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Inheritance—Why Some Styles are Gray
When making changes to styles in the Advanced view of the Stylesheet Editor, you may notice that
some styles are gray. These are called "inherited" styles. That's because they do not yet have
explicit settings on them, so they are inheriting default values from somewhere else (e.g., a factory
stylesheet located where you installed the application). As soon as you make a change to one of
these styles, it ceases to be an inherited style (or at least the property you set is no longer inheriting
from the default value), and the style name turns from gray to a darker font. You can click Hide
Inherited in the local toolbar if you want to hide these inherited styles.
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Also, if you hover over an inherited style, Flare Desktop displays the path to the stylesheet from
which the style is inherited.

If you have created a link from one stylesheet to another, you can double-click on an inherited
property to open that other stylesheet.

CHAPTER 5  127



EXAMPLE You have two stylesheets in your project—one called "Main-Styles" and the other
"Styles-for-Home-Page." You decide to create a link between the two stylesheets, so you
open Main-Styles.css, select the Options drop-down in the Stylesheet Editor, and choose
Stylesheet Links.

In the Stylesheet Links dialog, you move Styles-for-Home-Page.css from the left to the right
side.
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Back in the Main-Styles.css file, you notice that the color property is inheriting a setting.
This is indicated by the gray text. If you hover over this property, you can see that the color
is coming from the Styles-for-Home-Page.css stylesheet.

If you open the Styles-for-Home-Page.css stylesheet and select that same style, you will
notice that the text for the color property is darker, meaning it is the source of that setting.
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Two Views of the Stylesheet Editor
There are two views available in the Stylesheet Editor: Simplified and Advanced. You can toggle
between these two views by clicking or in the local toolbar of the editor.

n Simplified The Simplified view displays styles in a grid view and is often best for brand new
users.

This view provides an easy way to apply properties to styles, with format options available
from a toolbar and dialogs (similar to the way one would use an interface such as Microsoft
Word). In some cases, only the most common property options are available in the Simplified
view (e.g., font, letter/word spacing, paragraph alignment/indentation, autonumbering format,
borders, background). One advantage of the Simplified view is that you can apply a property
to multiple styles at the same time. You can also click a check box to hide the properties in
the editor, allowing you to see only the styles.

n Advanced The Advanced view displays styles in a tree structure, and despite the name, is
user friendly for authors of all levels.

For the properties, you can toggle between a grouped display and an alphabetical display.
The Advanced view of the Stylesheet Editor lets you edit more settings than are available in
the Simplified view. In addition, the Advanced view lets you see and apply settings to multiple
mediums and media queries at the same time.
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Simplified View of the Stylesheet Editor
Option Description

[Styles] You can use this field to filter which types of styles to show in
the area below.

Hide Inherited Hides the inherited styles from the list below in the editor.
These are styles that do not yet have explicit settings on them,
so they are inheriting default values from a stylesheet located
elsewhere (e.g., a factory stylesheet stored in the place where
you installed Flare Desktop). As soon as you make a change to
one of these styles, it ceases to be an inherited style (or at least
the property you set is no longer inheriting from the default
value). In the Advanced view of the Stylesheet Editor, inherited
styles are gray; non-inherited styles are black. In addition, there
are a couple of factory media queries (tablet and mobile), which
are inherited. If you have not yet edited these media queries,
they will not show up in the Medium drop-down field in the local
toolbar if you have this option set to hide inherited.

Hide Properties Hides the properties in the main portion of the Stylesheet Editor.
By hiding the properties you can make the editor load faster
than it would otherwise.

Medium: [Name of Medium] You can use this field to select a medium or media query, which
opens it in the editor so you can edit it. This includes factory
mediums and media queries, as well as those that you may
have created. If you have "Hide Inherited" enabled, the factory
mediums and media queries will not show up in the drop-down
if you have not yet made any edits to them. In the Advanced
view of the editor, you can have multiple mediums or media
queries open at the same time.The default medium is always
placed on the left of the others.
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Option Description

Opens the Properties dialog for the selected style. From this
dialog, you can provide various settings for the style(s), such as
changing the font or the background color.

Applies bold typeface to the font for the selected style.

Applies italic typeface to the font for the selected style.

Underlines the font for the selected style.

Lets you select a font type (e.g., Arial, Times New Roman),
applying it to the selected style.

Lets you select a font size, applying it to the selected style.

Lets you choose and apply a color to the font for the selected
style.

Lets you choose and apply a color to the background of the
selected style.
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Option Description

[Styles Grid] Columns and rows in the grid display the various styles and
classes in the stylesheet, as well as some of the more common
property settings. These grid cells are populated based on the
settings you provide in the Properties dialog (which is opened
by clicking ) or by selecting certain buttons (e.g., bold, font
size) in the editor.

n Name Displays the full name of the style class (the XML
tag followed by a period and the name of the class, if
any). For example, if you create a class of the p style
called "tip," this column will display "p.tip."

n Tag Displays the XML tag upon which the class is based.

n Class Displays the class name if you have created one
(based on the XML tag).

n ID Displays the identifier (ID) name if you have created
one (based on the XML tag).

n Pseudo Class Displays the pseudo class, if one exists
(e.g., active, hover, visited).

n Preview Displays a preview of the style class as you make
changes to the property settings.

n Comment You can click twice (or click once and press F2)
in this cell and type comment text related to the style.
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Advanced View of the Stylesheet Editor
Option Description

[Styles] You can use this field to filter which types of styles to show in the area
below.

Hide Inherited Hides the inherited styles from the list below in the editor. These are styles
that do not yet have explicit settings on them, so they are inheriting default
values from a stylesheet located elsewhere (e.g., a factory stylesheet stored
in the place where you installed Flare Desktop). As soon as you make a
change to one of these styles, it ceases to be an inherited style (or at least
the property you set is no longer inheriting from the default value). In the
Advanced view of the Stylesheet Editor, inherited styles are gray; non-
inherited styles are black. In addition, there are a couple of factory media
queries (tablet and mobile), which are inherited. If you have not yet edited
these media queries, they will not show up in the Medium drop-down field in
the local toolbar if you have this option set to hide inherited.

Toggles between showing the properties in grouped view or alphabetical
view.

Properties are organized into logical groups (when using grouped view) in
the Stylesheet Editor. The Unclassified group holds miscellaneous
properties that do not really fit in any of the other groups. This group
consists of both standard CSS properties and MadCap-specific properties.

If you are using the grouped view, this expands all of the property groups.

If you are using the grouped view, this collapse all of the property groups.
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Option Description

Medium: [Name
of Medium]

You can use this field to select a medium or media query, which opens it in
the editor so you can edit it. This includes factory mediums and media
queries, as well as those that you may have created. If you have "Hide
Inherited" enabled, the factory mediums and media queries will not show up
in the drop-down if you have not yet made any edits to them. In the
Advanced view of the editor, you can have multiple mediums or media
queries open at the same time.The default medium is always placed on the
left of the others.

Show: 
[Properties]

You can use this field to filter the style properties that are displayed.

n Set (Locally) Properties Displays properties that have been set
explicitly in the stylesheet. An "Add Property" field is also shown at the
top of the properties. You can use this field to quickly add another
property to the list so you can edit it.

n
Set Properties Displays properties that have been set explicitly in the
stylesheet. It will also show properties that have been set in an
imported stylesheet or inherited properties that have been set in a
factory stylesheet. An "Add Property" field is also shown at the top of
the properties. You can use this field to quickly add another property
to the list so you can edit it.

n Assorted Relevant Properties Displays the properties that are used
most often for the selected style type.

n All Properties Displays all available properties.

[Styles] Lists the styles. After you select a style on the left, you can edit its properties
on the right.
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Option Description

[Properties] Lists the properties relevant to the style that is selected to the left. If the
properties are displayed in group view, expand the group to see the actual
properties. The property name is displayed on the left. Click on the right
and use the options to specify the value settings for the property. Depending
on the property, you might set the value by typing an entry, selecting an
option from a drop-down list, or specifying settings in a small popup.

CHAPTER 5  136



Option Description

Comments You can select the style and then type a comment in the field at the bottom
of the Styles section.
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Option Description

[Preview] As you make changes to a property's values, you can see how the changes
look in the Preview section at the bottom of the editor.

Local Toolbar of the Stylesheet Editor
Option Description

Toggles between an Advanced view and a Simplified view of the
Stylesheet Editor.

Opens the New Selector dialog opens, which lets you create a new
selectors of varying levels of complexity.

A selector is a way to associate XHTML content with style settings
based on various information—most often its type, class, or ID.
Sometimes the word "selector" is used interchangeably with the term
"style," but a selector can be much more than just a simple style.

Lets you rename a selector (e.g., class, ID).

Opens a menu, which lets you add a new CSS variable or insert an
existing one into a property.

Opens a menu, which lets you add a new medium or media query. You
can also delete the custom medium or media query that is active in the
Stylesheet Editor.
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Option Description

Opens a submenu that lets you select from the following options:

n Import Styles Opens the Import Styles dialog, which lets you
import individual styles from another stylesheet to the current one.
You can import from one of Flare Desktop's factory stylesheets or
any other CSS file that you have access to.

n Manage Font Sets Opens the Font Set Manager, which lets you
add, edit, and delete a font set.

n Stylesheet Links Opens the Stylesheet Links dialog, which lets you
link another stylesheet to the current stylesheet. The style classes
within the linked stylesheet are therefore copied into the current
stylesheet.

n Disable Styles Opens the Disable Styles dialog, which lets you You
cannot remove root styles provided by Flare Desktop. However,
you can prevent certain styles from being shown in the Stylesheet
Editor and in the Flare Desktop interface. Rather than being
overwhelmed with the sight of all styles in the stylesheet, you can
ensure that you see only the styles that you tend to use. Those
styles will not be removed from the stylesheet; they will simply be
hidden until you enable them. 
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Ribbon Options for Editing Styles
Some options in the Home ribbon were originally designed for local formatting only, which is
generally discouraged.

However, if you have a stylesheet open, these options can be used to apply formatting to styles in
the Stylesheet Editor. This can speed up the process of editing certain style properties.

EXAMPLE You want to make the h1 style green in your stylesheet. After selecting the style
in the Stylesheet Editor, you could find and set the color property to green.
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However, you could use the color option in the Home ribbon to do the same thing, only
faster.
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TOC Editor
The TOC Editor is used to create tables of contents manually.

Creating and editing a table of contents file in Flare Desktop can be very easy to do for both online
and print output. You can drag topics from the Content Explorer to the TOC Editor. You can also
manually add TOC books and items, and then link them to other files. The links usually point to
topics, but for online outputs they can also point to external files, other Help systems, and movies.
You put all of these books and items in a structure that you think would be useful for the individual.
In online output, end users browse through a TOC to find information. And in HTML5 Side and Top
Navigation output, the TOC items become links in menus.

Online vs. Print TOCs
The TOC files you see in the Project Organizer work differently for online output than they do for
print-based output. For online outputs, TOC files are exactly as their name suggests; they are files
that create TOCs or menus in the output. But for print-based outputs, that same TOC file functions
more like an outline. The element that actually generates a TOC in print-based output is called a
“proxy,” which is inserted into a topic. You can manually create that proxy yourself, or you can select
an option in the Advanced tab of the Target Editor and let Flare Desktop do it all for you. There are
pros and cons for both methods.
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How to Open This Editor
1. Open the Project Organizer.

2. Expand the TOCs folder and double-click the file.
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Buttons and Descriptions
Option Description

Hides or shows special information pertaining to the editor or window
pane.

Exports all of the data in the window pane to a comma-separated value
(CSV) file. This option is enabled only if you are working in Grid View.

Exports only the selected data in the window pane to a comma-
separated value (CSV) file. This option is enabled only if you are working
in Grid View.

This button toggles between Tree View and Grid View when you click it.
Tree View is the traditional format of the TOC, displaying books and
items in a hierarchy. Grid View displays all of the books and items in a
column format. In either view you can select a range of entries and set
the same property information for all of those items.

Opens the Columns dialog, which lets you configure the way the column
information is shown. This option is enabled in Grid View only.

Expands all of the TOC books so that you can see the items under each
book (enabled in Tree View only).

Collapses all of the TOC books so that you can no longer see the items
under each book (enabled in Tree View only). You can only see the
books.

If you have created and applied condition tags, clicking this button
toggles between showing and hiding them in the TOC Editor. This option
is enabled in Tree View only.

CHAPTER 5  146



Option Description

Click this button to create a new topic and simultaneously link it to a
new item in the TOC. When you click this button, it opens the Add File
dialog, which you use to create the new topic, associate it with a topic
template, and give it any name you want. When you are finished with
this dialog, the new topic is created and it opens in the XML Editor. You
can click the tab containing your TOC to return to the TOC Editor. You
will notice that the item is created at the selected location in the TOC.
For example, if you have a TOC book selected and then click this button,
the new item will be added under the book.

Click this button to add a new item to the TOC. You can link the item to a
topic, a TOC, a browse sequence, another Flare project, an external Help
system, or a MadCap Mimic movie. The item is created at the selected
location in the TOC. For example, if you have a book selected and then
click this button, the new item will be added under the book. (As an
alternative, you can click existing topics in the Content Explorer and drag
them to the TOC Editor. Doing this creates a new TOC item with the
same name and automatically links it to the topic.)

Click this button to add a new book to the TOC. A TOC book simply acts
as a folder in your TOC to help organize it. You can then click an item
(such as a topic) and drag it under the book.

Click this button to add a new book at the top level (i.e., extreme left) of
the TOC.

Click this button to create a test node in a TOC. Select an item in the
TOC, and click to add a new TOC entry as a sibling below the
selected entry.
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Option Description

Click this button to open the Properties dialog for whatever item is
selected in the TOC. You can then specify where the item is linked,
whether it should have condition tags, and other behavioral settings.

If the item selected in the TOC Editor is a test node, this button displays
as Test Options and opens directly to the eLearning tab in the Properties
dialog.

Click this button to move the selected item to the left in the TOC
structure.

Click this button to move the selected item to the right in the TOC
structure.

Click this button to move the selected item upward in the TOC structure.

Click this button to move the selected item downward in the TOC
structure.

Opens the Content Explorer and highlights the location of the selected
content file within it.

Opens the Send Topic for Review Wizard, which lets you send the linked
document to another person for review.

Click this button to open the selected item. For example, if you select an
item that is linked to a topic and then click this button, that topic opens
in the XML Editor. You can also open an item by holding your CTRL key
and double-clicking the item.
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Option Description

Click this button to show or hide reports of unlinked entries.

Click either of these buttons to open a small window that displays how
many broken or unlinked items are in the editor. Below, in the editor, a
triangle icon is displayed next to broken links, and another icon that
looks like a small flag is displayed next to unlinked items.

Click this button to navigate to the previous warning in the TOC.

Click this button to navigate to the next warning in the TOC.

Click this button if you want to toggle the behavior of double-clicking an
item in the TOC.

The default behavior (without the toggle button selected) is that double-
clicking an item will open the properties dialog, and holding down the
CTRL key while double-clicking will open the file linked to the item. If you
activate the toggle button, this behavior is reversed; double-clicking an
item opens the file linked to it, and holding the CTRL key while double-
clicking will open the properties dialog.

Displays the color of condition tags that are associated with the TOC
entry (if any). Condition tags are used to determine specific content or
files to be included in some targets but not in others.
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What’s Noteworthy?
TIP To find where a particular topic has been inserted into a table of contents (TOC), right-
click the topic file in the Content Explorer or within the topic itself, and select Locate in TOC.
If the topic is located in more than one TOC, a dialog opens, listing all of those TOCs. Select
the TOC you want to look in and click Open.
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Skin Editor
The Skin Editor displays when you open a skin file from the Project Organizer, and is used to
develop a skin for one or more online targets in your project. A skin is a file that contains
information about the appearance of the output window (such as its size and positioning, which
buttons or tabs it should include, and style settings). The Skin Editor consists of several tabs,
displaying only settings relevant to the selected skin type—HTML5 (the recommended online output
type) or Standard (for other online outputs). You can also perform certain tasks for HTML5 and
micro content skin components.
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What You Can Do in the Skin Editor
Following are some of the primary tasks that you can perform in this editor:

Feature Description

About Box (Standard
Skins)

You can select an image to be used for the "About box" in the
output window. You can use this About box for any purpose you
like.

Accordion Title—Exclude
(Standard Skins)

You can exclude the accordion title from output. This shifts the
navigation buttons to the left.

Browser Settings (HTML5
Tripane and Standard
Skins)

You can specify which features will be used in the output window
when a browser is involved.

Buttons (HTML5 Tripane
Skins)

You can specify web toolbar settings for some online outputs.
This includes determining which buttons are displayed in the web
toolbar. You can also add custom JavaScript for the toolbar.

Buttons (Standard Skins) You can select the Help buttons that you would like to include in
the output window (e.g., Hide, Forward, Back, Print, customized
buttons).

Caption (HTML5 Tripane
and Standard Skins)

You can enter the caption that you want to be used at the top of
your Help system window (e.g., in the title bar of the browser
window or HTML Help viewer).
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Feature Description

Flare Online Account Link
(HTML5 Skins)

You can produce private output that requires a user to log in with
an email and Flare Online password. Without credentials, people
cannot see the output. It is possible to set private output for all
output types supported by Flare Online. Also, accessing private
output is not limited to people in your company. Flare Online has a
free viewer user type that you can use to add any of your
customers to your Flare Online license, and then give them
access to live private output. After users log in to see private
output, an account link displays in the output interface for HTML5
targets (not for other output types). If the output is not set to
private, this link is not shown. When users hover over the link, a
menu shows two options. You can change the look of this
account link in an HTML5 skin.

Index—Binary (Standard
Skins)

You can create a binary index for your project. Binary indexes are
intended for merging multiple CHM files when you build a target.
The index keywords in the CHM files are sorted alphabetically and
numerically for display in the output.

Index—Bookmarks
(Standard Skins)

If you want index term links to point to the exact spot in the topic
where the index marker has been set, you need to specify this in
the Skin Editor. Otherwise, the index term links will point to the
topic in general. However, by pointing to the individual index
markers, the index may not display the way you want if the index
term points to multiple topics and you also have created a binary
index. In other words, index entries pointing to multiple topics will
display the index terms repeated instead of the topic title. A
workaround is to deselect the binary index option in the Skin
Editor. However, keep in mind that a binary index is required if you
want to merge CHM files.
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Feature Description

Localization and UI Text
(HTML5 and Standard
Skins)

As an alternative to using language skins, you can use the UI Text
tab in the Skin Editor to perform all of the localization tasks for
HTML5 targets. This tab not only lets you enter text in other
languages, but it lets you change the substance of text strings
altogether, whether they are in your primary language or another.
If you are using a standard skin, you can use the Styles tab to
localize skin settings.

Mediums (HTML5 Skins) To support responsive output, HTML5 skins come equipped with
three mediums—Web, Tablet, and Mobile. You can use these
mediums to specify different looks when necessary for the
different devices people might be using to view your output.

Micro Content (HTML5
Skins)

You can include micro content containers (e.g., featured snippets,
Knowledge Panel) for HTML5 search results output. However, you
can also use more advanced micro content proxies (e.g., FAQ,
Knowledge, Promotion) and related skin components for more
choices and control over your micro content.

Navigation Link—
Standalone Topics
(HTML5 Tripane and
Standard Skins)

You can add a link to the top or bottom of topics in HTML5,
WebHelp, or WebHelp Plus outputs. This link will not display
unless the output topic is opened as a standalone (outside of the
main navigation framework of the output). By clicking the link, a
user can view the standalone topic in the main navigation
framework.

Navigation Pane (HTML
Help) (Standard Skins)

You can specify navigation pane settings for Microsoft HTML
Help output. This includes setting the width of the navigation
pane and determining whether it shown or hidden under different
circumstances. The navigation pane is used to hold elements
such as TOCs and indexes.
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Feature Description

Navigation Pane (HTML5
and WebHelp) (HTML5
and Standard Skins)

You can specify navigation settings for HTML5, WebHelp, or
WebHelp Plus output. For some of these outputs, the navigation
pane is used to hold the TOC, Index, Search, Glossary, Browse
Sequences, and Favorites in an accordion-type structure. For
HTML5 Side and Top Navigation outputs, the navigation pane
settings let you choose the main menu and slide-out position,
fixed header, depth level of menu items (Top Navigation only),
slide-out menu style, and a URL for a logo.

Preview (HTML5 and
Standard Skins)

You can see how your skin settings look in each of the online
output types.

Print Medium (HTML5) The print medium in skin files is for styling printed pages from the
generated online target (i.e., a browser function).

Responsive Output—
Enable (HTML5 Skins)

Responsive web design (RWD) is a way to construct your HTML5
output so that the display and content are adjusted automatically
depending on the device. Therefore, on tablets and mobile
devices such as smart phones, users will see a condensed look
and perhaps different text that is more appropriate for those
devices, compared with larger monitors. You can get the same
effect if you shrink your browser to a smaller size.

Skin ID (HTML5 Skins) You can assign skin IDs to your skin if you want to use a specific
skin for context-sensitive Help. Skin IDs are also used to allow
users to choose from multiple skins to change the display of the
output.

Styles (HTML5 and
Standard Skins)

For certain elements of the online output window (e.g., menu,
search, navigation pane, TOC or browse sequence entries, index
keywords) you can determine skin style settings. The styles
available depend on the type of skin.
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Tabs/Accordions/Links
(HTML5 Tripane and
Standard Skins)

You can determine which navigation elements from your project
(e.g., TOC, Index, Glossary, Browse Sequences) that you want
users to have access to in the output. If you are creating
Microsoft HTML Help output, these elements will display as tabs
in the output window (except for a glossary, which is included in
the TOC as a book). If you are creating HTML5 Tripane, WebHelp,
or WebHelp Plus, these elements will display as accordion items
in the output window. In some outputs, you can select one of the
navigation elements to serve as the default in the output. This
feature is not supported in HTML5 Top Navigation output.

TOC—Binary (Standard
Skins)

You can create a binary table of contents (TOC) for your project.
Binary TOCs are intended for very large compiled Microsoft HTML
Help projects, reducing the amount of time it takes to load a TOC.

TOC—Look (Standard
Skins)

You can specify the look and feel of your table of contents (TOC).
This includes adding plus/minus squares next to entries,
changing the book/folder icons, adding border around the TOC,
and more.

TOC—Reduce
Flicker/Embed Visible TOC
Entries (HTML5 Side and
Top Navigation Skins)

For frameless output (HTML5 Side or Top Navigation) you can
reduce "flicker" effects that users might see when clicking in the
main table of contents (TOC) navigation. This can be done by
selecting the "Embed Visible TOC Entries" option on the Setup tab
of the Skin Editor. When this option is enabled, the top-level (i.e.,
parent) TOC items are preloaded (i.e., embedded) into the output
topics. Because of this, the movement (or "flicker") when opening
topics is less significant.
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TOC—Synchronize
(HTML5 and Standard
Skins)

You can customize your output so that users can always see
where the current topic belongs in the table of contents (TOC),
even if they did not access the topic via the TOC. This can be
done by selecting the "Automatically Synchronize TOC" option on
the Setup tab of the Skin Editor. When users navigate from topic
to topic in the output, the TOC automatically changes accordingly,
highlighting the topic that is open.

Topic Toolbar Custom
Settings (Standard Skins)

In addition to the regular web toolbars that can be included in all
most online outputs, you have another option for including
toolbars. This option lets you insert toolbars anywhere in any
topics.

Web Toolbar—Add for
HTML Help (Standard
Skins)

You can add a web toolbar that displays at the top of each topic.
This toolbar is added automatically if you have enabled MadCap
Feedback in the target, but you can add the toolbar manually in
the Skin Editor, even if you are not using MadCap Feedback.

Web Toolbar Custom
Settings (HTML5 Tripane
and Standard Skins)

You can specify web toolbar settings for some online outputs.
This includes determining which buttons are displayed in the web
toolbar. You can also add custom JavaScript for the toolbar.

Window—Size/Position
(HTML5 Tripane and
Standard Skins)

You can set the size and position of the output window. The size
refers to the height and width of the output window. The position
refers to the distance that the output window is placed from the
top, bottom, left, and right of the user's computer screen.

Window—User-defined
Size/Position (Standard
Skins)

You can let end users control the position and size of the output
window by using an option on the HTML Help Setup tab of the
Skin Editor. This option causes an HTML Help (CHM) file to save
its window position and size after its first use. The next time, it
will open at the same window position and size.
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NOTE If you want to display the output user interface in a particular language, you can
modify styles in a language skin instead of a regular skin. As an alternative to using
language skins, you can use the UI Text tab in the Skin Editor to perform all of the
localization tasks for HTML5 targets. This tab not only lets you enter text in other
languages, but it lets you change the substance of text strings altogether, whether they are
in your primary language or another. For more information see the Help system.

NOTE You can download a variety of free skins with different looks from the MadCap
Software website.

http://madcapsoftware.com/downloads/flareskingallery.aspx

After downloading the skin, you can import it into your project.
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Page Layout Editor
The Page Layout Editor lets you edit page layouts, including individual pages and frames within
them.

A page layout is used for page specifications (e.g., size, margins) and to apply certain content (e.g.,
headers, footers, page numbers) to many (or all) topics in print-based output. It allows for easy
configuration through the use of content frames, bleeds, crop marks, registration marks, margins,
padding, alignment features, and more. You might create multiple page layouts for different
purposes (e.g., title page, TOC, chapters, appendix). Page layouts are similar to template pages, but
are more flexible and easier to use. The general rule is that page layouts are recommended for
print-based output, and template pages continue to be the best method for automatically adding
headers, footers, breadcrumbs, and more in multiple topics for online output. Another difference
between page layouts and template pages is that page layouts can be used for Adobe PDF,
Microsoft Word or Microsoft PowerPoint, whereas template pages can be used only for Microsoft
Word when creating print-based output.

HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help PPTX

Page
Layouts
Supported

Template
Pages
Supported
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Opening the Page Layout Editor
Accessing the Page Layout Editor is simply done by opening a page layout file from the Content
Explorer.

How to Open the Page Layout Editor
1. Open the Content Explorer.

2. Locate and double-click a page layout file.

If you used the default location when you added the page layout to the project, the page
layout is located in the Resources > PageLayouts subfolder of the Content Explorer.
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What You Can Do in the Page Layout Editor
Following are the primary tasks that you can perform in the Page Layout Editor.

Feature Description

Bleed, Crop Marks,
Registration Marks
(Show)

You can turn on indicators to see where your bleed is set on a page,
as well as crop and registration marks.

Frames (Add) You can add the following types of frames: Body, Header, Footer,
Decoration, Image.

Frames (Remove) Just as you can add new frames to a page as necessary, you can
remove existing frames as well.

Margins (Show) You can turn on indicators to see where your margins are set on a
page.

Padding (Show) You can turn on indicators to see where padding is set in a frame.

Page
Numbers/Variables
(Add to Frame)

The Select Frame Text dialog is used to choose an existing snippet
for a frame. This is often used to insert page numbers or Heading
variables into frames. You can also create custom snippet templates
and select them from the dialog.

Page Properties (Set) The Page Properties button lets you set properties for the active page
in the layout. You can set properties such as the size, margins, page
name, page type, background, and bleeds.
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Pages (Add) In each page layout, you need to decide how many pages you need
and add them to the layout. The number of pages that you add
depends on the differences that may occur on the various pages. For
example, you might add a First Right page to be used only for the first
page of the chapter. You also might add a Left page for even pages
(e.g., 12, 14, 16, 18) and a Right page for odd pages (e.g., 11, 13, 15,
17). Each of those page types might display header or footer content
differently. You also might want to add an Empty Left page to make
sure that new chapters start on a right page. In the Page Layout
Editor, only one page will be visible at any one time, but you can
navigate to the other pages quickly by using the small squares to the
right of the editor (one for each page in the page layout).

Pages and Frames
(Edit)

After you have the pages and frames that you need in a page layout,
you can modify them to affect the content, as well as the look of the
pages in the output. This might consist of various tasks, such as
inserting page numbers or text, adding borders to frames, resizing
frames, and more.

Text (Add to Frame) You can add any kind of content to a frame that you can add to a
regular topic (e.g., text, links, images).
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Local Toolbar of the Page Layout Editor
Option Description

Opens the Properties dialog for the page layout file. You can use this dialog to set
file tags on the file, as well as apply condition tags to it.

Clicking the face of the button opens the Page Properties button, which lets you
set properties for the active page in the layout. You can set properties such as the
size, margins, page name, page type, background, and bleeds.

For option details, see the Help system.

Opens the Frame Properties dialog, which lets you edit frames that you add to a
page layout.
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Option Description

Select the down arrow to choose one of the following, adding a new frame. .

n New Frame Mode The first time you select this option, it will allow you to
draw a body frame. The second time, it will allow you to draw a header
frame. The third time, it will allow you to draw a footer frame. And the
fourth time, it will allow you to draw a decoration frame.

n
New Header Frame Mode This lets you draw a header frame. This frame is
designed to hold content from the topic (e.g., chapter title, page number).
The frame is usually positioned at the top of a page, above the body text.

NOTE You can have only one header frame per page.

n
New Footer Frame Mode This option lets you draw a footer frame. This
frame is designed to hold content from the topic (e.g., chapter title, page
number) or text that you add. The frame is usually positioned at the bottom
of a page, below the body text.

NOTE You can have only one footer frame per page.

n New Body Frame Mode This option lets you draw a body frame. This frame,
usually the largest on the page, is basically a placeholder for the content
that you add to topics. You cannot add content directly to a body frame. If
necessary, you can have multiple body frames on a page. This lets you
customize the flow of text from one frame to another on a page.

n
New Decoration Frame Mode This option lets you draw a decoration frame.
This frame can be used to display content for aesthetic purposes on a
page. You can add color, a border, text, and images to a decoration frame.

NOTE Decoration frames are not supported in Word output.
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n
New Image Frame This option lets you draw an image frame. This frame
opens the Insert Image dialog, prompting you to provide an image file. The
image is added to a frame of the same size, which you can place on the
page as necessary. If you do not want to use an image frame, you can use a
decoration frame instead to display a picture.

NOTE Image frames are not supported in Word output.

Converts the cursor to Select mode, which lets you select any frames in the page.

Enables the snap feature, which functions somewhat like a magnet in the editor.
When you are resizing, moving, or creating a frame, this option lets you snap its
edges to different display positions—such as the edge of the page, margins, other
frames, and the middle of the page vertically or horizontally. You do not need to
have indicators—such as margins—turned on in order to use this feature, but it
may be helpful to do so.

Lets you add any kind of content to a frame that you can add to a regular topic
(e.g., text, links, images).

Opens the Select Frame Text dialog, which is used to choose an existing snippet
for a frame. This is often used to insert page numbers or Heading variables into
frames. You can also create custom snippet templates and select them from the
dialog.
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Opens a submenu to select from various rotation, depth, and alignment options.

n
Rotate

l Rotate Clockwise Turns the frame 1 degree clockwise.

l Rotate 45 Clockwise Turns the frame 45 degrees clockwise.

l Rotate 90 Clockwise Turns the frame 90 degrees clockwise.

l Rotate Counter Clockwise Turns the frame 1 degree counter
clockwise.

l Rotate 45 Counter Clockwise Turns the frame 45 degrees counter
clockwise.

l Rotate 90 Clockwise Turns the frame 90 degrees counter clockwise.

l Reset Rotation Returns the frame to its original setting.

n
Depth

l Float Floats the selected frame, bringing it forward one level if at least
one other frame overlaps it (above it).

l Sink Sinks the selected frame, sending it backward one level if at least
one other frame overlaps it (below it).

l Sink To Bottom Sinks the selected frame, sending it backward to the
bottom level if at least one other frame overlaps it (below it).

l Float To Top Floats the selected frame, bringing it forward to the top
level if at least one other frame overlaps it (above it).

n
Align on Canvas

l Center on Canvas Centers the selected frame(s) both vertically and
horizontally on the canvas.

l Vertically Center on Canvas Centers the selected frame(s) vertically on
the canvas.

l Horizontally Center on Canvas Centers the selected frame(s)
horizontally on the canvas.
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n
Make Same

l Same Left Horizontally aligns the frames so the left border is at the
same location.

l Same Right Horizontally aligns the frames so the right border is at the
same location.

l Same Top Vertically aligns the frames so the top border is at the same
location.

l Same Bottom Vertically aligns the frames so the bottom border is at
the same location.

l Same Width Resizes the width of the selected frames so that they are
all the same. The resizing is based on the width of the first frame that
you select.

l Same Height Resizes the height of the selected frames so that they are
all the same. The resizing is based on the height of the first frame that
you select.

l Same Size Resizes the width and height of the selected frames so that
they are all the same. The resizing is based on the width and height of
the first frame that you select.

l Same Center Vertically aligns the selected frames so that the center of
each is at the same location. The alignment is based on the center of
the first frame that you select.

l Same Middle Horizontally aligns the selected frames so that the
middle of each is at the same location. The alignment is based on the
middle of the first frame that you select.

n
Vertically Align

l Top Aligns the text vertically along the top edge of the frame.

l Middle Aligns the text vertically at the middle point of the frame

l Bottom Aligns the text vertically along the bottom edge of the frame.

n
Align
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l Left Aligns the text horizontally along the left edge of the frame.

l Center Aligns the text horizontally at the center point of the frame.

l Right Aligns the text horizontally along the right edge of the frame.

l Justify Spaces the text so both the left and right sides are aligned.

l Default Resets the text alignment to the default (inherited) setting.
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Opens a submenu that lets you select from the following.

n
Page Overview Bar You can show or hide the Page Overview Bar, which is
the area on the right side of the Page Layout Editor that displays small
rectangles, representing each page in the layout.

n
Anchor Lines If you have anchors enabled on a frame, this option displays
lines to show where the anchors are placed.

n
Bleed (as well as crop and registration marks) You can turn on indicators to
see where your bleed is set on a page, as well as crop and registration
marks.

l Bleed This refers to the area beyond the edge of the page where
printing occurs. Professional printers use the bleed to prevent a final
trimmed document from having unprinted areas along the edge of the
document. You can set the size of the bleed in the Page Properties
dialog.

l
Crop marks These are thin vertical and horizontal lines that show the
edges of the page, where it will be trimmed by the printer. The location
of crop marks are determined by the page size you specify.

l Registration marks These are small cross-hair target icons shown next
to crop marks. Each color in the final output is printed on its own layer.
Therefore, in order to make sure the colors are matched up accurately,
printers use registration marks to align plates on the press.

n
Labels You can turn on indicators to see labels on a page, both for the page
itself and frames within it.

n
Margins You can turn on indicators to see where your margins are set on a
page.

n
Padding You can turn on indicators to see where padding is set in a frame.

n
Word Overlay When enabled, this option shows the real header, footer, and
body areas if the page layout will be used in Microsoft Word output.
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Why is it important to have a special page layout view for Word output?
Because Word treats the header, footer, and body areas differently than
Flare Desktop and other outputs treat them. In Flare Desktop the frames
are determined by the sizes that you specify either in the Frame Properties
dialog or by drawing them on the page. But in Word, frames are determined
instead by the margins and content within the frames. Therefore, if you
send output to Word, you might end up with results that you do not expect,
unless you use the Word Overlay to see what the actual results will be.

NOTE You can still edit frames when the Word Overlay view is
enabled.

n Show Vertical Ruler Shows or hides a measurement ruler vertically at the
left of the editor or window pane. If you click the ruler after it is opened, you
can select to convert the ruler to pixels, points, centimeters, inches, or ems.

n Show Horizontal Ruler Shows or hides a measurement ruler horizontally at
the top of the editor or window pane. If you click the ruler after it is opened,
you can select to convert the ruler to pixels, points, centimeters, inches, or
ems.

n
Scale to 100% Displays the page at 100% of its actual size.

n Fit Width Resizes the page so that it displays in proportion to the width of
the editor.

n Fit Height Resizes the page so that it displays in proportion to the height of
the editor.
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CHAPTER 6

Primary Dialogs
There are many dialogs that you will see while working in Flare Desktop, but some are most
commonly used.

This chapter discusses the following:

Add File Dialog 174

Character Dialog 187

Options Dialog 195

Project Properties Dialog 230
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Add File Dialog
This dialog is used to add the various files to a project. You can choose the kind of file from the File
Type at the top of the dialog. When you do this, the dialog changes to display only the fields
pertinent to adding that specific element.

Files That You Can Add
Following are the types of files that you can add from the Add File dialog.

File Description

Alias An alias file is used to populate a header file with the information
necessary for producing context-sensitive Help (CSH). In Flare
Desktop, you can open an alias file and use the Alias Editor to create
and assign identifiers for the header file.

Auto Suggestion List In addition to snippets, variables, and several common system
suggestions (e.g., date, time), you can create a custom auto
suggestions list and add your own words and phrases to it. The first
step to doing this is to add an auto suggestions list file to your project.

Auto-index Phrase
Set

An auto-index lets you automatically add words in your project to a
generated index, rather than inserting all of the index markers
manually. To do this, you can add phrases and corresponding index
entries to an auto-index file. When you generate the output, Flare
Desktop scans the auto-index file and adds the words it finds to the
generated index.

Batch Target You can add a batch target file, which can be used to generate and/or
publish one or multiple targets in a batch from the user interface,
perhaps scheduled to run at a specific time.
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Branding You can add a branding stylesheet to a project. It provides basic
branding connections for updating the main brand color (i.e., Primary),
font, logo, and a couple complementary colors.

Browse Sequence A browse sequence is like an alternative table of contents (TOC) for
online output. For example, if you have several topics that you think
end users should read in order, you can create a browse sequence.
Another way to use a browse sequence is to create an alphabetical list
of all of the topics. So readers can use your regular TOC for a
structured method of navigation (with folders and subfolders), or they
can use the browse sequence for a more flattened, alphabetical way to
find topics.

Condition Tag Set A condition is a single-sourcing feature that you can apply to files or
different areas of your content. Conditions can determine whether
certain information displays in some outputs but not in others. You can
also control whether content displays on a certain device or screen
size. It is just one of the many single-sourcing features that you can
use in Flare Desktop.

Confluence Import You can add a Confluence import file, which is used to import Atlassian
Confluence pages into a project.

Destination The first step to setting up your project for publishing output is to
create a publishing destination. You can create as many publishing
destinations in your project as necessary, depending on how many
locations you need to send your output files.

DITA Import You can add a DITA import file, which is used to import DITA file
content into a project.
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Export Project You can add an export project file, which is used to export Flare
projects, or parts of them, to another location.

File Tag Set You can assign "tags" to files in Flare Desktop, even folders. You can
use file tags for many different purposes, such as assigning authors or
milestones to topics.

Flare Import The first step to importing files from another project is to add an
import project file. After you create this file, it will be stored in the
Imports folder in the Project Organizer. If you want to manually
reimport files from the project in the future, you can open this file (with
an .flimpfl extension). Your settings are saved in the file, and you can
simply initiate a reimport.

FrameMaker Import You can add a FrameMaker import file, which is used to import
FrameMaker documents into a project.

Glossary Flare may provide you with an initial glossary called "MyGlossary," to
which you add terms and definitions using the Glossary Editor. You can
use this initial glossary, but you can also add more glossaries if you
want.

Header A header file is a simple text file that contains basic information about
connecting the dialogs or windows in a software application to the
corresponding topics in the Help system. Both you and the software
developer need access to this file.

HTML Import You can add an HTML import file, which is used to import HTML files
into a project.
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Image You can add an image to your project, without inserting it into a
content file. If you follow the steps for inserting an image, the image
file is added to the project as well.

Index Link Set In addition to creating regular index entries that point to a specific
place in your project, you can also create index links. An index link is an
entry in a generated index that points to another entry. There are three
kinds of index links—"See," "See Also," and "Sort As."

Language Skin Flare Desktop provides language skins for certain languages, such as
French, German, and Spanish (i.e., many values are already translated).
These languages are identified as being "localized" skins. You can edit
these default translations by creating a language skin for the language.
For languages that do not provide default translations, you can create
language skins so they can be applied to the output too. If you have a
legacy language skin in your AppData folder, you can use it as a
template to create new language skins.

Markdown Import You can add a Markdown import file, which is used to import
Markdown files into a project.

Meta Tag Set You can add meta tag sets to your project to set up a schema of meta
tags to be used at various file levels.

Micro Content You can create micro content phrases and responses, which can be
used for HTML5 search results, topic output, or for other uses (e.g.,
chatbots).

MS Word Import You can add an MS Word import file, which is used to import Word
documents into a project.

CHAPTER 6  177



File Description

Multimedia You can add many types of multimedia files to your project, which can
then be inserted into topics or snippets.

Page Layout A page layout is used for page specifications (e.g., size, margins) and
to apply certain content (e.g., headers, footers, page numbers) to many
(or all) topics in print-based output. It allows for easy configuration
through the use of content frames, bleeds, crop marks, registration
marks, margins, padding, alignment features, and more. You might
create multiple page layouts for different purposes (e.g., title page,
TOC, chapters, appendix). Page layouts are similar to template pages,
but are more flexible and easier to use. The general rule is that page
layouts are recommended for print-based output, and template pages
continue to be the best method for automatically adding headers,
footers, breadcrumbs, and more in multiple topics for online output.
Another difference between page layouts and template pages is that
page layouts can be used for Adobe PDF, Microsoft Word or Microsoft
PowerPoint, whereas template pages can be used only for Microsoft
Word when creating print-based output.

Relationship Table A relationship table is an element used to link related topics together. It
is similar to concept links or related topics links. Although a
relationship table is a common feature in DITA, you do not need to be
using DITA or know anything about DITA in order to take advantage of
relationship tables.

Report From the Reports folder in the Project Organizer, you can generate
custom reports based on information contained in your project. In
addition, you can design the look and feel of reports, save them for
future access, and open them in a browser window (where you can
print them).
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Search Filter Set A search filter lets users narrow their search based on concepts.
Concepts are simply keyword markers that you insert into topics that
have some kind of relationship with each other. They are also used for
inserting concept links into topics.

Skin A skin is a file that contains information about the appearance of an
online output window. There are three kinds of skins: Standard, HTML5,
and Mobile.

Snippet A snippet is a chunk of formatted content that is heavily used in single-
sourcing. Snippets can include text, tables, images, and whatever else
can be included in a normal topic. You can insert snippets into one or
more topics throughout your project, thus allowing you to reuse
content that is maintained in one place. You can even insert them into
other snippets, creating nested snippets. Snippets are not usually
intended for single words or very short phrases that change frequently.
In those cases, you probably want to use variables instead.

Stylesheet Stylesheets are files with a .css extension. They are used to hold many
styles, as well as information about how each style looks or behaves.
Whenever you need to create new styles or change their properties, you
accomplish this in a stylesheet, via the Stylesheet Editor.

Synonyms If users enter search phrases in your online output and those phrases
are not returning results, you can make improvements to your output
so that, in the future, users are able to find the search results they
need. One way to enhance your output is to create synonyms for
search phrases.

Table Style You can add a new .css file specifically designed to design the look of
tables.
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Target It is easy to confuse output types with targets, but they are two
different (although related) concepts. A target is one instance of an
output type. It is the engine that takes all of your files and settings, and
brings them together to produce the end result. When you build your
final output, you are essentially building one or more of the targets in
your project.

Template Page You can create template pages for use in both online and Word output.

TOC A table of contents (TOC) is a method that end users can use to find
information easily in your output. A TOC in Flare works much like a TOC
in a printed book. It provides an outline of contents in your Help system
so that end users can easily and quickly navigate to the information
they need. You create a TOC, adding books, topic links, and links to
external files in a structure that you think would be useful for the user.
End users then browse through a TOC to find information. For print-
based (Adobe PDF, Microsoft Word) and EPUB output, you need to use
the TOC Editor to create a TOC just as you would create one for online
output (HTML5, Eclipse Help, Microsoft HTML Help, WebHelp, WebHelp
Plus). However, there is a fundamental difference. Performing this task
for online output creates an actual TOC in the output, which people use
to navigate from topic to topic. This is not the case for print-based
output. Performing this task for print-based output lets you indicate
which topics will be included in the output and in what order. In that
sense, this TOC functions more as an outline for print-based output.
Therefore, for print-based output, you can think of it as an "outline
TOC." If you want to include a generated TOC in print-based output, you
need to use a TOC proxy in a topic instead.
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Topic A topic is a file containing information about a particular subject.
Topics might be the most important part of a project. Everything else is
contained within topics (e.g., cross-references, text, images) or points
toward topics (e.g., tables of contents). The very reason end users
open a Help system or manual is to find information, a little direction.
They find that help within individual topics.

Variable Set A variable is a small piece of plain text or auto-generated content that
can be edited in one place but used in many places throughout your
project. Variables are especially useful for text that might change
frequently, such as version numbers and dates. Variables are stored in
variable sets, which can hold multiple variables. Depending on the
template you select when creating a project, Flare Desktop may provide
you with an initial variable set, but you can add as many additional
variable sets and variables as you like.
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Applying Conditions and File Tags to New Files
When you create new files, you can apply conditions and file tags to them directly from the Add File
dialog. This saves you the time of having to locate the file in the Content Explorer or Project
Organizer after you create the file. To do this, expand the Attributes area at the bottom. Then next
to the Condition Tags and File Tags fields, click and select the relevant conditions and file tags.
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Content Files and the Folder Location
If you are adding a content file (e.g., topic, image, template page, multimedia, page layout, snippet,
stylesheet, table stylesheet), the Folder field is automatically populated based on whatever has
focus in the Content Explorer. Flare Desktop does not try to direct you to a particular folder (such as
the recommended default folders for non-topic files). Instead, it assumes that you want to place the
file in the folder that has focus in the Content Explorer, with the option to place it anywhere else if
you like.

Recommended Folders for Non-Topic File Types

Non-Topic File Type Recommended Default Folder in Content Explorer

Branding Resources > Branding

Image Resources > Images

Micro Content Resources > MicroContent

Multimedia Resources > Multimedia

Page Layout Resources > PageLayouts

Snippet Resources > Snippets

Stylesheet Resources > Stylesheets

Table Stylesheet Resources > TableStyles

Template Page Resources > TemplatePages
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NOTE If you want to place non-topic files in a recommended folder, first make sure that
folder exists in the Content Explorer. If it does not exist, you can easily add it.

TIP When adding a new file to the Content Explorer, the recommended method is to right-
click on the folder in the Content Explorer and use the New menu option. This is the most
efficient way to direct the new file to the folder where you want to store it.

EXAMPLE The last place you clicked in the Content Explorer was a random topic in a
custom folder called "C-Procedure-Topics" that you created.
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You then select the Project ribbon, click New, and select Page Layout.
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The Add File dialog populates the Folder field with "C-Procedure-Topics," because that is
the folder that had focus when you opened the Add File dialog.
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Character Dialog
The Character dialog offers hundreds of characters and symbols that you can insert into your
content. You can also use features in the dialog to perform a variety of tasks, such as specifying a
quick character, selecting favorite characters, and searching for characters.

How to Open the Dialog
1. Open the content file.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Insert > Character.

n Keyboard Shortcut Press SHIFT+F11.
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Buttons and Sections
Option Description

Font When you first open the Character dialog, the characters and symbols are
shown in the font you are currently using. So this field displays (normal text),
which is probably what you want most of the time. However, you can use
the drop-down field at the top-left of the dialog to switch to a different font.
Also, you can begin to type a font in the field, and as you do, the list shortens
accordingly.

NOTE If you insert a character with "(normal text)" selected in the
Font field, that character will use the same font properties of the
content where it is being inserted. But if you select a specific font in
the Font field, the character will use those properties at the point of
insertion, which will likely result in a <span> tag being created.
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Option Description

[Characters and
symbols]

This large area displays all of the characters and symbols available. You can
click on a character or symbol to select it for insertion. If you right-click on a
character, you can choose an option to set that character as a favorite or as
a quick character.

After selecting a character, you can click this to copy it to the clipboard. That
way, you can continue pasting it into other places after closing the
Character dialog.

After selecting a character, you can click this to add it to the list of favorites
below.

After selecting a character, you can click this to set it as the quick character.
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Option Description

Quick Character You can designate one character or symbol as your "quick character," which
means that a special menu and shortcut option are set aside for that
character. Simply select the character or symbol and then click . The
current quick character is displayed in this field.

In the XML Editor you can insert the specified quick character by either
pressing F11 on your keyboard or clicking the down arrow of the Character
button and selecting Insert Quick Character.

NOTE You can also paste a character in the field, or you can right-
click on a character in the dialog and use the context menu to set it
as the quick character.
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Option Description

Search If you know the name of a character or its code, you can type it in this field
and click to locate it quickly.

NOTE To return to the view where you see all of the characters and
symbols, simply clear the Search field.
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Option Description

Favorites If there are certain characters and symbols that you use frequently, you can
add them to this list of favorites for quick and easy access. You can also
remove favorites from the list.
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Option Description

NOTE Favorite characters are shared across products.

Recently used When you insert a character or symbol from the dialog, it is added to the list
of the 16 most recently used. This is another way to quickly find and select
characters or symbols in the future. If the list of recently used characters
and symbols is full, the oldest one is removed automatically when a new
one is used.

NOTE Recent characters are shared across products.
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Option Description

[Name and
code]

When a character or symbol is selected in the dialog, its name and character
code are shown.

The code is also shown in a tooltip when you hover over a character.

Close after
inserting a
character

If this check box is not selected, the dialog will remain open until you click
Close. This way, you can click the Insert button several times to add many
characters to your content before closing the dialog. If the check box is
selected, the dialog will close immediately after you click the Insert button.
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Options Dialog
You can open the Options dialog by selecting File > Options. This dialog lets you choose
miscellaneous preferences and global settings.

Options Dialog—General Tab
Option Description

Auto-Reload
Documents

Select this check box if you want Flare Desktop to reload documents
automatically. In other words, if you have topics or editor pages open
and then close the project, this option ensures that those same
documents are reopened the next time you open the project.

Auto-Save
Documents

Select this check box if you want Flare Desktop to periodically auto-save
any open files. You can specify the number of minutes that should
elapse between each auto-save.
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Option Description

Close others when
opening new
document

You can have multiple files of all types (e.g., topics, stylesheets, targets)
open in the interface at the same. By default, when you open a new file,
other documents that are already open remain open. However, you can
change this behavior so that files already open in the interface are
automatically closed when you open a new document.

You can use any of the following options:

n Close others This option automatically closes all other open
documents.

n Close others with no changes This option automatically closes all
other open documents that do not have unsaved changes. If you
have files open where changes have been made but not saved,
those files will remain open until you save and close them.

n Close others with same extension This option automatically
closes all other open documents that share the same file
extension. For example, let's say you have a topic, a stylesheet,
and a target open. If you open another topic, the topic file that is
currently open will be closed, but the stylesheet and target will
remain open.

n Close others with same extension and no changes This option is
the same as the previous option, except that files with unsaved
changes will not automatically be closed. Those files remain open
until you save and close them.

CHAPTER 6  196



Option Description

Show Select UI
Language Dialog on
Startup

Select this box to show the Select UI Language dialog the next time you
launch Flare Desktop.

You have the option of viewing the interface in English, French, German,
Japanese, or Chinese. All of these languages are available from the
same version of Flare Desktop (you do not need to purchase different
versions for different languages). When you initially launch Flare
Desktop, you are asked to select your language preference. Based on
your selection, the user interface is displayed in the selected language,
with the option to switch your preferences at any time from the Select UI
Language dialog. If a particular element is not available in the selected
language, that element displays in English.

Import/Export Word
Files Without MS
Office

Flare Desktop supports the import and export of Microsoft Word
documents without the need to have Word installed locally. For example,
a user of Microsoft Office 365 (a subscription-based software solution)
would not have Microsoft Word installed locally (via Microsoft Office).
However, Flare Desktop lets Office 365 users build Word output, or
import Word files in the DOCX, DOC, or RTF format, even if they do not
have Microsoft Word installed on the same machine.

It is still recommended that you work with Word installed locally, which
is a more robust process. However, if you are an Office 365 user without
a local installation of Word, you can select this check box to enable this
feature. (This option is disabled by default.)

NOTE This feature does not support WMF or EMF files in Word
documents. If you have those types of image files, you should
disable this option and use a local installation of Word.
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Option Description

Import Excel Files
Without MS Office

Flare Desktop supports the import and export of Microsoft Excel files
without the need to have Excel installed locally.

It is still recommended that you work with Excel installed locally, which
is a more robust process. However, if you do not have recent version
installed (Excel 2010 or newer), you should select this check box to
enable this feature. (This option is disabled by default.)

Automatically resize
low DPI images

Starting with Flare Desktop 10, images with a very low DPI are rendered
more accurately in the XML Editor (WYSIWYG) and PDF output, usually
resulting in slightly larger and more blurry images (as is consistent with
their lower DPI). Therefore, if you upgrade from an older version to Flare
Desktop 10 or higher, you might notice images that looked a certain size
before now look larger and more blurry (because their true DPI is being
rendered more precisely). The best solution, and a long-term one, is to
replace your lower-DPI images with higher-DPI images to be used in
print output. But you also have the option to revert back to previous
version behavior. If you select this option, the newer, more precise
resizing from newer versions of the software is used. If you do not
select this option, the behavior of older versions is used.
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Option Description

Prefer Local Help By default, Flare Desktop's online and dynamic Help system points to
files hosted externally. This allows for live updates to the Help.

Because the Help system is hosted online, you may not be able to
access it if you are behind a firewall or if you have a slow connection. In
that case, you can use a local version of the Help. Flare Desktop will
even switch to the local Help automatically if it detects that you cannot
connect to the external Help system.

Select this option if you want to use the local Help manually.
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Options Dialog—Interface Tab
Option Description

Menu Style You can select an option to display the interface with ribbons or with the
classic tool strip.

Theme You can click the Active Theme field and select a color scheme for the
interface. You can choose a black, classic, or silver theme.
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Options Dialog—Source Control Tab
The options you see on this tab depend on whether your project is already bound to source control.

Not all options are applicable to each of Flare Desktop's integrated source control providers. If you
select an option that is not applicable to the provider you are using, this option is ignored. For
example, Git does not use lock functionality, so if you select this option it will be ignored.

Additionally, terminology varies for each source control provider. You may see slightly different
dialogs or prompts depending on which source control provider you are using.

Option Description

Automatically
check file out
from source
control when
saving file
changes

Select this check box to automatically check the file out from source
control when you save changes to it.

Lock files when
automatically
checking out

You can select this check box if you are using Microsoft Team Foundation
Server, Apache Subversion, or Perforce Helix Core and want files that are
automatically checked out to be locked as well. Locking files means that
other users cannot check those same files in when you have them checked
out. You might use this feature to prevent conflicting changes from
occurring and having to merge files as a result.

NOTE Subversion will automatically lock a modified file when
saving changes (if it is not already locked) if you selected the
option to automatically check out files from source control when
saving them. Because there is not a "checked out" status for
Subversion files, these files will be marked as modified and can
be committed.
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Option Description

Show prompt to
add auto-created
files to source
control

Select this if files were automatically added to your project and you want to
be prompted to add those files to source control. For example, this might
occur if you drag a word file to Content Explorer. Multiple files might be
automatically created when you do this.

Enable
background
status checks

Select this check box if you are using source control integration in Flare
Desktop and you want the application to check for frequent status changes
automatically. You can specify the number of minutes and seconds when
you want Flare Desktop to ping the source control repository and get status
changes for files that have been checked out, checked in, moved, deleted,
etc. The upside of this feature is that you can ensure that the source control
status information is always up to date. The downside is that you may
experience slower performance due to this constant communication over
the network.

Do not prompt to
get latest when
opening source
control bound
projects

When you open a project that is bound to source control, a message
automatically asks if you want to get the latest version of files. Select this
check box if you want to disable this prompt. Therefore, in the future when
you open the project you will no longer see the message, and the project
will open without replacing any local files with the latest ones from source
control.

Prompt to check
in files when
closing source
control bound
projects

Select this if you want to automatically be reminded to check in files when
you close a project that is bound to source control.
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Option Description

Enforce TFS
comment policy

By default, Flare Desktop ignores all Microsoft Team Foundation Server
check-in policies. However, if your source control administrator requires a
comment when you check in a file, you can select this option to force Flare
Desktop to abide by this policy.

NOTE Selecting this option only enforces the TFS comment policy.
It will not check for other policies.

Bind Detection Bind detection scans your project when you load it to see if the project has
been previously bound to source control. If a binding is detected, you then
have the option of applying the binding and committing the project to
source control. Depending on the provider you are using, Flare Desktop may
search the file system and its artifacts, as well as contact and query
servers, to find potential source control bindings.

Use Git
executable for
network
functions

Get Git for
Windows

Get an updated
version of Git for
Windows

Use this section to integrate Git for Windows (Git.exe) if your project is
bound to Git (not a Flare Online binding though) via Secure Shell (SSH). This
might be necessary to avoid errors. However, an upside to installing Git.exe
is that it is likely to result in faster and better performance for file transfers.

Flare Online
Transfer
Protocol

If you plan to bind a Flare project to a MadCap Flare Online license, you
must use the HTTPS transfer protocol. This field also shows the SSH
protocol, but this protocol is actually no longer available for Flare Online
connections due to security issues. Selecting SSH here will no longer cause
Flare Desktop to use SSH for Flare Online bindings.
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Options Dialog—Proxy Server Tab
Option Description

Use proxy server You might need to enable this option if your network has a proxy server
and you require any network connection from Flare Desktop (e.g.,
opening the Help system or logging in to Salesforce or Zendesk). After
enabling this option, enter your company's proxy server information. You
might need to consult your network administrator to obtain the
necessary credentials.

After completing the fields on this tab, close and restart Flare Desktop
for the changes to take effect.

Address Enter the address of the proxy server.

Port Enter the port for the proxy server.

Enable
authentication

Enable this so that you can enter a username and password for access
to the proxy server.
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Options Dialog—XML Editor Tab
Section Options and Descriptions

Options
n Enable Drag and Drop Text Place a check mark in this check box to

enable the drag-and-drop feature. When enabled, you can highlight and
drag text to move it within topics.

n Show web images Select this check box to show or hide web-linked
images in the XML Editor. If you have many image tags that link to
websites, slow website response times may slow down your work.
Therefore, you might want to disable the rendering of such images in
the XML Editor.

n Insert Empty Alt Text Select this check box to automatically add an
empty alt tag to images when you insert them into a topic or snippet
(unless you specifically add an alt tag to an image).

n Replace straight quotes with smart quotes Select this check box to use
single and double curly smart quotes instead of straight quotes when
you type in the XML Editor. This option is disabled by default.

n
Show style previews in UI When you attempt to apply a style to content
using the Style drop-down in the Home ribbon, the Styles window pane,
or the floating Style Picker, previews of the various styles are shown by
default. This gives you an idea of how each style looks before you apply
it to the content.

If you prefer not to see style previews in these areas of the user
interface, remove the check mark from this option.

With this option disabled, all of the styles will be presented as plain text
when you select them.
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Section Options and Descriptions

Text
Rendering

n Enable ClearType Font Smoothing Displays text in a "ClearType" font,
which appears to "smooth out" the words and make them easier to
read. ClearType is a software technology developed by Microsoft that
improves the readability of text on existing LCDs (Liquid Crystal
Displays), such as laptop screens, Pocket PC screens, and flat panel
monitors. With ClearType font technology, the words on your computer
screen look almost as sharp and clear as those printed on a piece of
paper. ClearType works by accessing the individual vertical color stripe
elements in every pixel of an LCD screen. Before ClearType, the
smallest level of detail that a computer could display was a single pixel,
but with ClearType running on an LCD monitor, we can now display
features of text as small as a fraction of a pixel in width. The extra
resolution increases the sharpness of the tiny details in text display,
making it much easier to read over long durations.

n
Enable GDI+ Text Renderer Toggles between Microsoft Windows
Graphics Device Interface (GDI) and GDI+ in terms of how content is
rendered on your monitor. What is the difference between GDI and
GDI+? The bottom line is that GDI+ improves the quality of the
rendering somewhat, but it can be slower than GDI. For more
information about GDI+, see:

http://msdn.microsoft.com/en-us/library/ms533797.aspx
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Section Options and Descriptions

Defaults
n Paste Text Select the default behavior when pasting text from another

program.

l Paragraphs Paste the text as regular paragraphs.

l Paragraph Block Paste the text as paragraph blocks, such as <div>,
<blockquote>, or <fieldset>.

l Inline Text Paste the text as inline text, so that it takes on the style
of the location where it is being pasted. If you have copied multiple
lines of text from the source document and use this option, the text
will be pasted in one line, not multiple lines.

l Table Paste the text into a new table.

l List Paste the text as a new bulleted list.

n Link Select the default behavior when creating a link by dragging a file
into the XML Editor—Cross-References (which are dynamically
generated based on commands) or Hyperlinks (which are based on
specific text you provide in the XML Editor).

n List Select the default behavior when creating a new numbered or
bulleted list. You can include <p> tags within each <li> tag (Paragraph),
or you can just have <li> tags (Simple) but add <p> tags later manually
for list items where you want them.

n Definition List Select the default behavior when creating a new
definition list. You can include <p> tags within each <dt> and <dd> tag
(Paragraph), or you can just have <dd> and <dt> tags (Simple) but add
<p> tags later manually for list items where you want them.

n Cut Table Columns Select the default behavior when cutting columns in
a table. You can choose to cut the entire Columns (including the
contents) or just the Cell Contents.

n Cut Table Rows Select the default behavior when cutting rows in a
table. You can choose to cut the entire Rows (including the contents) or
just the Cell Contents.

n Merge Table Select the default behavior when creating or pasting a new
table above or below and existing one. You can choose to keep the
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Section Options and Descriptions

tables separate (Don't Merge Tables), or to merge the tables. Merge
Table Up means the new merged table will use the style of the table on
top. Merge Table Down means the new merged table will use the style
of the table on bottom.

n Merge List Select the default behavior when creating or pasting a new
list above or below and existing one. You can choose to keep the lists
separate (Don't Merge Lists), or to Merge Lists into a single list.

n Paste Cells Into Tables Select the default behavior when pasting table
cells that you have copied or cut.

l Cells Paste the copied cells, replacing the cells nearest to where
you have placed your cursor.

l Table Paste the copied cells as a separate table. It will be placed
within the cell where you have placed your cursor.

l (Above) Paste the copied cells above the cell where you have
placed your cursor.

l (Below) Paste the copied cells below the cell where you have
placed your cursor.

l (Left) Paste the copied cells to the left of the cell where you have
placed your cursor.

l (Right) Paste the copied cells to the right of the cell where you have
placed your cursor.

n Table to Text Select the default behavior when converting a table to
text.

l Convert to Paragraphs Convert the content in each table cell into
separate paragraphs.

l Separate with Commas Convert the content in each table cell into
text separated by commas.

l Separate with Text Convert the content in each table cell into text
separated by a text string that you specify (e.g., a semicolon).
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Options Dialog—Project Analysis Tab
In order for the following options to be effective, you must set the options before opening your
project. If you have your project open and a scan is in process, setting these options will not
improve your system performance.

Option Description

Collect Segments Select this check box if you want Flare Desktop to collect segments of
text while scanning your project. Segment collection lets you view
information about your project such as frequent segments found and
index keyword suggestions.

Collect Variable
Prospects

Select this check box if you want Flare Desktop to look for text that you
might want to convert to variables.

Collect Snippet
Prospects

Select this check box if you want Flare Desktop to look for text that you
might want to convert to snippets.

Collect Local Style
Prospects

Select this check box if you want Flare Desktop to look for places where
you have applied local formatting and might want to apply styles to
those areas instead.

Collect Embedded
Stylesheet
Prospects

Select this check box if you want Flare Desktop to look for style
information (embedded styles in <style> elements) in your topic files.
Disabling this scan limits the results found in the style reports.

NOTE You should select this option if you have imported topics
that have embedded styles. Otherwise, it is not usually
necessary to select this option.
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Option Description

Collect Accessibility
Prospects

Select this check box if you want Flare Desktop to look for text where
you might want to add web accessibility features (e.g., captions,
alternate text).

Collect Markup
Prospects

Select this check box if you want Flare Desktop to look for a variety of
XHTML markup issues in your content (e.g., extra spaces, empty
attributes). You can open the affected files and "clean up" the markup in
them. You may be able to fix some issues in the XML Editor, but other
issues may require you to open the behind-the-scenes code in the
Internal Text Editor.
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Option Description

Search Limits You can limit the number of results returned from some analysis reports.
You can limit the search results to 100, 500, 1000, or 5000. If "All" is
selected, there are no limitations for the search results. You might want
to use this new feature to improve performance.

When a limit is selected, it is applied to the following window panes and
reports.

n Index Keyword Suggestions

n New Style Suggestions

n Replace Local Style Suggestions

n Undefined Styles
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Options Dialog—Auto Suggestion Tab
Option Description

Enable Auto
Suggestion

Select this to enable the entire Auto Suggestion feature.

Enable Snippet Auto
Suggestion

Select this to enable snippet suggestions.

Max Suggestions Enter the maximum number of suggestions that you want to be
displayed in the popup at any given time. You can enter a number from 1
to 25.

Min Character
Length

Enter the minimum number of characters that must be typed before the
popup opens to display matching phrases, variables, or snippets. You
can enter a number from 3 to 12.

Enable/disable files This area lists all custom auto suggestion list files and all variable sets in
your project. Select any of the check boxes to enable a particular file for
Auto Suggestion.
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Options Dialog—Spelling Tab
Section Option and Description

Select Global
Dictionary Location

A global dictionary is a file that contains words and can be used for spell
checking by any Flare Desktop project you open on your computer. This
is a convenient way to ensure that all of your projects are using the
same spellings for terms, rather than having each project rely on a
different dictionary.

By default, a new global dictionary is stored in your AppData folder, like
all of your built-in dictionaries.

However, you can select Use custom location to choose a different
location for your global dictionary. For example, you might be working
with a team of users and want to make sure you are all using the same
spellings for certain terms. By choosing a network directory, your entire
team can use the same global dictionary. After selecting this option,
click to choose the location.
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Section Option and Description

Installed
Dictionaries

This section displays information about the dictionaries that are
installed and therefore available to your project. You can import
additional dictionaries if you want.

n Language This column lists the names of all languages with
dictionaries that are installed on your computer. Dictionaries are
stored in your AppData Windows folder.

n Code Displays the code for each language.

n Spell Green dots indicate which dictionaries support spell
checking.

n Hyphen Green dots indicate which dictionaries support
hyphenators. A hyphenator is used to automatically hyphenate
words in an editor based on particular word patterns, as outlined
in the dictionary file. (Hyphenators are important only for certain
languages.) For more information about hyphenation patterns in
different languages, see:http://www.tug.org/TUGboat/tb27-
1/tb86nemeth.pdf

n Thesaurus Green dots indicate which dictionaries contain a
thesaurus.

n Description This column provides a short description of each
dictionary.

n Import Dictionaries You can download more dictionaries from
OpenOffice.org. After you download a new dictionary, you can
install it by clicking this button.

CHAPTER 6  214

http://www.madcapsoftware.com/downloads/dictionaries/openoffice


Section Option and Description

Spelling Options You can use these fields to ignore any of the following when spell
checking files:

n Ignore repeated words

n Ignore words with numbers

n Ignore uppercase words

n Ignore URLs

n Ignore email addresses

n Ignore mixed case words

n
Ignored styles If there are certain styles or classes in your
stylesheet that you want to ignore when spell checking, you can
enter them in this grid. For example, you might have styles
containing code text that you do not want to be affected by a spell
check.

n
Ignored conditions If there are certain chunks of content that are
conditioned and you want to ignore them when spell checking, you
can enter them in this grid (type the condition tag set, followed by
a period and then the name of the condition). For example, you
might have a condition that you use for content that is not yet
ready for release. Content with this condition might have your
notes and characters that you don't feel the need to spell check.
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Options Dialog—Index and Concepts Tab
Option Description

Auto-complete
Index and Concept
Entries

As you enter index keywords in the Index window pane, the application
recognizes if you have created a similar index keyword. The similar
keywords appear in a list just below the entry field. You can quickly
select one of the keywords from the list instead of typing the entire word
manually. This option turns this feature on and off.

Mode Warnings for
Index and Concept
Entries

If you turn on the Index Entry Mode or Concept Entry Mode and then
close the application, you will receive a warning message the next time
you open the application. The message lets you know that the mode is
still on. You can disable the warning messages from that dialog. This
option lets you turn those warning messages on again:

n Check mode and display this dialog when first topic opened You
can avoid seeing the Mode Warning dialog in the future by not
selecting this option. However, this does not mean the mode will
automatically be turned off for you. It simply means that you will
not be warned.

n Auto-switch to normal selection mode on launch Select this option
if you always want the application to disable the mode
automatically when you open the program in the future. You can
always turn the mode on again manually.

n Continue in mode The "Index Entry Mode" or "Concept Entry Mode"
will continue to be enabled after this dialog is closed. You can turn
off the mode manually by right-clicking in the topic and selecting
the mode.
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Options Dialog—Keyboard Shortcuts Tab
Option Description

Command Scope Select whether the custom shortcut will be available throughout the
interface (Global) or just in the XML Editor. The options available on the
tab change depending on your selection.

NOTE If you set one shortcut with XML Editor selected and
another with Global selected, the XML Editor shortcut has
precedence.

Option/Shortcut Select the option whose hot keys you want to change. You can click the
Option or Shortcut column headings to sort the columns alphabetically.
This can help you more easily find a command or see which shortcut
keys are free to use.

Key Assignment Select the hot key that you want to assign to the option.

Other commands
using shortcut

If you create a shortcut that is already being used, this field displays the
conflicting command.

Modifier Key
Assignment

You can select the Control Key, Shift Key, and/or Alt Key check boxes if
you want to use a combination for the shortcut. For example, if you
select D from the list to the right and add check marks to the Shift Key
and Alt Key boxes, the new shortcut for the option will be SHIFT+ALT+D.

Unlisted
Commands

You can assign a hot key to a command that does not appear in the grid
above by clicking Unlisted Commands. In the Other Commands dialog,
select a command, then click OK. The unlisted command appears in the
grid.

Reset to Factory
Defaults

This returns the tab to the factory default keyboard shortcuts.
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Options Dialog—Build Tab
Option Description

Enable byte order
mark

Select this to enable the byte order mark (BOM). The BOM is a Unicode
character that appears at the start of a text stream. Most authors
probably want to disable the BOM. But if you are hosting content on a
web server that requires BOM (such as a LINUX machine), you can
enable it.

On the first launch of Flare Desktop, it will use the preset value of the
BOM option from your registry. If there isn’t a value in the registry, it will
be turned off. After the first launch, you can only enable or disable BOM
through the Options dialog. The registry will reflect the changes, but the
registry will not be used to control the enabling or disabling of the BOM.

Build target (if
needed) after
selecting 'View'

If you select an option in the user interface to view output from a target,
Flare Desktop shows that output if it is up to date. But if there is no
output or it is out of date, Flare Desktop gives you a message, asking if
you want to build the output. This feature lets you avoid seeing this
message for all targets in all projects.

View output after
successful build

The Builds window pane has a button that lets you open output after it
has been generated so you can view it. Select this option to do this
automatically at a global level for all targets in all projects.

CHAPTER 6  219



Option Description

Maximum
Concurrent Builds

You can use this field to limit the number of targets that can be
generated at the same time. If you are concerned about Flare Desktop
slowing down during builds, you may want to make sure this number is
not too high.

EXAMPLE You have three targets in your project and you have
the Maximum Concurrent Builds field set at 2.

You generate Target 1, and then shortly after, you also generate
Target 2. These targets compile simultaneously.

Then you tell Flare Desktop to generate Target 3. But because
your maximum number is 2, Target 3 is queued for the moment.

Let's say Target 2 finishes building. At that point, Target 3 begins
its build process while Target 1 also continues its generation.
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Log Destination You can choose where your log file will be stored when you build a
target. The default location is the Output folder, but you can also choose
to place it in the Reports folder of the Project Organizer, or you can
select a custom location.
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Use timestamps in
log file

Select this option if you want your output build logs to include time
markers for each activity in your target's compilation. This might help
you identify places where your build is lagging.

Warnings You can tell Flare Desktop to ignore certain warnings so that they do not
display as such in the Builds window pane when generating output. This
can be done globally for all targets in all projects by using this section.
You can also override those global settings for a specific target in a
project.

You can remove check marks next to any warning that you want Flare
Desktop to ignore. By default, all check boxes are initially selected.

Reset Warnings If you want to return to the default settings where all of the check boxes
are selected, you can click this option.
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Options Dialog—Review Tab
Section Options and Descriptions

User Name When you first install and launch Flare Desktop, your login user name is
captured and stored in the Options dialog (File > Options). You can
change the user name (for Flare Desktop purposes) in this field.

Initials The first two letters of the user name are also stored as your initials.
This information is employed whenever you use the track changes and
annotations features. For example, if you insert an annotation in a topic,
your initials are displayed at the beginning of the comment so that other
users know where the annotation came from. You can change your
initials in this field.
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Tracked Change
Display

You can change the way tracked changes are displayed in the interface.

n
Display all changes in balloons If you select this option, all
changes—text and formatting—will be shown in balloons in the
sidebar.

n
Display only format changes in balloons If you select this option,
changes that include content only (or content plus formatting) will
be shown inline. But changes that contain formatting
modifications only will be shown in balloons in the sidebar.

n
Display all non-format changes inline If you select this option, all
text changes will be shown inline. Balloons are not used.
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Section Options and Descriptions

n
Change Bar Select whether or not you want to turn on change
bars. If you turn on change bars, a bar appears on the left side of
the line where a change has been made.

CHAPTER 6  225



Section Options and Descriptions

User Colors The tracked changes and annotations for each user can be shown in a
separate color. You also have the option of choosing a specific color for
all users.

n
Use a different color for each user Select this option if you want
Flare Desktop to automatically assign a different color for each
user.

n
Use the following color for all users Select this option if you want
all changes, regardless of the user, to display in the same color.
After you choose this option, click the down arrow below to select
a color.
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Options Dialog—Plugins Tab
Field Description

Name Displays the name of the plugin, based on the DLL file you have created
and added to the Flare Desktop installation folder in Windows.

Description Displays a description of the plugin.

Version Displays the version number of the plugin.

Enable/Disable Click Enable to install the plugin, then restart Flare Desktop. Click Disable
to uninstall the plugin.

CHAPTER 6  228



Options Dialog—Services Tab
These options are for the Content Services Portal and Elasticsearch service.

Option Description

Content Services URL This location is used to run the web services associated with your
Elasticsearch target. Click the Restore Default button to revert back to
the original URL.

Elasticsearch URL This location runs the search engine for your Elasticsearch target.
Click the Restore Default button to revert back to the original URL.

Memory allocation This field manages the amount of memory used by the Elasticsearch
service. This is set to 512 MB by default. Click the Restore Default
button to revert back to the original URL.

Show console
windows

This option enables the console windows if you need to troubleshoot
your Elasticsearch build. For this option to take effect, please restart
the MadCap Process Manager in the system tray.
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Project Properties Dialog
This dialog is used to see basic information (e.g., location of files, creation date) and to make
property changes for your Flare project in the following ways.

Tabs/Options Description

Defaults

Primary TOC In most situations, you will have one TOC that you use for a particular
output (target). In that case, you simply associate the appropriate TOC
with the target. If you have multiple TOCs that you want to include in
the same project or output target, the TOC that you associate with the
project or target serves as the primary TOC. In your primary TOC, you
have the option of creating links to the other TOC that you want to
include in the output. If you do not select a TOC, Flare Desktop will use
the first one in the project (if there is more than one). If you have
specified a primary TOC at the project level and another at a target
level, the TOC at the target will take precedence. Click in the field and
select a table of contents (TOC) from your project to use as the primary
one. If you click the Edit button, the selected TOC opens in the TOC
Editor.

Primary Page Layout After you create a page layout and configure its frames and settings as
necessary, you need to associate the page layout with the appropriate
content. In most cases, you will probably want to associate different
page layouts with various entries in your outline TOC (so that different
page layouts can be used for different parts or chapters in a manual).
Otherwise, you would associate a single "primary" page layout with an
entire target or project; in that case, the same page layout will be
applied to all topics in that target or project. You can associate a page
layout with an outline TOC entry with or without creating a chapter
break at the same time. Click in the field and select a page layout from
your project to use as the primary one. If you click the Edit button, the
selected page layout opens in the Page Layout Editor.
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Branding Stylesheet The branding stylesheet (Branding.css) specifically identifies values for
branding elements for your project. When you add a new branding file
to a project it will not include all the necessary connections for instant
results, but it will tie the stylesheet to a project if you select it as your
primary branding stylesheet. (The branding stylesheet can also be
associated at the Target level.) If you click the Edit button, the selected
stylesheet opens in the Branding Editor.

Primary Stylesheet When you want to use styles in your content, the stylesheet needs to be
made available for the content in question. In Flare Desktop, you can
associate regular stylesheets with individual files. However, you also
have the option of using a regular stylesheet as the primary one,
applying it at either the project or target level, or both. If you associate
a primary stylesheet with an entire project, the styles will be available
for the content in the project. If you have specified a primary stylesheet
at the project level and another at a target level, the stylesheet at the
target will take precedence. If you are using different primary
stylesheets for different targets, the stylesheet associated with the
primary target determines what you see in the XML Editor. You can set
a target-level primary stylesheet on the General tab of the Target
Editor. Click in the field and select a stylesheet from your project to use
as the primary one. If you click the Edit button, the selected stylesheet
opens in the Stylesheet Editor.
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Meta Tags You can set meta tag values and override those inherited from a meta
tag set. You can also create custom meta tags at the project level.

Language You can select a language to use for the project.

Source Control You can select several options related to source control. The options
shown are different, depending on which source control provider your
project is bound to.

Bind Project If you have a Flare project open—and bind detection in the Options
dialog is disabled, or if you don't already have a repository in the
folder—you will see a button that lets you bind (i.e., connect) it to a
source control application. Binding a project to source control lets you
take advantage of the many multi-author features available through
source control integration. This includes automatic check-in, check-out;
viewing differences between source control and local copies of the
project files; and more. If the bind detection option is enabled in the
Options dialog and you already have a repository in the folder, which
Flare Desktop locates, the project will automatically become bound to
it.

Unbind or Disable
Provider

You can remove the connection between the Flare project and a
source control provider. You can also disable a provider so that the
Flare Desktop interface is not available for source control tasks for that
provider.

Check In Files When you are finished editing files, you can check them in to source
control. Checking in a file overwrites the old copy of the file in the
database with the new one from your local machine. Even if others are
not working on a file, it is a good idea to periodically check in files for a
backup in source control. You will see this option if your project is
bound to Microsoft Team Foundation Server.
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Commit When you are finished editing files, you can commit them to source
control. If you are working with Git, committing a file adds your
changes to the local database. When you are ready to add your local
commits to the remote repository, you can push these files to the
remote. If you are working with Subversion, committing a file
overwrites the old copy of the file in the source control database with
the new one from your local machine. You will see this option if your
project is bound to Git or Subversion.

Submit When you are finished editing files, you can submit them to source
control. Submitting a file overwrites the old copy of the file in the
source control database with the new one from your local machine. So
even if others will not be working on that file, it is a good idea to
periodically submit files so that you have a backup in source control.
You will see this option if your project is bound to Perforce Helix Core.

Check Out Files When you need to work on any of the Flare Desktop project files, you
can check them out. Checking out files means to copy the latest source
control files to your local Flare Desktop project and remove the "Read
Only" designation from them so that you can edit the files. A red check
mark is displayed next to each file that is checked out. You will see this
option if your project is bound to Microsoft Team Foundation Server or
Perforce Helix Core.

Lock Files When you are working, you may want to lock the files you have
modified. Locking a file does not prevent other users from modifying
the file. However, no one else can commit a file that you have locked
until you unlock the file. If your project is bound to Subversion, you can
steal a lock from another user if you need to commit a locked file while
they are working on it. Likewise, another user can steal a lock on a file
you have locked. You will see this option if your project is bound to
Perforce Helix Core or Subversion.
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Unlock Files If you have locked a file, you should unlock it when you are done
modifying it. Other users can modify the file while you have it locked,
but they cannot submit a locked file until you unlock it. To help prevent
file conflicts and make sure that everyone on your team has the most
current version of the file, you should unlock and submit the file when
you are finished working on it. You will see this option if your project is
bound to Perforce Helix Core or Subversion.

Get Latest Version After you bind a Flare Desktop project to a source control application,
you can get the latest version of any of the source control files. When
you do this, you are copying the most current files stored in the source
control application to your local Flare Desktop project without
necessarily checking out the files. This means that the "Read Only"
designation will remain associated with the files until you check them
out. You will see this option if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.

Update After you bind a Flare project to Subversion, you can update any of the
source control files. When you do this, you are copying the most
current files stored in Subversion to your local Flare project. When
working with other authors, it is a good idea to do this frequently (e.g.,
at the beginning of each day) in order to ensure you have the latest
changes that those authors have made, and that they have the latest
changes you've made. You will see this option if your project is bound
to Subversion.

Undo Check Out If you have files checked out from source control but do not want them
checked out anymore, you can use the "Undo Check Out" option instead
of checking in the files. You will see this option if your project is bound
to Microsoft Team Foundation Server.
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Revert If you have modified files from source control but do not want to keep
your modifications, use the "Revert" option instead of committing the
files. While committing the file would save changes to source control,
reverting a file returns it to its previously committed state and does not
commit any of your new changes to source control. When reverting
changes made in Git, you only revert changes to the file on the branch
you are currently editing. If you have a file that resides on multiple
branches, copies of the file on other branches are preserved. You will
see this option if your project is bound to Git, Perforce Helix Core, or
Subversion.

View Differences One of the benefits of Flare Desktop's integrated source control is that
you can view the history and differences for a particular file. You will
see this option for all source control providers.

View History One of the benefits of Flare Desktop's integrated source control is that
you can view the history for a particular file, including who checked in
the file and when it was checked in. You can also view differences
between different versions of the file and roll back to an older version if
necessary. You will see this option for all source control providers.

Create or Edit Ignore
File

If you bind a project to Git outside of Flare Desktop (i.e., you do not use
Flare Desktop's interface to do the binding), you should make sure that
you have a .gitignore file. You can add the .gitignore file by selecting an
option in the Source Control Explorer or Project Properties dialog. Once
you have a project containing a .gitignore file, the button in the
interface changes to "Edit Ignore File," so that you can open the file to
make edits to it.
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CHAPTER 7

Ribbons and Toolbars
Flare Desktop's user interface lets you use ribbons and toolbars to access features.

This chapter discusses the following:

Ribbons 237

Quick Launch Bar 331

Quick Access Toolbar 333

Global Toolbars 336
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Ribbons
Flare Desktop's user interface lets you switch between using a ribbon layout, or using a more
traditional tool strip layout. The ribbon layout consists of a File drop-down with common tasks such
as creating new projects and files, as well as opening and saving documents. This is followed by
the Home ribbon, which is the default, and several others related to various features in Flare
Desktop.
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Characteristics

n Switch Views By default ribbons are used when you install and launch Flare Desktop for the
first time. However, you can use the Options dialog (File > Options) to switch back to the
classic tool strip.

n Minimize You can minimize the ribbons so that you only see the top portion of the ribbons
until you select an option. To do this, right-click anywhere in a ribbon and select Minimize the
Ribbon from the context menu.
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n Hidden Ribbons Some ribbons are not always shown. For example, the Source Control ribbon
is displayed only if your project is bound to version control.

n Icons/Text Ribbons consist of icons and text, which let you perform various tasks. Larger
icons are shown for the most common tasks.

n Sections Ribbons are split into sections to make it easier to locate the options on them. For
example, the Review ribbon contains the following sections: Packages, Changes,
Annotations, Locks, and Options.
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n Reducing Application Window Size When you reduce the size of the entire application
window, the ribbons are also reduced in a way that lets you continue to access hidden
options by clicking on the section name.

EXAMPLE You have the application window maximized, and this is what you see
when opening the Project ribbon:

If you reduce the size of the application window, the ribbon shrinks along with it. You
can still access all of the options. Some icons are simply smaller, and others are
accessible from section drop-downs.
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File Menu
Various options are available in the File menu for starting and managing projects.

Option Description

Opens the Start New Project Wizard, which you can use to
create a new project. You can also use this wizard to import
files from other sources. Click on the arrow to the right to show
a list of different wizards that you can use to import a variety of
file types into the project. You can also choose to create a new
project or import from source control.

Opens the Add File dialog, which you can use to add a variety of
files to your project.

Opens a dialog, which lets you open any type of file supported
by Flare Desktop.
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Click the face of the button to save changes to the active file.
You can also select an option from the submenu.

n Save Saves changes to the active file.

n Save All Saves changes to all of the open files.

n Save As Opens the Save As dialog, which lets you save
the active file under a different name and/or file type and
to a particular location. The new file is then displayed in
the editor.

n Save To Opens the Save As dialog, which lets you save
the active file under a different name and/or file type and
to a particular location. The new file is not automatically
displayed in the editor.

n Save As Template Opens the Save as Template dialog,
which lets you save a copy of the active file as a
template. When you create a new file of the same type in
the future, you can select your template file as a starting
point for the new file.

n Save As Contribution Template Opens the Save as
Contribution Template Wizard, which you can use to
create templates for others to use.
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Click the face of the button to open the Print dialog and send a
file to a printer. You can also select an option from the
submenu.

n Print Opens the Print dialog, which lets you send a file to
a printer. Make sure that the item that you want to print is
selected. For example, if you want to print a topic from
the Help system, first click somewhere inside the topic
so that it is the active element in the interface.

n Print Preview Opens the Print Preview dialog, which lets
you see how a document looks before you send it to a
printer. Make sure that the item that you want to preview
is selected. For example, if you want to preview a topic
from the Help system, first click somewhere inside the
topic so that it is the active element in the interface.
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Click the face of the button to create a temporary copy of the
active file. You can also select an option from the submenu.

n Send to Backups Creates a temporary copy of the file
that is open and active in the interface (not files that you
select in the Content Explorer, Project Organizer, or File
List window pane). The file is placed in the Backups
window pane.

n Clear the "Backups Folder" Removes all temporary
backup files from the Backups window pane.

EXAMPLE You might use this feature, for example, if
you want to make some changes to a file but are not
certain if you will want to keep them when you are
finished. Therefore, you can make a backup of the file
in question. When you are finished making your
changes, you might decide that you prefer the file the
way it was. If so, you can quickly roll back to the
backup file, which overwrites the changes that you
made.

Opens the Properties dialog for the selected item.
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Click the arrow and choose from the following. The options
shown are different, depending on which source control
provider your project is bound to.

n
Import Project Opens the Import From Source Control
Wizard, which lets you create a new project by importing
an existing project that is located in a source control
application.

You will see this option for all source control providers.

n
Add Opens the Check In dialog, which lets you add the
selected files to the integrated source control
application.

When working in a project that is connected to source
control, there may be occasions when you have files in
your local copy of the project that are not yet part of the
source control copy. For example, when you add a new
topic in your local copy of the project, that file will not be
included in the source control copy of the project until
you add it.

You will see this option for all source control providers

n
Check In Opens the Check In dialog, which lets you check
files into source control.

When you are finished editing files, you can check them
in to source control. Checking in a file overwrites the old
copy of the file in the database with the new one from
your local machine. Even if others are not working on a
file, it is a good idea to periodically check in files for a
backup in source control.

You will see this option if your project is bound to
Microsoft Team Foundation Server.
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n
Commit Opens the Commit dialog, which lets you
commit files into source control.

When you are finished editing files, you can commit them
to source control. If you are working with Git, committing
a file adds your changes to the local database. When you
are ready to add your local commits to the remote
repository, you can push these files to the remote.

If you are working with Subversion, committing a file
overwrites the old copy of the file in the source control
database with the new one from your local machine.

You will see this option if your project is bound to Git or
Subversion.

n
Submit Opens the Submit dialog, which lets you submit
files into source control.

When you are finished editing files, you can submit them
to source control. Submitting a file overwrites the old
copy of the file in the source control database with the
new one from your local machine. So even if others will
not be working on that file, it is a good idea to periodically
submit files so that you have a backup in source control.

You will see this option if your project is bound to
Perforce Helix Core.

n
Check Out Opens the Check Out dialog, which lets you
check out files from source control.

When you need to work on any of the Flare Desktop
project files, you can check them out. Checking out files
means to copy the latest source control files to your local
Flare Desktop project and remove the "Read Only"
designation from them so that you can edit the files. A
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red check mark is displayed next to each file that is
checked out.

You will see this option if your project is bound to
Microsoft Team Foundation Server or Helix Core.

n
Lock Opens the Lock dialog, where you can select files to
lock. If your project is bound to Subversion, you can steal
locks from another user's locked files.

When you are working, you may want to lock the files you
have modified. Locking a file does not prevent other
users from modifying the file. However, no one else can
commit a file that you have locked until you unlock the
file.

If your project is bound to Subversion, you can steal a
lock from another user if you need to commit a locked
file while they are working on it. Likewise, another user
can steal a lock on a file you have locked.

You will see this option if your project is bound to Helix
Core or Subversion.

n
Unlock Opens the Unlock dialog, where you can select
files you want to unlock.

If you have locked a file, you should unlock it when you
are done modifying it. Other users can modify the file
while you have it locked, but they cannot submit a locked
file until you unlock it. To help prevent file conflicts and
make sure that everyone on your team has the most
current version of the file, you should unlock and submit
the file when you are finished working on it.

You will see this option if your project is bound to Helix
Core or Subversion.
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n
Get Latest Version Opens the Get Latest Version dialog,
which lets you "get" files from source control.

After you bind a Flare Desktop project to a source control
application, you can get the latest version of any of the
source control files. When you do this, you are copying
the most current files stored in the source control
application to your local Flare Desktop project without
necessarily checking out the files. This means that the
"Read Only" designation will remain associated with the
files until you check them out.

You will see this option if your project is bound to
Microsoft Team Foundation Server or Helix Core.

n
Update Opens the Get Latest Version dialog, which lets
you update files from source control.

After you bind a Flare Desktop project to Subversion, you
can update any of the source control files. When you do
this, you are copying the most current files stored in
Subversion to your local Flare Desktop project.

You will see this option if your project is bound to
Subversion.

n
Undo Check Out Opens the Undo Check Out dialog, which
lets you reverse the check-out of the files.

If you have files checked out from source control but do
not want them checked out anymore, you can use the
"Undo Check Out" option instead of checking in the files.

You will see this option if your project is bound to
Microsoft Team Foundation Server.

n
Revert Opens the Revert dialog, which lets you return
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files to their last known state.

If you have modified files from source control but do not
want to keep your modifications, use the "Revert" option
instead of committing the files. While committing the file
would save changes to source control, reverting a file
returns it to its previously committed state and does not
commit any of your new changes to source
control. When reverting changes made in Git, you only
revert changes to the file on the branch you are currently
editing. If you have a file that resides on multiple
branches, copies of the file on other branches are
preserved.

You will see this option if your project is bound to Git,
Helix Core, or Subversion.

n
Show Differences Opens a window pane that lets you
view the content and code differences for files. If you
select a single file and choose this option, the differences
between the local version of the file and the source
control version of the file are shown. If you select two
files and choose this option, the differences between
those two files are shown.

You will see this option for all source control providers.

n
View History Opens the History dialog, which lets you
view the history of a particular source control file,
including all of the occasions when the file has been
checked in. You can then use the dialog to view the
differences between older versions of the file or roll back
to a particular version.

You will see this option for all source control providers.

n
Undelete Undeletes a file, allowing you to add it to source
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control. You will see this option if your project is bound to
Microsoft Team Foundation Server.

n
Refresh Refreshes the window pane so that the latest
information is shown. You will see this option for all
source control providers.

n
Network Settings Opens the Network Settings dialog,
which lets you view and modify source control network
settings from Flare Desktop.

You will see this option if your project is bound to Git or
Subversion.

Click the arrow to open a submenu, which lets you select
various SharePoint options for the selected file(s).

n Check In Opens the Check In dialog, which lets you check
files into SharePoint. When you are finished editing files,
you can check them in to SharePoint.

n Check Out Opens the Check Out dialog, which lets you
check out files from SharePoint.

n Undo Check Out Opens the Undo Check Out dialog, which
lets you reverse the check-out of the files.

Click the face of the button to close the active file. You can also
select an option from the submenu.

n Close Closes the active file.

n Close Project Closes the current project, but the
application itself does not close.
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Displays a list of recently opened projects. You can select one
from the list to open it. You can also remove projects from the
list of recently opened projects, which lets you keep the list
shorter and more manageable. When you use this feature, the
project is merely removed from the list, but the actual project is
not deleted.

Displays a list of recently opened files. You can select one from
the list to open it. You can also remove files from the list of
recently opened files, which lets you keep the list shorter and
more manageable. When you use this feature, the file is merely
removed from the list, but the actual file is not deleted.

Opens the Options dialog, which lets you set various global
options.

Closes the application.
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Home Ribbon
Various options are available in the Home ribbon for managing content.

Option Description

Pastes the selection from the clipboard to the
place where the cursor is inserted.

Cuts the selection and sends it to the clipboard.

Copies the selection and sends it to the clipboard.

Deletes the selection.

Lets you select a font type (e.g., Arial, Times New
Roman), applying it to the content selected in the
topic.

Lets you select a font size, applying it to the
content selected in the topic.

Applies bold typeface to the content selected in
the topic.

Applies italic typeface to the content selected in
the topic.

Underlines the content selected in the topic.
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Raises the selected content in the topic above the
normal line of text (e.g., X2).

Lowers the selected content in the topic below the
normal line of text (e.g., X2).

Removes local formatting in a selection or even an
entire topic.

Lets you choose and apply a color to the selected
content.

Lets you choose and apply a color to the
background of the selected content.

You can set redacted text on any kind of content
(e.g., characters, paragraphs, images, tables). You
can do this locally at the font level by highlighting
each piece of content, or you can specify redaction
on a style and then apply that style to content
whenever necessary. It is recommended that you
use styles whenever possible. Redaction occurs
when content is permanently eliminated from a
printed or electronic document. In place of that
content, end users will see black rectangles that
indicate where the original content was found.

(at bottom of Font section) Opens the Font Properties dialog, which lets you
edit the font properties for topic content directly.
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Lets you select one of several kinds of bullet or
numbered lists, applying it to the selected content.
If you want to create a bulleted or numbered list, it
is a best practice to limit your selections to the
Bullet List and Numbered List options, then rely on
list style settings to provide the type of list item
automatically depending on its level. For example,
for a three-level numbered list, you can place
settings on the ol style for the first level, on ol ol for
the second level, and on ol ol ol for the third level.

n
Bullet List Applies a bulleted list to the
selected content.

n Circle Bullet List Applies a bulleted list to the
selected content. The bullets are circles.

n Square Bullet List Applies a bulleted list to
the selected content. The bullets are
squares.

n Numbered List Applies a numbered list to
the selected content.

n Lower-alpha Numbered List Applies a
numbered list to the selected content where
lowercase alpha characters are used (a., b.,
c., d., etc.)

n Upper-alpha Numbered List Applies a
numbered list to the selected content where
uppercase alpha characters are used (A., B.,
C., D., etc.)

n Lower-Roman Numbered List Applies a
numbered list to the selected content where
lowercase Roman numerals are used (i., ii.,
iii., iv., etc.)

n Upper-Roman Numbered List Applies a
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numbered list to the selected content where
uppercase Roman numerals are used (I., II.,
III., IV., etc.)

n Definition List A definition list is used to
create a group of terms and definitions. It is
also sometimes referred to as a description
list, and although it is called a "list," it does
not have bullets or numbers. Instead, it is
similar to a table that doesn't have borders
(although it can have borders, shading, etc. if
you edit the necessary styles).

n Custom Format Opens a custom list format
that lets you create a uniquely styled list up
to 10 levels deep. You can also select an
existing custom format from this submenu
to apply it to the selected content in your
topic or snippet. At this time, custom list
formats are supported only in PDF output.
After browsers begin to support the CSS3
marker element that makes custom list
formats possible, this feature will
automatically be supported in browser-
based outputs as well. Until then, if you want
to generate a browser-based output, you
should use the standard method for creating
lists instead.

Removes the group tag from a paragraph, thus
"outdenting" it.
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Lets you use a group tag such as <div> to indent
content. Another method for indenting content is
through the use of margin or padding settings on a
style.

NOTE If you click inside a paragraph
(rather than at the very beginning) and
press Tab or click in the Home ribbon
or Text Format toolabar, you will notice
that the paragraph is not indented, but
rather the Create Group dialog opens,
allowing you to select different types of
block styles. These styles let you create
block-level content in a unique "container"
for different purposes. For more
information about tag groups, see the Help
system.
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Lets you apply miscellaneous actions to selected
content in a list.

n Merge With Previous List Combines a list
with another list immediately before it.

n Merge With Next List Combines a list with
another list immediately following it.

n Sort List Reorders the items in the list
alphabetically.

n Reverse List Reorders the items in the list so
that they appear in reverse order (i.e., first
item is last, last item is first).

n Unbind List Removes the list designation
from the content so that it displays as
regular text.

n
Continue Sequence Ensures that the next list
you create in the topic starts with the next
number in the sequence of the list above
(even if the two lists are separated by other
content).

EXAMPLE You have a numbered list
from 1 to 10 at the top of your topic
and you add a few regular
paragraphs (not in a list) after it. If
you start another numbered list and
select this option, the new list will
start at 11.

n List Start Number Lets you specify a number
to start a numbered list.
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n
Item Number Lets you specify a number to
start a selected item in a numbered list.

EXAMPLE You have a numbered list
from 1 to 10. If you click in the
paragraph with the number 7 and
then use this option to start
numbering at 23, your list would
change so the numbering displayed
as 1 to 6, and then 23 to 26.

n Move Up Moves the selected item in the list
above the item before it.

n Move Down Moves the selected item in the
list below the item after it.

n Make Simple Item(s) Lets you return a line in
a list from a paragraph item to a simple item
(an <li> tag without a <p> tag following it).
Paragraph items can be used in numbered
or bulleted lists, for example, to add
comments without disrupting the flow of the
list.

n Make Paragraph Item(s) Lets you add a <p>
tag after the <li> tag in a numbered or
bulleted list. You can then add more lines
after a list item without adding numbers or
bullets to those lines. Paragraph items can
be used in numbered or bulleted lists, for
example, to add comments without
disrupting the flow of the list.

CHAPTER 7  258



Option Description

Groups selected items. The Create Group dialog
opens, which lets you create a group from selected
content and apply one of the following tags to it:
<blockquote>, <div>, <fieldset>, <form>.

Aligns the selected content to the left.

Aligns the selected content in the center.

Aligns the selected content to the right.

Spaces the selected content so that both the left
and right sides are aligned.

Resets the alignment of the selected text to the
default (inherited) setting.

(at bottom of Paragraph section) Opens the Paragraph Properties dialog, which lets
you edit the paragraph properties for topic content
directly. This includes the ability to apply page
breaks, column breaks, and widow/orphan control
to a paragraph directly.
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Opens the Styles window pane, which displays
styles contained in the stylesheets that are
associated with the current topic. The styles that
are shown depend on the positioning of your
cursor in the topic. For example, if the cursor is
highlighting multiple paragraphs or is simply
placed somewhere within a paragraph, the
paragraph styles are shown in the Styles window
pane. If the cursor is highlighting a portion of a
paragraph, the character styles are shown.

Opens the Responsive Layout window pane, which
lets you create single-row grids that allow your
content to be responsive. This means that the
structure of the content shifts, depending on the
size of the screen displaying it.

Opens the Formatting window pane, which has
two tabs. The Style Inspector tab lets you see the
style details for selected content in the open file
(e.g., topic, snippet), and even edit those styles if
necessary, without having to open the full
stylesheet. The Local Properties tab displays local
formatting for the selected content in a topic.
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Lets you apply a style to the content selected in
the topic.

When you attempt to apply a style to content using
the Style drop-down in the Home ribbon, the Styles
window pane, or the floating Style Picker, previews
of the various styles are shown by default. This
gives you an idea of how each style looks before
you apply it to the content.

If you prefer not to see style previews in these
areas of the user interface, you can open the
Options dialog (File > Options) and disable the
preview on the XML Editor tab. Remove the check
mark from Show style previews in UI.
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With this option disabled, all of the styles will be
presented as plain text when you select them.

TIP It is likely that you will have certain
styles that you tend to use more than
others. You can pin these styles in various
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places of the Flare Desktop interface so
that they are always easily accessible.

Opens the Create Style dialog, which lets you
create a new style for the content selected in the
content file.

Opens the Stylesheet Links dialog, which lets you
apply one or more stylesheets to the active
content file.

Opens the Create Snippet dialog, which lets you
create a new snippet from the content selected in
the topic.

Lets you create a micro content file from a topic or
snippet.

This window pane is used to set attributes for a
tag. Attributes let you provide additional
information about tagged content and how that
content should behave.

Opens a dialog that lets you apply conditions to
content.

Opens the Select Language dialog, which lets you
choose a language for the selected content.
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Opens the Manage Named Elements, which you
can use to name content when creating togglers.

Opens a submenu, which lets you choose from
various options.

n Find and Replace in Files Opens the Find and
Replace in Files window pane, which lets you
search for and replace text in multiple
documents. .

n Find Results 1 Opens the Find Results 1
window pane, which is used to display
results from a search in the Find in and
Replace in Files window pane.

n Find Results 2 Opens the Find Results 2
window pane, which is used to display
results from a search in the Find in and
Replace in Files window pane.

n Find Elements Opens the Find Elements
window pane, which is used for finding files
containing particular elements—custom
tags, MadCap-specific features (e.g., drop-
down text, concepts, equations), markup,
inline styles, and style classes. You have the
flexibility to look in all files in the project or
only in the open documents. The results of
the search are displayed in either the Find
Results 1 window pane or in the Find Results
2 window pane, depending on your selection.

Opens the Quick Find widget in the upper-right
corner of the open document. This lets you search
for text in that document.
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Opens the Quick Replace widget in the upper-right
corner of the open document. This is the same as
the Quick Find widget, except that it opens with the
replace fields already in view. It lets you search for
and replace text in that document.

Opens the Find Elements window pane, where you
can search for specific elements, tags, styles, and
markup in the open document or the entire project.

Opens the Properties dialog for the selected item.
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Various options are available in the Insert ribbon for adding different features and elements.

Option Description

Opens a dialog that lets you insert an image at the location of
the cursor.

Opens a submenu, which lets you select options for inserting
multimedia (audio and video).

n Flash Movie Opens the Insert Multimedia dialog, with
tabs designed specifically for inserting Adobe Flash
files.

n Windows Media Player Opens the Insert Multimedia
dialog, with tabs designed specifically for inserting
Windows Media files.

n Quicktime Movie Opens the Insert Multimedia dialog,
with tabs designed specifically for inserting Quicktime
files.

n Mimic Movie Opens a dialog that lets you insert a Mimic
movie link into a topic. You must have MadCap Mimic
installed on your computer in order to use this feature.

n HTML5 Movie Opens the Insert Multimedia dialog, with
tabs designed specifically for inserting HTML5 movie
files (e.g., MP4, WebM).

n 3D Model Opens the Insert Multimedia dialog, with tabs
designed specifically for inserting 3D model files.

n YouTube/Vimeo Opens the Insert Multimedia dialog,
with tabs designed specifically for linking to YouTube or
Vimeo movies and embedding them in your content
files.
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Opens the Screen Capture dialog, which lets you insert a
screen capture image into a topic. You must have MadCap
Capture installed on your computer in order to use this
feature.

Opens the Insert QR Code dialog, which lets you create and
insert a QR code into a content file (e.g., topic, snippet).

Inserts a slideshow element into a content file (e.g., topic,
snippet). You can use a slideshow as an alternative way to
display content, using navigation controls to move from slide
to slide to view different content. You can place most kinds of
content into a slideshow, including snippets, text, tables, and
more.

If you click on the face of the button, the Insert Table dialog
opens, which lets you insert a table and specify various
settings for it.

If you click the down arrow, you can use a grid to select the
number of rows and columns for a simple table and insert it.

Lets you insert or edit a text hyperlink in a content file.

Lets you insert or edit a cross-reference in a content file (e.g.,
topic, snippet).
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Opens the Manage Bookmarks dialog, which lets you insert a
bookmark into a topic.

Opens the Named Destination dialog, where you can name
and insert a named destination for use in Adobe PDF output.
This allows you point to a specific place in a PDF from the
selected location.

Opens the Create Glossary Term dialog, which lets you create
a glossary term and definition, and insert a link to the
definition into a topic. In order for this option to be enabled,
you first need to select text in the topic that you want to use
as the glossary term link.

Creates and inserts an index keyword at the location in your
topic where text is selected. To enable this option, you must
first select the text in the topic that you want to use as the
index keyword.

Opens the Insert Snippet Link dialog, which lets you insert a
snippet into a content file (e.g., topic, snippet).

Opens the Variables dialog, which lets you insert a variable.

Opens the Insert Toggler dialog, which lets you insert a toggler
into a content file (e.g., topic, snippet).
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Opens a submenu, which lets you choose an option.

n Drop-Down Text Creates a drop-down effect from the
selected content.

n Drop-Down Hotspot Lets you specify the exact text to
use in a drop-down effect as the drop-down hotspot. In
order for this option to be enabled, you first need to
create a drop-down effect. Then select a portion of the
drop-down head and choose this option.

Opens a submenu, which lets you choose an option.

n Expanding Text Creates an expanding text effect from
the selected content.

n Expanding Hotspot Lets you adjust the text that serves
as the hotspot. In order for this option to be enabled,
you first need to create an expanding text effect. Then
highlight the text in the current hotspot area and select
this option. This pushes any text after your selecting
into the second set of brackets.

Opens the Insert Text Popup dialog, which lets you insert a
text popup into a content file (e.g., topic, snippet).
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Opens the Insert Text Box dialog, which lets you insert a box
into a topic (using a <div> tag) so that you can add content to
it. A text box can be positioned in a variety of places on a page
(e.g., aligned left on the page, outside frame, center of
column).

EXAMPLE You want to add a case study that is
positioned next to the main body text on a page.
Therefore, you insert a text box with a border and
unique background color to make it stand out. You
position the text box to the left of the body frame on a
page. That way, it is clear to the reader that the case
study is intended to provide additional information
pertaining to the body text on that page.

Opens the Insert Footnote/Endnote dialog, which lets you
insert a footnote or endnote. When inserting a footnote or
endnote, an indicator (a number by default) is added at the
location where your cursor is placed in the topic. Also, you can
determine where the accompanying comment is inserted. A
footnote is typically added at the end of a page, but you can
also insert an endnote at the end of a document, chapter,
section, or book.

Opens the Insert Rule dialog, which lets you insert a rule
(horizontal line) into a content file (e.g., topic, snippet).
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Inserts a manual page break into a content file (e.g., topic,
snippet). Placing a page break on a style may be the preferred
method in many cases, but there may be times when you find
that it makes more sense to use an independent page break
directly in the content file. This might be the case, for example,
if you need a page break to occur after a paragraph and just
before a heading, but only in some outputs. After inserting the
page break, you can set conditions on it if necessary so that it
is used in some outputs but not others.

Opens the Code Editor, which lets you insert a code snippet.
The syntax is automatically highlighted according to the
language, similar to text editors such as Sublime Text and
Notepad++. In HTML5 output, users can click a Copy button,
then paste the code into a third-party editor.

Opens the Insert Related Topics Control dialog, which lets you
insert a related topics link into a topic.

Opens the Insert Concept Link Control dialog, which lets you
insert a concept (See Also) link into a topic.

Opens the Insert Keyword Link Control dialog, which lets you
insert a keyword link into a topic.

Opens the Insert Shortcut Control dialog. Insert a shortcut
control into a topic.
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Opens the Equation Editor, which lets you insert a
mathematical equation into a content file (e.g., topic, snippet).

Opens a submenu for inserting special characters or symbols
into the editor.

n Insert Quick Character Inserts the quick character. You
can also do this by clicking the by pressing F11 on the
keyboard.

n Non-breaking Space Inserts a non-breaking space. This
is a special space character that prevents an automatic
line break (line wrap) at its position. Also known as a
hard space or fixed space, it can be used to create
multiple spaces in a row in systems like HTML that
reduce sequences of normal spaces to a single space.
You can also insert a non-breaking space by pressing
SHIFT+SPACE on your keyboard.

n Non-breaking Hyphen Inserts a non-breaking hyphen.
You can also insert a non-breaking hyphen by pressing
CTRL+SHIFT+- on your keyboard.

n Favorites Displays and lets you select any of the
characters and symbols from your favorites list.

n Recently Used Displays and lets you select any of your
most recently used characters and symbols.

n More characters Opens the new Character dialog.

Opens the Insert Script dialog. Insert a script into a content file
(e.g., topic, snippet).
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Opens the Insert IFrame dialog. Add external content to a
topic (e.g., a web page).
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Opens a submenu, which lets you select a proxy to insert into
a topic. A proxy is a placeholder for a certain type of content.

n Body Proxy You can insert a Body proxy into a template
page. You can then enter text above the proxy (for a
header) or below the proxy (for a footer). In order for this
option to be enabled, open a template page first.

n Breadcrumbs Proxy You can insert a Breadcrumbs
proxy into a template page or an individual topic. If a
proxy is included in a template page or topic, the output
displays a "trail of breadcrumbs" composed of the table
of contents (TOC) entries above the current topic in the
TOC hierarchy.

n Topic Toolbar Proxy You can insert a topic toolbar proxy
into a template page or an individual topic. You can use
the topic toolbar proxy to generate a web toolbar
anywhere in any topics. This is an alternative (or an
additional option) to the regular toolbar that can be
included in all online outputs (via the Help Viewer or
through the use of skins).

n TOC Proxy You can insert a TOC proxy into a topic. TOC
proxies are primarily used when creating print-based
output from your project, but they can also be used in
online output, in particular when you generate HTML5
Top Navigation output that does not have a built-in TOC.
When you build the output, the TOC proxy is replaced
with the generated TOC from your project.

n Mini-Toc Proxy You can insert a "mini-TOC" proxy into a
template page or topic. If this proxy is included in a
template page or topic, the output will display links to
TOC entries below the current topic in the TOC hierarchy
(a "mini-TOC").

n Index Proxy You can insert an Index proxy into a topic.
Index proxies are used when creating print-based output
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from your project. When you build the printed output, the
Index proxy is replaced with the generated index from
your project.

n Glossary Proxy You can insert a Glossary proxy into a
topic. Glossary proxies are used when creating print-
based output from your project. When you build the
printed output, the Glossary proxy is replaced with the
generated glossary from your project.

n Endnotes Proxy You can insert an Endnotes proxy into a
topic. You would use this proxy if you want to generate a
list of your footnotes on a separate page of your output,
perhaps at the end of the manual. When you build the
output, the Endnotes proxy is replaced with the
generated list of footnotes from your project.

n Concepts Proxy You can insert a Concepts proxy into a
topic. You would use this proxy if you want to generate a
list of the concepts in your project. When you build the
output, the Concepts proxy is replaced with the
generated list of concepts from your project.

n List-Of Proxy You can insert a List-Of proxy into a topic
based on a particular style class. This lets you create a
list of elements, such as a list of images or tables in
your project. When you build the output, the proxy is
replaced with the generated list.

n Relationships Proxy You can insert a Relationships
proxy into a topic or template page. This lets you create
a link that is based on a relationship table. When you
build the output, the proxy is replaced with the
generated link, which lets users quickly navigate to
related topics.

n Search Bar Proxy You can insert a Search Bar proxy into
a topic or template page. A Search Bar proxy lets you
create a field that can be used to perform searches in
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HTML5 output. When you build the output, the proxy is
replaced with the generated search bar. If you insert a
search bar using a proxy, you might also need to hide
the search bar from some topics so that you do not
have two search bars on a page.

n Menu Proxy You can insert a Menu proxy into a topic or
template page. A Menu proxy lets you create a topic
menu based on your TOC file, allowing users to navigate
to other topics. This proxy can be especially useful if
you are creating HTML5 Top Navigation or skinless
output and you want a context-sensitive menu to display
next to each topic. When you build the output, the proxy
is replaced with the generated menu.

n Search Results Proxy You can insert a Search Results
proxy into a topic. A Search Results proxy works with
the Search Bar proxy and lets you create a container
that is used to display the results of end user searches
in your output. When you build the output, the proxy is
replaced with the generated search results.

n Flare Online Account Proxy You can insert a Flare Online
Account proxy into a topic or template page. A Flare
Online Account proxy lets you create an account link
drop-down, allowing users viewing private output to log
out or edit their MadCap Flare Online profile settings. By
default, the account link is included automatically in the
header of the regular skin.

n eLearning Toolbar Proxy You can insert a proxy into a
template page. The eLearning Toolbar proxy lets you
include intuitive navigation buttons and controls in your
course. These might be a Next and Previous button, or a
progress bar. When you build HTML5 output, the proxy
content is replaced with the generated navigation tools.

n Test Results Proxy You can insert a Test Results proxy
into a topic. Creating a topic to use as a link for a
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custom test results page is just like creating any other
content, but you also need to include a Test Results
proxy. The proxy is necessary for displaying content
such as the test results score, learner answers vs.
correct answers, and feedback.

n FAQ Proxy You can insert an FAQ proxy into a topic or
template page. The FAQ proxy lets you generate a list of
phrases and responses for the selected micro content
file(s) in most outputs. Results are static, based on
specific criteria selected when the target is built, not on
the search engine output. This type of proxy is ideal for
including traditional FAQs, but it can be used for other
purposes as well.

n Knowledge Proxy You can insert a Knowledge proxy into
a topic or template page. The Knowledge proxy lets you
display filtered micro content items in HTML5 output.
Results are dynamic, generated at runtime in the
browser, using search engine rankings. You might use a
Knowledge proxy to display content such as information
about a person, a company, technical specifications,
related tasks, etc.

n Promotion Proxy You can insert a Promotion proxy into
a topic or template page. A Search Results proxy works
with the Search Bar proxy and lets you create a
container that is used to display the results of end user
searches in your output. When you build the output, the
proxy is replaced with the generated search results.
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Opens the Page Header dialog, which lets you insert a Page
Header proxy into a topic. Page header proxies are used when
creating printed output from your project. When you build the
printed output, the Page Header proxy is replaced with the
page header from the template page your project (see "Body
Proxy" above). A page header is simply a block of text that you
can format freely and include variables such as page
numbers.

Opens the Page Footer dialog, which lets you insert a Page
Footer proxy into a topic. Page footer proxies are used when
creating printed output from your project. When you build the
printed output, the Page Footer proxy is replaced with the
page footer from the template page in your project (see "Body
Proxy" above). A page footer is simply a block of text that you
can format freely and include variables such as page
numbers.
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Various options are available in the View ribbon for opening interface elements.

Option Description

Opens the Content Explorer, which is one of the most-used elements in the
Flare Desktop interface. The Content Explorer, just as it sounds, is used to
hold all of the content-related items in your project.

Opens the Project Organizer, which is one of the most-used elements in the
Flare Desktop interface. The Project Organizer, just as it sounds, is used to
hold all of the project-related items in your project.

Opens the File List window pane, which lets you view all of the content files
in your project in alphabetical order. You can limit the files that are
displayed by using the file type filter. For example, if you want to see only
your image files, you could select the "Image/Media Files" option from the
Filter drop-down list. You can also perform certain tasks from this window
pane, such as opening files, applying condition tags, and applying
stylesheets. And because you can select multiple files from the list, you can
perform these tasks for all of the selected files at the same time.

Opens the Source Control Explorer. The Source Control Explorer is used to
view and manage source control-related files and settings for your project.

Opens the Builds window pane, which is used to display targets as they are
being generated.
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Opens the Flare Online window pane. From there, you can log in to your
Flare Online account. You can also perform tasks related to Flare Online
while you are working in Flare Desktop.

Opens the Start Page, which provides links to high-level tasks and
information.

Opens the Messages window pane, which displays important information
as you work. For example, if a necessary file is missing, this window pane
lets you know.

Opens the Backups window pane so that you can see the files for which you
have created backups and restore (roll back) any of those files if necessary.

Opens the Preview window pane, which shows a preview of the open topic,
snippet, or template page. The Preview window pane is dynamic, allowing
you to keep the preview open while you work and see changes as you make
them in the XML Editor. Initially, the window pane opens as a floating
window. This can be quite useful if you are working with dual monitors,
because you can drag the Preview window pane to one monitor while
editing the topic in the other monitor. However, you always have the option
of docking the Preview window pane to the interface.  

If you click the down arrow, you can choose a target; otherwise, the preview
opens according to the settings in the primary target (e.g., with the
appropriate conditions already applied).
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Opens the Glossary Terms window pane, which you can use to see all of the
glossary terms and definitions that you have added to the project. You can
double-click the terms in this window pane to insert them as links.

Opens the Index window pane, which is used to create index keywords and
insert them into topics.

Opens the Concept window pane, which is used to create concepts and
insert them into topics.

Opens the Link Viewer window pane, which is used to view other files linked
to and from the active file.

Opens the Footnotes window pane, which lets you see all of the footnotes
that have been added in the active topic.

Opens the Frame Contents window pane, which lets you add content to the
selected frame in a page layout.

Opens the External Resources window pane, which lets you work with
external resource files that you want to bring into your projects.
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Opens the SharePoint Explorer, which lets you connect to a SharePoint
server and work with files that you want to bring into your projects.

Opens the Contributions window pane, which lets you see documents
received from contributors that are pending acceptance.

It also lets you see a list of contribution templates that you have created
and send them to others.

Hides or shows special information pertaining to the editor or window pane.

Opens or closes the status bar at the bottom of the program window.
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Various options are available in the Project ribbon for managing your project.

Option Description

Click on the face of the button to add a new topic. You can also click
the down arrow and choose a different kind of element to add. Either
way, the Add File Dialog opens. The Add File dialog will be populated
with all the settings for the item you select. You can change the
selected item in the File Type field at the top of the dialog.

Opens a submenu with options for importing different types of
external files.

n Flare Project Lets you import files from another project, linking
them to the current project. That way, you can single-source
the content across multiple projects.

n MS Word Documents

n MS Excel Workbooks

n HTML File Set

n Confluence Pages

n Markdown Documents

n FrameMaker Documents

n DITA Document Set

If you click the face of the button, output is generated for the target
that is designated as the "primary" target. When the build process
finishes, you are asked if you want to view the output. Click Yes if you
do.

If you click the down arrow, you can select a specific target (not
necessarily the primary target) to generate.
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Lets you view the output for the target that you have designated as
the primary target. If the target has not yet been generated, or if
changes have been made to the project since it was last generated,
you will be asked if you want to build the output. Click Yes if you do.

If you click the down arrow, you can select a specific target (not
necessarily the primary target) to view.

Publishes the output for the primary target to its destination(s). If the
target has not yet been generated, or if changes have been made to
the project since it was last generated, you will be asked if you want
to build the output. Click Yes if you do.

If you click the down arrow, you can select a specific target (not
necessarily the primary target) to publish.

Deletes the Output folder for the project and all output files inside.
The next time you build a target, the Output folder will be created
again to hold the new output files.

Opens the project Output folder in Windows so that you can see the
output subfolders and files.

Opens the Builds window pane, which is used to display targets as
they are being generated.

Opens the primary target in the Target Editor.
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Opens the primary TOC in the TOC Editor.

Opens the Stylesheet Editor and displays the primary stylesheet
specified in your primary target. If you have not specified a primary
stylesheet in that target, it opens the primary stylesheet specified for
the project (Project > Project Properties). If you have not specified a
primary stylesheet for either of those, this option is disabled.

Opens the Branding Editor and displays the primary branding
stylesheet in your primary target. If this ribbon option is disabled, that
is an indication of no branding file, or that no branding stylesheet is
set in the Project Properties or Target Editor.

Opens the Page Layout Editor and displays the primary page layout
specified in your primary target. If you have not specified a primary
page layout in that target, it opens the primary page layout specified
for the project (Project > Project Properties). If you have not specified
a primary page layout for either of those, it opens the first page layout
listed in your project (in the Resources > PageLayouts subfolder of
the Content Explorer).

Opens the Export Project Wizard, which lets you export a project, or
parts of one, to another location.

CHAPTER 7  285



Option Description

Opens a submenu, which lets you select an option to "pack" your
project into a single zip file, which makes it easier to move it and send
it to other individuals who have Flare Desktop installed.

n Zip Project Opens the Create Package dialog, which lets you zip
a project and select a location for storing it.

n Zip and Email Project Automatically zips the project, opens
your email program, and attaches the zip file to a new
message. All you need to do is provide the address of the email
recipient and send the email.

Opens the Save Project as Template Wizard, which lets you save the
project and its files in another location as a template. When you
create a new project in the future, you can select the template project
as a starting place for the new project.

Opens the Synchronize Files dialog, which lets you synchronize files
in your project that are linked to source files elsewhere.

Opens the External Resources window pane, which lets you work with
external resource files that you want to bring into your projects.

Opens the SharePoint Explorer, which lets you connect to a
SharePoint server and work with files that you want to bring into your
projects.

Opens the Map Files and Folders dialog, which lets you create and
edit mappings for files in your project that are linked to source files
elsewhere. .
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Opens the TOC Editor and highlights the location of the active topic in
the TOC.

Opens the Content Explorer and highlights the location of the
selected content file within it.

Opens the Project Properties dialog, which lets you perform various
actions.

n Select a primary table of contents (TOC) for the entire project.
The TOC will be used for all targets in the project. However, you
can also set a primary TOC at the target level. If you do that, the
TOC specified at on the target takes precedence over the
primary TOC set at the project level.

n Select a primary page layout for the entire project.

n Select a primary stylesheet for the entire project, as well as
allow local stylesheets to be applied to files separately.

n Create custom meta tags for the project, set meta tag values,
and override meta tag values inherited from the meta tag set.

n Select a language to be used for the project.

n Bind a project to source control, and unbind it.
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Various options are available in the Analysis ribbon for analyzing your project.

Option Description

Opens the Analysis window pane, which is the primary window pane used
for analysis in your project. This window pane displays a list of current
issues in the project being analyzed.
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Opens a submenu, which lets you select window panes that show
information about links in your project.

n Broken Links Opens the Broken Links window pane. You can view a
list of files in your project where a broken link is located, including
which file it is trying to find, the link text, the link tag, and other
information. Also, you can open the file where the broken link is
located. The broken link is highlighted so that you can easily fix it.

n Broken Bookmarks Opens the Broken Bookmarks window pane. You
can view a list of files with broken bookmarks, including the bookmark
destination that the link is trying to find, the link text, the link tag, and
other information. Also, you can open the file where the broken link is
located so that you can fix it.

n External Links Opens the External Links window pane. You can view a
list of files in your Flare project containing links to external files. For
example, if you have a text hyperlink to a website, the file name where
the link exists is displayed. By clicking the "Check" button, you can
verify that all external links point to valid destinations. You can either
double-click on the specific row, or right-click on the row and select
Open. This lets you fix any problems with external links.

n
Absolute Links Opens the Absolute Links window pane. You can view
a list of files in your Flare project containing absolute links to other
files. An absolute link contains the full path to the target file. For
example, let's say you have a text hyperlink that points to a file in your
project like this: file://C:\MyProject\Content\MyFile.htm. (You can
view this link format in the file's true code, which can be seen by using
the Internal Text Editor in the source Flare project.) Because users do
not have access to your local C: drive, they will not be able to use the
link successfully in the output. Instead, the link should be relative to
the file in your project, with dots and slashes that represent each
folder level away from the current file (e.g., ..\..\MyFile.htm). You do
not need to create this path manually; instead, it is automatically
created when you properly insert a link by using the interface. The
Absolute Links window pane lets you find absolute links so that you
turn them into relative links (by re-inserting the link). You can either
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double-click on the specific row, or right-click on the row and select
Open. The link is highlighted so that you can easily fix it.

n Named Destinations Opens the Named Destinations window pane,
which displays files in your project containing named destinations for
PDF output.

n Index Keyword Links Opens the Index Keyword Links window pane.
You can view a list of all index keywords used in index links
throughout your project. You can also quickly rename index keywords
associated with the links.

n Concept Links Opens the Concept Links window pane. You can view a
list of all concepts that have been used in concept links throughout
your project. You can also quickly rename concepts associated with
the links.
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Opens a submenu, which lets you open window panes that display
suggestions for improving your project.

n Index Keyword Suggestions Opens the Index Keyword suggestions
pane. You can view a list of topics containing text that matches
existing index keywords in your project. You can then quickly add the
same index keywords to those topics.

n Snippet Suggestions Opens the Snippet Suggestions window pane.
You can view content that matches existing snippets in your project,
and you can quickly convert these occurrences to snippets. You can
also double-click a row to open the topic in question, with the potential
snippet content highlighted.

n Variable Suggestions Opens the Variable Suggestions window pane.
You can view regular text that matches existing variables in your
project, and then quickly convert these occurrences to variables. You
can also double-click a row to open the topic in question, with the
potential variable text highlighted.

n New Style Suggestions Opens the New Style Suggestions window
pane. You can view the places in a project containing local formatting.
The analysis tool suggests that you convert these instances to new
styles. You can use the Create New Style dialog to do just that. You
can also double-click a row to open the file where the formatted
content exists.

n
Replace Local Style Suggestions Opens the Replace Local Style
Suggestions window pane. You can view the places in your project
where you have used local formatting. The analysis tool suggests that
you replace these instances of formatting with existing styles in your
stylesheet that match the formatting that you have applied manually.
This is different from a new style suggestion in the following way:
With a new style suggestion, the properties in the tag do not match an
existing style exactly; therefore, the analysis suggests that you create
a new style. On the other hand, if you make formatting changes that
happen to result in an exact match to all of the properties in an
existing style, the analysis suggests that you replace the formatting
with that style (rather than creating a new style).
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n Accessibility Suggestions Opens the Accessibility Suggestions
window pane, where you can search for places in your project where
you can make accessibility improvements for web-based and PDF
outputs in Flare Desktop. That way, you can make sure your
documentation can be accessed by people with disabilities (i.e.,
individuals who have visual, hearing, and mobility impairments). This
includes the ability to identify tables that are missing certain elements
and finding objects—such as images, equations, and QR codes—that
are missing alternate text. You can click the "Search Properties"
button to customize which types of issues to display in the window
pane. You can double-click a row to open the topic or other file. You
can also right-click on the row and select Open.

n Markup Suggestions Opens the Markup Suggestions window pane,
where you can search for places in your project where the XHTML
markup (code) can be improved (e.g., empty tags, CDATA tags, empty
attributes, excessive spaces). You can click the "Apply" button to
automatically apply the suggestions to the selected files. You can
click the "Search Properties" button to customize which types of
issues to display in the window pane. You can double-click a row to
open the topic or other file in Flare Desktop. You can also right-click
on the row and select Open.

n Cross-Reference Suggestions Opens the Cross-Reference
Suggestions window pane, where you can search for hyperlinks in
your project that can be converted to cross-references. You can
double-click a row to open the file and proceed to convert the
hyperlink into a cross-reference.

n Writing Suggestions Opens the Writing Suggestions window pane.
You can view places in your project where you can make writing
improvements based on industry-wide standards. For example, the
analysis tool can locate files where an h1 or h2 heading has only one
subheading (i.e., an h1 heading with only one h2 heading under it, or
an h2 heading with only one h3 heading under it). It is recommended
that you have more than one subheading under a parent heading.
Therefore, occurrences such as these are raised as concerns. The
analysis tool can also locate files where a heading level has been
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skipped (e.g., an h1 heading is followed by an h3 heading, rather than
h2), as well as any files where consecutive headings exist (e.g., an h1
heading is followed by an h2 heading, with no other content between
them). You can use the Writing Suggestions Search Properties dialog
to customize which types of suggestions to display in the window
pane.

n Frequent Segments Opens the Frequent Segments window pane,
which lets you view a list of segments that occur frequently in your
project. You can see the text, the number of occurrences of each
segment, and the number of words and characters in each segment. If
you notice that certain segments are repeated numerous times
throughout your project, you can easily convert them to snippets or
variables.

n Similar Segments Opens the Similar Segments window pane. You can
view a list of segments of text in your project that are similar, but not
identical, to each other. You may want to modify similar segments so
that they become identical to each other, or even convert them to
snippets. You can also use the "Start Search" button to limit or expand
the list of similar segments that are displayed.
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Opens a submenu, which lets you open window panes showing information
related to undefined elements in your project. These undefined elements
include glossary term links, undefined variables, condition tags, file tags,
and styles.

n Undefined Glossary Term Links Opens the Undefined Glossary Term
Links window pane. You can view a list of files where glossary term
links are inserted, but those glossary terms do not appear in any of
your glossary files. This might occur, for example, if you have created
a new term in a glossary and then inserted that term into a topic as a
glossary term link. Later, you remove that term from the glossary. You
now have a glossary term link in a topic, but the term no longer exists
in the glossary. Therefore, a problem exists. You need to either
remove the glossary term link from the content, or you need to add the
term to the glossary again. From the Undefined Glossary Term Links
window pane, you can quickly unbind or rename multiple glossary
term link occurrences in a single batch, add a new glossary term, or
map the undefined term to an existing glossary term.

n Undefined Variables Opens the Undefined Variables window pane.
You can view a list of all files where you have variables inserted in the
content, but those variables have not been defined. This might occur,
for example, if you have inserted a variable in a topic and then later
change the name of the variable or variable set. The old variable or set
name is still used at the location where it was previously inserted in
the topic; therefore, a problem exists. From the Undefined Variables
window pane, you can open the topic in question and fix the undefined
variable. You can also quickly rename or remove multiple variables in
a single batch, add the undefined variable to the project, or map the
undefined variable to an existing variable.

n Undefined Condition Tags Opens the Undefined Condition Tags
window pane. You can view a list of all files where you have condition
tags in the content, but those condition tags have not been defined.
This might occur, for example, if you have applied a condition tag in a
topic and then later change the name of the tag or condition tag set.
The old tag or set name is still used at the location where it was
previously applied in the topic. Therefore, a problem exists. From the
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Undefined Condition Tags window pane, you can open the file in
question and fix the undefined condition tag. You can also quickly
rename or remove multiple condition tag occurrences in a single
batch, add the undefined tag to the project, or map the undefined tag
to an existing condition tag.

n Undefined File Tags Opens the Undefined File Tags window pane. You
can view a list of all files that are associated with file tags, but those
file tags have not been defined. This might occur, for example, if you
have associated a file tag with a topic and then later change the name
of the tag or file tag set. The old tag or set name is still used for the
topic. Therefore, a problem exists. From the Undefined File Tags
window pane, you can open the file in question and fix the undefined
tag. You can also quickly rename or remove multiple file tag
occurrences in a single batch.

n Undefined Styles Opens the Undefined Styles window pane. You can
view a list of all files where you have style classes applied to content,
but those styles have not been defined. This might occur, for example,
if you have created a new style class and applied it to a paragraph in a
topic. Later, you remove that style class from the stylesheet.
Therefore, you now have a style in a topic that is no longer defined in
the stylesheet. You need to either apply a different, existing style class
to that content, or you need to add the style class to the stylesheet
again. You can also quickly rename or remove multiple style
occurrences in a single batch, add the undefined style to the project,
or map the undefined style to an existing style.

n Undefined Meta Tags Opens the Undefined Meta Tags window pane.
You can view a list of all files with meta tags applied to them, but
those meta tags have not been defined. This might occur, for
example, if you have applied a meta tag to a file and then later change
the name of the tag or meta tag set in the Text Editor.
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Opens a submenu, which lets you open window panes showing information
related to used elements in your project. This includes condition tags, file
tags, language tags, variables, index keywords, concepts, and bookmarks.

n Used Condition Tags You can view a list of all condition tags that have
been applied in files throughout your project. The list shows not only
the condition tags, but each file where they have been used. You can
also quickly rename or remove multiple condition tag occurrences in a
single batch.

n Used File Tags You can view a list of all file tags used in your project.
The list shows the tag type and the file that it is associated with. You
can quickly rename or remove multiple file tag occurrences in a single
batch.

n Used Language Tags You can view a list showing each file where a
language tag is found, the content tag to which it has been applied
(e.g., html, span), and the language used.

n Used Variables You can view a list of variables that have been inserted
in your project. The list shows not only the variables, but each topic
where they have been used. You can also quickly rename or remove
multiple variable occurrences in a single batch.

n Used Index Keywords You can view a list of all index keywords used
throughout your project. You can also quickly rename multiple
keyword occurrences in a single batch.

n Used Concepts You can view a list of all concepts used in your
project. You can also quickly rename multiple concept occurrences in
a single batch.

n Used Bookmarks You can view a list showing each file where a link to
a bookmark is found, including the name of the bookmark, the kind of
link used, and the path of the link. You can also double-click a row to
open the file where the bookmark link is inserted.

n Used Meta Tags You can view a list of all meta tags that have been
applied to files throughout your project. The list shows not only the
meta tags, but each file where they have been used, and the values
(i.e., content) of each. You can also quickly rename or remove multiple
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meta tag occurrences in a single batch.
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Opens a submenu, which lets you open additional window panes for
additional analysis of your Flare project.

n Files With Annotations Opens the Files With Annotations window. You
can view a list of all files where annotations (internal comments) have
been inserted. You can also double-click a row to open the topic in
question.

n Files With Changes Opens the Files with Changes window pane where
you can view all topics in your project that contain tracked changes.
You can either double-click on the specific row, or right-click on the
row and select Open.

n Topics Not In Index Opens the Topics Not in Index window pane. You
can view a list of all topics where you have not yet inserted index
keywords. Therefore, no references to those topics will be found in the
generated index. You can also double-click a row to open the topic in
question.

n Topics Not In Selected TOC Opens the Topics Not in Selected TOC
window pane. You can view a list of all topics that have been created
in the project, but they have not yet been linked to any items in a TOC.
A drop-down filter lets you select a specific TOC to analyze, or you can
select "Any TOC" to analyze all TOCs in a project.

n Topics Not Linked by Map ID Opens the Topics Not Linked By Map ID
window pane. You can view a list of all topics that are not linked to
context-sensitive Help (CSH) map IDs. You can also double-click a row
to open the topic in question.

n Duplicate TOC Items Opens the Duplicate TOC Items window pane,
which lets you view a list of all files in your project that have been
added more than once to a table of contents.

n
Duplicate Style Formats Opens the Duplicate Styles window pane. You
can view a list of all styles in your project where the same properties
have been set. For example, let's say you have a style called "p.tip" and
another style called "p.note." If you have specified the same settings
for each of these styles (e.g., red font, 12 pt), with no other properties
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set, these styles will be included in the Duplicate Styles window pane.
Groups or pairs of duplicate styles are displayed in alternating shaded
rows (e.g., the rows for the first pair of duplicate styles are not shaded,
the rows for the next group are shaded, the rows for the next group
are not shaded, and so on). If you encounter duplicate styles, you may
want to modify the settings for one or both styles, or you can remove
one of the style classes from the stylesheet.

NOTE Duplicate styles are displayed only if they are based on
the same tag. For example, if you have identical properties set
for the styles "p.tip" and "p.note," they will be included in the
window pane (because they are both based on the p style).
However, if you have identical properties set for the styles
"p.tip" and "h4.note," they will not be included in the window
pane (because one is based on the p style, whereas the other
is based on the h4 style).

n Duplicate Meta Tags Opens the Duplicate Meta Tags window pane.
You can view a list of all meta tags that have been applied to files
throughout your project and whose values are defined two or more
times in the same file. However, the same meta tag name is allowed in
different meta tag sets.

n Unused Items Opens the Unused Items window pane, which lets you
view lists of unused elements in your project.

n Non-XML Topics Opens the Non-XML Topics window pane. You can
view a list of non-XML files (e.g., HTML files) that have been added to
your project. You can also convert those HTML files to XHTML files in
a single batch.

n Files With Snippet Conditions Opens the Files with Snippet Conditions
window pane. You can view a list of all files where snippet conditions
have been applied. You can also double-click a row to open the file in
question.

n Files Without File Tags Opens the Files Without File Tags window

CHAPTER 7  299



Option Description

pane. You can view a list of all content files in the project that do not
have file tags. Then you can open the properties for a file and
associate one or more file tags with it.

n Topics Without Concepts Opens the Topics Without Concepts window
pane. You can view a list of all topics in the project that do not have
concepts inserted. You can then open a topic and insert concepts into
it.

n Invalid Meta Values Opens the Invalid Meta Values window pane. You
can view a list of all files containing meta tags that have invalid
values. For example, an invalid meta tag might occur if you remove a
meta tag's list item from the meta tag set file. In a case such as this,
you can resolve the issue by adding the list item back to the meta tag
set, or re-associating the files with a different value.

Opens the File Issues Viewer, where you can see any issues associated with
selected files. You can use the File List window pane to quickly add many
files to this Viewer, or you can add files one at a time from within the user
interface.
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Various options are available in the Review ribbon for dealing with topic reviews.

Option Description

Opens the Send File for Review Wizard, which lets you specify
settings and send the open file to others so that they can review it.

Opens the File Reviews window pane, which lets you see files that
have been reviewed from others and are pending acceptance.

It also lets you see a list of files that you have sent out for review.

Opens a dialog, which lets you import reviewed files into your
project. After that, you can view and/or accept the file. You might
use this feature, for example, if you have received a file from a
reviewer, but rather than immediately sending the file to your Inbox
from the email message, you saved it to your local drive.

Opens the Review Packages window pane, which displays all of the
files contained in a review package received from another Flare
author. From this window pane you can open the files to review
and edit them.

Enables or disables the track changes feature. 

Accepts tracked changes or annotations in the active document,
making them part of that document. You can click the down arrow
to accept a single change or all of them.
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Rejects tracked changes or annotations in the active document,
removing them from that document. You can click the down arrow
to reject a single change or all of them.

Opens a sidebar and displays any tracked changes or annotations
(notes) that have been attached to any content in the topic.

Navigates to the previous change or annotation.

Navigates to the next change or annotation.

Adds an annotation rectangle, extended to a sidebar to the right,
with a line pointing to the selected content. This rectangle will hold
annotation text after you type it. Also, the selected content is
shaded, indicating that the annotation refers to that text. However,
the shading will not be displayed in the output; it is for internal use
only.

Removes annotations from the document. You can click the down
arrow to delete a single annotation or all of them.
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Opens a submenu to select options for locking content in files so
that it cannot be edited.

n Mark Element(s) to be Locked Places a gray background
behind the selected content in the file, where content can be
locked. In order to see this gray background, select the
option below to show locked elements.

n Locks (Disabled/Enabled) Locks or unlocks the content
designated with the gray background. After content has been
locked, it cannot be edited, and annotations cannot be added
to it.

n Show Locked Elements Lets you show or hide the gray
background associated with elements that have been locked
or selected to be locked.

Opens the Review tab in the Options dialog, which lets you set
various options for viewing tracked changes and annotations.
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Various options are available in the Tools ribbon for working with and improving your project.

Option Description

Opens the Open Dictionary dialog, which lets you choose a
custom global or project dictionary so you can make changes
to it.

Opens the Spell Check window pane, which lets you perform
spell checking manually.

Activates a feature that lets you check your spelling as you
type in your topics. Questionable words are underlined with a
jagged red line. You can take action with the word by right-
clicking on it.

Opens the Ignored Words dialog, which lets you create a list of
words to be ignored when using the spell checking feature in
the application.

Opens the Thesaurus window pane, which lets you quickly
view and select words related to those in an open topic or
snippet.

Opens the Text Analysis window pane, which lets you evaluate
your files for things such as readability, average sentence
length, and more.

Opens the Hyphenation window pane, which lets you add
custom hyphenation rules for words so that they are
hyphenated at the end of lines after specific letters.
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Opens the Template Manager, where you can perform a
variety of tasks to manage your template files.

Opens the Context-sensitive Help API Tester dialog, which lets
you test the context-sensitive Help links that you've created in
the Alias Editor.

Opens the Export Header Files dialog, which lets you export
existing header files in your project to another location. You
can export header files to the following formats: C/C++ (.h),
Visual Basic (.bas), Java (.properties), Delphi Pascal (.inc).
Work with your developer to determine the appropriate format
(s) to use.

Opens the Update Cross-References dialog, which lets you
update the cross-references that you have added to topics. By
updating the cross-references, you can ensure that they
reflect any changes in your project that might affect them.

Updating cross-references is not a mandatory step. When you
generate output for a target, all of your cross-references will
be updated automatically. However, you can use this feature
to manually update cross-references in a single topic. This is a
way of performing a "spot check" ahead of time, verifying that
cross-references will be updated accurately before you
generate the entire target.

Regenerates (updates) all of the images in your project. The
primary reasons for using this option are to remove
watermarks and to modify PROPS files.
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Opens a submenu, which lets you open various integrated
MadCap Software products.

n MadCap Capture Opens the MadCap Capture
application (if you have it installed on your computer),
which lets you capture and edit images.

n MadCap Mimic Opens the MadCap Mimic application (if
you have it installed on your computer), which lets you
create and edit movies.

Lets you record your actions so that they become a macro
command that you can use to repeat the same task.

Lets you select one of your recorded macros so that you can
play it back.

Lets you open a dialog so that you can make changes to any
macros you've recorded.
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The Source Control ribbon uses a dynamic interface. The icons that display will change depending
on the source control provider your project is bound to. Additionally, the ribbon will not display if
you are not using source control.

Option Description

Opens the Pending Changes window pane. This displays files in the project
that are pending check in (if the project is integrated with a source control
application). Use this window pane to see which files you have checked out,
which files have been created but not yet added to source control, which
files other users have checked out, and which files are out of date.

Opens the Check In dialog, which lets you add the selected files to the
integrated source control application.

When working in a project that is connected to source control, there may be
occasions when you have files in your local copy of the project that are not
yet part of the source control copy. For example, when you add a new topic
in your local copy of the project, that file will not be included in the source
control copy of the project until you add it.

You will see this option for all source control providers.

Opens the Check In dialog, which lets you check files into source control.

When you are finished editing files, you can check them in to source control.
Checking in a file overwrites the old copy of the file in the database with the
new one from your local machine. Even if others are not working on a file, it
is a good idea to periodically check in files for a backup in source control.

You will see this option if your project is bound to Microsoft Team
Foundation Server.
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Opens the Commit dialog, which lets you commit files into source control.

When you are finished editing files, you can commit them to source control.

If your project is bound to Git, committing a file adds your changes to the
local database. When you are ready to add your local commits to the remote
repository, you can push these files to the remote.

This icon is Git-specific.

Opens the Commit dialog, which lets you commit files into source control.

When you are finished editing files, you can commit them to source control.

If your project is bound to Subversion, committing a file overwrites the old
copy of the file in the source control database with the new one from your
local machine.

This icon is Subversion-specific.

Opens the Submit dialog, which lets you submit files into source control.

When you are finished editing files, you can submit them to source control.
Submitting a file overwrites the old copy of the file in the source control
database with the new one from your local machine. So even if others will
not be working on that file, it is a good idea to periodically submit files so
that you have a backup in source control.

You will see this option if your project is bound to Perforce Helix Core.
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Opens the Check Out dialog, which lets you check out files from source
control.

When you need to work on any of the Flare Desktop project files, you can
check them out. Checking out files means to copy the latest source control
files to your local Flare Desktop project and remove the "Read Only"
designation from them so that you can edit the files. A red check mark is
displayed next to each file that is checked out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.

Opens the Lock dialog, where you can select files you want to lock. If your
project is bound to Subversion, you can steal locks from another user's
locked files using this dialog.

When you are working, you may want to lock the files you have modified.
Locking a file does not prevent other users from modifying the file. However,
no one else can commit a file that you have locked until you unlock the file.

If your project is bound to Subversion, you can steal a lock from another
user if you need to commit a locked file while they are working on it.
Likewise, another user can steal a lock on a file you have locked.

You will see this option if your project is bound to Perforce Helix Core or
Subversion.
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Opens the Unlock dialog, where you can select files you want to unlock.

If you have locked a file, you should unlock it when you are done modifying
it. Other users can modify the file while you have it locked, but they cannot
submit a locked file until you unlock it. To help prevent file conflicts and
make sure that everyone on your team has the most current version of the
file, you should unlock and submit the file when you are finished working on
it.

You will see this option if your project is bound to Perforce Helix Core or
Subversion.

Opens the Get Latest Version dialog, which lets you "get" files from source
control.

After you bind a Flare Desktop project to a source control application, you
can get the latest version of any of the source control files. When you do
this, you are copying the most current files stored in the source control
application to your local Flare Desktop project without necessarily checking
out the files. This means that the "Read Only" designation will remain
associated with the files until you check them out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.

Opens the Get Latest Version dialog, which lets you update files from source
control.

After you bind a Flare Desktop project to Subversion, you can update any of
the source control files. When you do this, you are copying the most current
files stored in Subversion to your local Flare Desktop project.

You will see this option if your project is bound to Subversion.
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Opens the Undo Check Out dialog, which lets you reverse the check-out of
the files.

If you have files checked out from source control but do not want them
checked out anymore, you can use the "Undo Check Out" option instead of
checking in the files.

You will see this option if your project is bound to Microsoft Team
Foundation Server.

Opens the Revert dialog, which lets you return files to their last known state.

If you have modified files from source control but do not want to keep your
modifications, use the "Revert" option instead of committing the files. While
committing the file would save changes to source control, reverting a file
returns it to its previously committed state and does not commit any of your
new changes to source control. When reverting changes made in Git, you
only revert changes to the file on the branch you are currently editing. If you
have a file that resides on multiple branches, copies of the file on other
branches are preserved.

You will see this option if your project is bound to Git, Perforce Helix Core, or
Subversion.

Opens a window pane that lets you view the content and code differences
for files. If you select a single file and choose this option, the differences
between the local version of the file and the source control version of the file
are shown. If you select two files and choose this option, the differences
between those two files are shown.

You will see this option for all source control providers.
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Opens the History dialog, which lets you view the history of a particular
source control file, including all of the occasions when the file has been
checked in. You can then use the dialog to view the differences between
older versions of the file or roll back to a particular version.

You will see this option for all source control providers.

Undeletes a file, allowing you to add it to source control.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.

Refreshes the window pane so that the latest information is shown.

You will see this option for all source control providers.

Opens the Check In dialog, which lets you check all the files in the project
into source control.

When you are finished editing files, you can check them in to source control.
Checking in a file overwrites the old copy of the file in the database with the
new one from your local machine. Even if others are not working on a file, it
is a good idea to periodically check in files for a backup in source control.

You will see this option if your project is bound to Microsoft Team
Foundation Server.
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Opens the Commit dialog, which lets you commit all the files in the project
into source control.

When you are finished editing files, you can commit them to source control.

If your project is bound to Git, committing a file adds your changes to the
local database. When you are ready to add your local commits to the remote
repository, you can push these files to the remote.

This icon is Git-specific.

Opens the Commit dialog, which lets you commit all the files in the project
into source control.

When you are finished editing files, you can commit them to source control.

If your project is bound to Subversion, committing a file overwrites the old
copy of the file in the source control database with the new one from your
local machine.

This icon is Subversion-specific.

Opens the Submit dialog, which lets you submit all files in the project into
source control.

When you are finished editing files, you can submit them to source control.
Submitting a file overwrites the old copy of the file in the source control
database with the new one from your local machine. So even if others will
not be working on that file, it is a good idea to periodically submit files so
that you have a backup in source control.

You will see this option if your project is bound to Perforce Helix Core.
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Opens the Check Out dialog, which lets you check out all of the files in the
project from source control.

When you need to work on any of the Flare Desktop project files, you can
check them out. Checking out files means to copy the latest source control
files to your local Flare Desktop project and remove the "Read Only"
designation from them so that you can edit the files. A red check mark is
displayed next to each file that is checked out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.

Opens the Get Latest Version dialog, which lets you "get" all of the files in the
project from source control.

After you bind a Flare Desktop project to a source control application, you
can get the latest version of any of the source control files. When you do
this, you are copying the most current files stored in the source control
application to your local Flare Desktop project without necessarily checking
out the files. This means that the "Read Only" designation will remain
associated with the files until you check them out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Perforce Helix Core.

Opens the Get Latest Version dialog, which lets you update all of the files in
the project from source control.

After you bind a Flare Desktop project to Subversion, you can update any of
the source control files. When you do this, you are copying the most current
files stored in Subversion to your local Flare Desktop project.

You will see this option if your project is bound to Subversion.
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Opens the Undo Check Out dialog, which lets you reverse the check-out of
all of the files in the project.

If you have files checked out from source control but do not want them
checked out anymore, you can use the "Undo Check Out" option instead of
checking in the files.

You will see this option if your project is bound to Microsoft Team
Foundation Server.

Opens the Revert dialog, which lets you return all files in the project to their
last known state.

If you have modified files from source control but do not want to keep your
modifications, use the "Revert" option instead of committing the files. While
committing the file would save changes to source control, reverting a file
returns it to its previously committed state and does not commit any of your
new changes to source control. When reverting changes made in Git, you
only revert changes to the file on the branch you are currently editing. If you
have a file that resides on multiple branches, copies of the file on other
branches are preserved.

You will see this option if your project is bound to Git, Perforce Helix Core, or
Subversion.

Opens the Select Remote for Pull dialog, which lets you select the remote
repository from which you will download remote files. After you select the
repository you want to pull from, the remote files are retrieved from the
repository and downloaded to your local project.

If necessary, Flare Desktop will perform a commit before pulling your files.

You will see this option if your project is bound to Git.
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Opens the Select Remote for Push dialog, which lets you select the remote
repository to which you will upload your local commits. After you select the
repository you want to push to, your files are sent to the remote repository.

If necessary, Flare Desktop will perform a commit before pushing your files.

You will see this option if your project is bound to Git.

Opens the Select Remote for Synchronize dialog, which lets you select the
remote you want to use for a pull and push of files.

After you select the repository, Flare Desktop pulls the remote files from the
Git repository and merges them with your local database. Then Flare
Desktop pushes your local changes back to the remote Git repository.

If necessary, Flare Desktop will perform a commit before synchronizing
your files.

You will see this option if your project is bound to Git.

Opens a dialog that lets you view when a branch was started, committed, or
merged. If there are any changes you wish to back out, you have the option
to revert those changes on the branch.

You will see this option if your project is bound to Git.

Opens the Branch Management dialog, which lets you create branches,
switch to (select) a different branch, and delete an existing branch.

A Git branch is a pointer to a snapshot of your changes, or you can think of it
as a variation from the original or main state of your files. Adding a branch
lets you create a new development area for your work (e.g., when
documenting a new feature, rewriting large sections of a topic, or making
structural changes). Then later, you can merge the branch into another one.

You will see this option if your project is bound to Git.
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Opens the Select branch to merge dialog. This lets you choose another
branch to merge with the active branch.

You will see this option if your project is bound to Git.

Disconnects the source control network so you can work offline. You can
reconnect at any time.

You will see this option if your project is bound to TFS, Perforce Helix Core,
or Subversion.

Opens the Network Settings dialog, which lets you view and modify source
control network settings from Flare Desktop.

You will see this option if your project is bound to Git or Subversion.
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Table Ribbon
Various options are available in the Table ribbon for creating and managing tables.

Option Description

If you click on the face of the button, the Insert Table dialog
opens, which lets you insert a table and specify various settings
for it.

If you click the down arrow, you can use a grid to select the
number of rows and columns for a simple table and insert it.

Opens a submenu, which lets you choose options for selecting
the following.

n Select All Cells Selects all of the cells in the table.

n Select Table Selects the entire table.

n Select Row Selects the row where the cursor is placed in
a table.

n Select Column Selects the column where the cursor is
placed in a table.

n Select Cell Selects the cell where the cursor is placed in a
table.

Shows and hides the gridlines in the table.

Opens the Table Properties dialog, which lets you edit
properties of the table (e.g., table size, caption, auto-fit
behavior, stylesheet).
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Opens a submenu, which lets you select an option for deleting.

n Delete Table Deletes the entire table.

n Delete Rows Deletes the selected row(s) in a table.

n Delete Columns Deletes the selected column(s) in a
table.

Inserts a new row in a table. The new row is inserted above the
area where the cursor is inserted.

Inserts a new row in a table. The new row is inserted below the
area where the cursor is inserted.

Inserts a new column in a table. The new column is inserted to
the left of the area where the cursor is inserted.

Inserts a new column in a table. The new column is inserted to
the right of the area where the cursor is inserted.

Turns the selected cells in a table into one big cell. You can
merge any number of rows and columns in a table, as long as
they are adjacent to one another.
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Turns the selected cell in a table into many smaller cells by
splitting the cell. When you split a cell, you are essentially
inserting a smaller table into that cell.

Removes the text from the cells selected in a table.

Opens the Table Cell Content Style dialog, which lets you
choose specific table or paragraph styles to use for the
selected cells.

Removes local cell formatting in a table. If you have applied
local formatting to a table (e.g., applying background shading
to cells directly, not through the use of styles), you can easily
remove it. This is possible even if the topic was previously
saved and closed. The local formatting is removed from the
entire table (if you simply placed your cursor within it) or from
selected cells.

NOTE This option resets formatting placed on the
entire cells (e.g., a background color added to cells
would be removed). However, local formatting on
content (e.g., bold text) is not affected. If you would like
to remove local formatting for cells as well as cell
content, you can use the Remove Inline Formatting
button instead.

Opens a drop-down menu where you can select an existing
table style to apply to selected content.
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Opens the Add File dialog, where the Table Style file type is
already selected. After completing the dialog, the TableStyle
Editor opens.

Opens the table style in the Table Style Editor so that you can
edit styles in the stylesheet.

Applies the table style to the table again.

Opens a submenu, which lets you select options for sorting
table rows .

n Ascending Sorts the selected table rows in ascending
order.

n Descending Sorts the selected table rows in descending
order.

n Advanced Sorting Options Opens the Advanced Sorting
Options dialog. You can sort tables using advanced
options, choosing which columns to sort first. In addition,
you can sort tables in this manner immediately, at
compile time, or both.

Converts a table to text. This option is enabled only if you have
placed the cursor within an existing table.
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Opens a submenu, which lets you select an option.

n Default Adds a placeholder for you to type a caption in
the default position. The factory default position is
centered above the table.

n Above Table Adds a placeholder for you to type a caption
above the table.

n Below Table Adds a placeholder for you to type a caption
below the table.

n None Removes a caption from the table.
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eLearning Ribbon
The eLearning ribbon supports Flare Desktop's learning and development (L&D) capabilities for
creating interactive eLearning courses. This ribbon is the main gateway to many of the eLearning
features. Use it to insert different question types, feedback, placeholders for course navigation and
test results, and more.

Various options are available in the eLearning ribbon for managing eLearning content.

Option Description

Inserts multiple choice question sections into the open topic in the XML
Editor. You can replace the default text with your question and answers. If
you press ENTER after the first answer, another paragraph displays. Only
one answer can be marked as the correct answer.

Inserts multiple response question sections into the open topic in the XML
Editor. You can replace the default text with your question and answers. If
you press ENTER after the first answer, another paragraph displays. More
than one answer can be marked as the correct answer.

Inserts correct feedback and incorrect feedback paragraphs to the active
question section. The feedback displays with default text, indicating for you
to replace it with the appropriate eLearning content. The end-of-test
feedback is implemented with this button, where the feedback displays on
the test results page. This button can also be used in conjunction with the
Add Submit Button for immediate feedback.

Inserts correct feedback, and incorrect feedback paragraphs, plus a submit
button to the active question section. The feedback displays with default
text, indicating for you to replace it with the appropriate eLearning content.
Instant feedback is implemented with this button, where each question
provides immediate feedback. (If feedback already exists for the question,
then only the Submit button is added.)
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Opens the Question Properties window pane, which displays information
about a question section in a topic. This window pane provides alternative
ways to interact with questions and answers (e.g., creating questions,
generating IDs, restricting navigation, assigning answers).

Adds a test node as an unlinked item to the active TOC. If more than one
TOC is open, then selecting this button first opens a Select TOC dialog to
choose a TOC to add the test node. When applied to the TOC, the test node
indicates the start of a gradable test.

Opens the TOC Properties dialog to select eLearning test node options. If
more than one TOC exists that includes a test node, then selecting this
button first opens a Select TOC dialog listing the TOCs with test nodes.
When a TOC is selected from that list, the Test Options display for the test
node.

Opens the Test Result proxy dialog which allows you to insert a Test Result
proxy into a topic. This topic can be set as a custom results page that
displays at the end of a test.

Opens the eLearning Toolbar proxy dialog which allows you to include a
toolbar with navigation controls for a course.
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Window Ribbon
Various options are available in the Window ribbon for adjusting the Flare Desktop interface.

Option Description

Opens the Manage Windows dialog, which lists the files that are
currently open in your project and lets you activate (i.e., switch to), save,
or close a particular file.

Closes open files. You can click the down arrow and select an option.

n Close All Documents Closes all files that you have opened in the
workspace.

n Close All But This Closes all files that you have opened in the
workspace, with the exception of the document that is currently
active.

If you select the Dock option when a window pane is active, the Drag
Pane area is shown or hidden in the window pane accordingly. The
Drag Pane area lets you move the window pane and dock it elsewhere
in the program window.

"Pins" the active window pane or editor to the side of the interface so
that you have more room for your workspace. You can show the
window pane by hovering over the thin bar on the side of the interface.
If you select the pin button at the top-right of the window pane, the
window pane returns to its previous state (no longer pinned to the side
of the interface).

Converts the active window pane or editor to a floating window, which
means it is no longer attached to the interface. This is a good option to
use if you want to work on two topics side-by-side. If you do not want a
window pane or editor to be floating anymore, you can right-click in the
title bar and select Dock.
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Opens a submenu that lists the layouts in your project. Select a layout
to display it in the interface.

Saves the window layout. You can click the down arrow and select an
option.

n Save Window Layout If you are working in a particular layout and
have opened different interface elements or moved interface
elements around, you can select this option to save the changes
to the layout.

n Save Window Layout As Opens the Rename Window Layout
dialog, which lets you save the current interface configuration as
a layout.

If you are working in a particular layout and have opened different
interface elements or moved interface elements around, you can select
this option to return to the saved configuration of the layout.

Returns the current configuration of the interface to the factory layout
settings (the original layout when you first installed and launched Flare
Desktop).

Automatically saves the layout of the workspace when you exit Flare
Desktop. The next time you launch Flare Desktop, that same layout will
be displayed.
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Help Ribbon
Various options are available in the Help ribbon for obtaining more information and assistance.

Option Description

Opens the Help system in a browser.

By default, Flare Desktop's online and dynamic Help system points to
files hosted externally. This allows for live updates to the Help.

Because the Help system is hosted online, you may not be able to
access it if you are behind a firewall or if you have a slow connection.
In that case, you can use a local version of the Help. Flare Desktop will
even switch to the local Help automatically if it detects that you
cannot connect to the external Help system.

If you want to use the local Help manually, open the Options dialog
(File > Options), and on the General tab select Prefer Local Help.

NOTE To choose the local Help system using this field, the
local Help must have been included when you first installed
Flare Desktop. If you did not initially include the local Help
system during installation, you can modify the installation
from Add/Remove Programs in your Control Panel
(Uninstall/Change).

NOTE The local Help system is only updated when the
application is updated. If you want to be sure that you have
the most current version of the Help, disable the local Help.
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Opens the Dynamic Help window pane, which automatically displays
the Help topic related to the active element in the interface.

Opens Help topics. You can select the following options.

n Help TopicOpens the Help topic related to the active element in
the Flare Desktop interface.

n New Help Topic WindowOpens a new instance of a Help topic in
another window.

Opens a Help topic that lets you access one of the printed guides
related to Flare Desktop.

Opens a website containing videos about Flare Desktop.

Opens the MadCap Forums website, where you can obtain additional
information about Flare Desktop and communicate with other Flare
Desktop users.
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Opens the Activate Product Wizard, allowing you to activate or renew
the product.

NOTE You can also activate or deactivate Flare Desktop
using the command line prompt. This can be helpful for
companies using imaged machines and are not able to
activate Flare Desktop from the user interface.

Deactivates the currently used license for the machine running Flare
Desktop.

NOTE You can also activate or deactivate Flare Desktop
using the command line prompt. This can be helpful for
companies using imaged machines and are not able to
activate Flare Desktop from the user interface.

Lets you register your version of Flare Desktop if you have not done so
already. This option is enabled only if you are using a trial version of
the software.

Opens the New Updates Available dialog, which lets you download
Flare Desktop updates from MadCap Software.

Displays a popup that shows information about the current version of
Flare Desktop. Click the popup to make it disappear.

Opens your default internet browser to the MadCap Software bug
submission web page, where you can report the bug.
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NOTE If you encounter issues viewing Help system in the Flare Desktop interface, it might
be caused by your company using a proxy server.

If this is the case, you can open the Options dialog (File > Options), select the Proxy Server
tab, and complete the fields. You might need to consult your network administrator to
obtain the necessary credentials.

After completing the fields on this tab, close and restart Flare Desktop for the changes to
take effect.
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Quick Launch Bar
The Quick Launch bar lets you search for any Flare Desktop file or command. It is located in the
upper-right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the
Quick Launch bar so you can begin typing.
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To search using the Quick Launch bar, type a few letters of the file or command you want to find.
Any available results appear in a drop-down list. Click the Commands or Files links in the list to filter
the results.
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Quick Access Toolbar
You can create a Quick Access toolbar at the top of the workspace to display options that you use
most often. When options are added to the Quick Access toolbar, they are easily accessible,
regardless of the ribbon that is open.

By default the Save, Save All, Undo, and Redo buttons are already added to the toolbar. However,
you can add others as well.

How to Add an Option to the Quick Access
Toolbar
Right-click on an option in the ribbon and from the context menu, select Add to Quick Access
Toolbar.

CHAPTER 7  333



How to Remove an Option From the Quick
Access Toolbar
In the Quick Access toolbar, right-click on the option and from the context menu, select Remove
from Quick Access Toolbar.

NOTE You cannot remove the default Save, Save All, Undo, and Redo options from the
Quick Access toolbar.
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How to Move the Quick Access Toolbar Above
or Below the Ribbon

1. Right-click on the Quick Access toolbar or on a ribbon.

2. From the context menu select one of the following:

n Show Quick Access Toolbar below the Ribbon

n Show Quick Access Toolbar above the Ribbon

NOTE The Quick Access toolbar is available only if you are using the ribbon layout, as
opposed to the classic tool strip. See "Switching Between Ribbons and the Tool Strip" on
page 379.
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Global Toolbars
IMPORTANT The tool strip is deprecated in Flare Desktop, which means that it is slated to
be removed in a future version.

Flare Desktop has multiple global toolbars ("global" meaning they are always available at the top of
the user interface, regardless of the type of document, editor, or window pane you are working on at
the moment).

Global toolbars can be seen only if you are working in the traditional tool strip view, as opposed to
the ribbon view. You can use the Interface tab of the Options dialog (File > Options) to switch
between ribbons and the classic tool strip layout. For more information see the Help system.
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Standard Toolbar
Tools in the Standard toolbar let you perform basic functions, such as Save, Cut, Copy, Paste, Undo,
and Redo. There are also shortcut buttons for performing source control functions, as well as
sending documents to other applications (e.g., opening a topic's true code in Notepad in order to
edit the tags). To see this toolbar you can select View > Toolbars > Standard.

Option Description

Opens the Start Page, which provides links to high-level tasks and
information. See "Start Page" on page 12.

Opens the Start New Project Wizard, which you can use to create a new
project. You can also use this wizard to import files from other sources.

Opens a dialog, which lets you open any type of file supported by Flare
Desktop.

Saves changes to the active file.

Saves changes to all of the open files.

Opens a submenu, which lets you open the active file in another application,
attach it to an email, or open the Windows folder where it is stored.
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Opens a submenu, which lets you select various source control options for
the selected file(s). The options shown are different, depending on which
source control provider your project is bound to.

n Project Opens a submenu, which lets you select a source control
action to be applied to the entire project (as opposed to just the
selected folder or files):

l
Check In All Opens the Check In dialog, which lets you check in all
files in the project into source control.

When you are finished editing files, you can check them in to
source control. Checking in a file overwrites the old copy of the
file in the database with the new one from your local machine.
Even if others are not working on a file, it is a good idea to
periodically check in files for a backup in source control.

You will see this option if your project is bound to Microsoft Team
Foundation Server.

l
Commit All Opens the Commit dialog, which lets you commit all
files in the project into source control.

If your project is bound to Git, committing a file adds your
changes to the local database. When you are ready to add your
local commits to the remote repository, you can push these files
to the remote. If your project is bound to Subversion, committing
a file overwrites the old copy of the file in the source control
database with the new one from your local machine.

You will see this if your project is bound to Git or Subversion.

l
Submit All Opens the Submit dialog, which lets you submit all files
in the project into source control.

When you are finished editing files, you can submit them to
source control. Submitting a file overwrites the old copy of the file
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in the source control database with the new one from your local
machine. So even if others will not be working on that file, it is a
good idea to periodically submit files so that you have a backup in
source control.

You will see this option if your project is bound to Perforce Helix
Core.

l
Check Out All Opens the Check Out dialog, which lets you check
out all files in the project from source control.

When you need to work on any of the Flare Desktop project files,
you can check them out. Checking out files means to copy the
latest source control files to your local Flare Desktop project and
remove the "Read Only" designation from them so that you can
edit the files. A red check mark is displayed next to each file that
is checked out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Helix Core.

l
Get Latest Version All Opens the Get Latest Version dialog, which
lets you "get" all files in the project from source control.

After you bind a Flare Desktop project to a source control
application, you can get the latest version of any of the source
control files. When you do this, you are copying the most current
files stored in the source control application to your local Flare
Desktop project without necessarily checking out the files. This
means that the "Read Only" designation will remain associated
with the files until you check them out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Helix Core.

l
Update All Opens the Get Latest Version dialog, which lets you
update files from source control.
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After you bind a Flare Desktop project to Subversion, you can
update any of the source control files. When you do this, you are
copying the most current files stored in Subversion to your local
Flare Desktop project.

You will see this option if your project is bound to Subversion.

l
Undo Check Out All Opens the Undo Check Out dialog, which lets
you reverse the check-out of all files in the project.

If you have files checked out from source control but do not want
them checked out anymore, you can use the "Undo Check Out"
option instead of checking in the files.

You will see this option if your project is bound to Microsoft Team
Foundation Server.

l
Revert All Opens the Revert dialog, which lets you return files to
their last known state.

If you have modified files from source control but do not want to
keep your modifications, use the "Revert" option instead of
committing the files. While committing the file would save
changes to source control, reverting a file returns it to its
previously committed state and does not commit any of your new
changes to source control. When reverting changes made in Git,
you only revert changes to the file on the branch you are currently
editing. If you have a file that resides on multiple branches, copies
of the file on other branches are preserved.

You will see this option if your project is bound to Git, Helix Core,
or Subversion.

l
Pull Opens the Select Remote for Pull dialog, which lets you
select the remote repository from which you will download
remote files.
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After you select the repository you want to pull from, the remote
files are retrieved from the repository and downloaded to your
local project. If necessary, Flare Desktop will perform a commit
before pulling your files.

You will see this option if your project is bound to Git.

l
Push Opens the Select Remote for Push dialog, which lets you
select the remote repository to which you will upload your local
commits.

After you select the repository you want to push to, your files are
sent to the remote repository. If necessary, Flare Desktop will
perform a commit before pushing your files.

You will see this option if your project is bound to Git.

l
Synchronize Opens the Select Remote for Synchronize dialog to
select the remote for a pull and push of files.

After you select the repository, Flare Desktop pulls the remote
files from the Git repository and merges them with your local
database. Then Flare Desktop pushes your local changes back to
the remote Git repository. If necessary, Flare Desktop will perform
a commit before synchronizing your files.

You will see this option if your project is bound to Git.

l
Branch Opens the Branch Management to create branches,
switch to (select) a different branch, and delete an existing
branch.

A Git branch is a pointer to a snapshot of your changes, or you
can think of it as a variation from the original or main state of
your files. Adding a branch lets you create a new development
area for your work (e.g., when documenting a new feature,
rewriting large sections of a topic, or making structural changes).

CHAPTER 7  341



Option Description

Then later, you can merge the branch into another one.

You will see this option if your project is bound to Git.

l
Disconnect/Reconnect Disconnects the source control network
so you can work offline. You can reconnect at any time.

This is available if your project is bound to TFS, Helix Core, or
Subversion.

l
Network Settings Opens the Network Settings dialog to view and
modify source control network settings from Flare Desktop.

This is available if your project is bound to Git or Subversion.

n
Add Opens the Add File(s) dialog to add the selected files to the
integrated source control application. When working in a project that
is connected to source control, there may be occasions when you
have files in your local copy of the project that are not yet part of the
source control copy. For example, when you add a new topic in your
local copy of the project, that file will not be included in the source
control copy of the project until you add it.

You will see this option for all source control providers.

n
Check In Opens the Check In dialog to check files into source control.
When you are finished editing files, you can check them in to source
control. Checking in a file overwrites the old copy of the file in the
database with the new one from your local machine. Even if others are
not working on a file, it is a good idea to periodically check in files for a
backup in source control.

You will see this option if your project is bound to Microsoft Team
Foundation Server.

n
Commit Opens the Commit dialog, which lets you commit files into
source control.
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When you are finished editing files, you can commit them to source
control. If you are working with Git, committing a file adds your
changes to the local database. When you are ready to add your local
commits to the remote repository, you can push these files to the
remote.

If you are working with Subversion, committing a file overwrites the
old copy of the file in the source control database with the new one
from your local machine.

You will see this option if your project is bound to Git or Subversion.

n
Submit Opens the Submit dialog, which lets you submit files into
source control.

When you are finished editing files, you can submit them to source
control. Submitting a file overwrites the old copy of the file in the
source control database with the new one from your local machine.
So even if others will not be working on that file, it is a good idea to
periodically submit files so that you have a backup in source control.

You will see this option if your project is bound to Helix Core.

n
Check Out Opens the Check Out dialog, which lets you check out files
from source control.

When you need to work on any of the Flare Desktop project files, you
can check them out. Checking out files means to copy the latest
source control files to your local Flare Desktop project and remove the
"Read Only" designation from them so that you can edit the files. A red
check mark is displayed next to each file that is checked out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Helix Core.

n
Lock Opens the Lock dialog, where you can select files you want to
lock. If your project is bound to Subversion, you can steal locks from
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another user's locked files using this dialog. When you are working,
you may want to lock the files you have modified. Locking a file does
not prevent other users from modifying the file. However, no one else
can commit a file that you have locked until you unlock the file. If your
project is bound to Subversion, you can steal a lock from another user
if you need to commit a locked file while they are working on it.
Likewise, another user can steal a lock on a file you have locked.

You will see this option if your project is bound to Helix Core or
Subversion.

n
Unlock Opens the Unlock dialog, where you can select files you want
to unlock. If you have locked a file, you should unlock it when you are
done modifying it. Other users can modify the file while you have it
locked, but they cannot submit a locked file until you unlock it. To help
prevent file conflicts and make sure that everyone on your team has
the most current version of the file, you should unlock and submit the
file when you are finished working on it.

You will see this option if your project is bound to Helix Core or
Subversion.

n
Get Latest Version Opens the Get Latest Version dialog, which lets you
"get" files from source control.

After you bind a Flare Desktop project to a source control application,
you can get the latest version of any of the source control files. When
you do this, you are copying the most current files stored in the source
control application to your local Flare Desktop project without
necessarily checking out the files. This means that the "Read Only"
designation will remain associated with the files until you check them
out.

You will see this option if your project is bound to Microsoft Team
Foundation Server or Helix Core.

n
Update Opens the Get Latest Version dialog, which lets you update
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files from source control.

After you bind a Flare Desktop project to Subversion, you can update
any of the source control files. When you do this, you are copying the
most current files stored in Subversion to your local Flare Desktop
project.

You will see this option if your project is bound to Subversion.

n
Undo Check Out Opens the Undo Check Out dialog, which lets you
reverse the check-out of the files.

If you have files checked out from source control but do not want
them checked out anymore, you can use the "Undo Check Out" option
instead of checking in the files.

You will see this option if your project is bound to Microsoft Team
Foundation Server.

n
Revert Opens the Revert dialog. You can return files to their last
known state.

If you have modified files from source control but do not want to keep
your modifications, use the "Revert" option instead of committing the
files. While committing the file would save changes to source control,
reverting a file returns it to its previously committed state and does
not commit any of your new changes to source control. When
reverting changes made in Git, you only revert changes to the file on
the branch you are currently editing. If you have a file that resides on
multiple branches, copies of the file on other branches are preserved.

This is available if your project is bound to Git, Helix Core, or
Subversion.

n
Show Differences Opens a window pane that lets you view the content
and code differences for files. If you select a single file and choose
this option, the differences between the local version of the file and
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the source control version of the file are shown. If you select two files
and choose this option, the differences between those two files are
shown.

You will see this option for all source control providers.

n
View History Opens the History dialog, which lets you view the history
of a particular source control file, including all of the occasions when
the file has been checked in. You can then use the dialog to view the
differences between older versions of the file or roll back to a
particular version.

You will see this option for all source control providers.

n Undelete Undeletes a file, allowing you to add it to source control. You
will see this option if your project is bound to Microsoft Team
Foundation Server or Helix Core.

n
Refresh Refreshes the window pane so that the latest information is
shown.

You will see this option for all source control providers.

n Pending Changes Opens the Pending Changes window pane. This
displays files in the project that are pending check in (if the project is
integrated with a source control application). Use this window pane to
see which files you have checked out, which files have been created
but not yet added to source control, which files other users have
checked out, and which files are out of date. You will see this option
for all source control providers.

Opens the TOC Editor and highlights the location of the active topic in the
TOC.

Opens the Content Explorer and highlights the location of the selected
content file within it.
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Cuts the selection and sends it to the clipboard.

Copies the selection and sends it to the clipboard.

Pastes the selection from the clipboard to the place where the cursor is
inserted.

Deletes the selection.

Lets you reverse the most recent action in a file. The undo and redo
functions are enhanced in the following ways.

n Unlimited You can undo or redo an unlimited number of times, back to
the last time you opened the file, even after you have saved the
document.

n Multiple Buffers Each document in the interface has its own
Undo/Redo buffer. This means that you can undo actions in one
document and then switch to another document and undo actions
specific to that file.

Lets you repeat the most recent action that you reversed in a file.

Opens the Properties dialog for the selected item.
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Tools in the Project toolbar provide shortcut buttons for some of the most common tasks in Flare
Desktop, such as building and viewing targets, opening the primary target, and adding topics. To
see this toolbar, select View > Toolbars > Project.

Option Description

Opens the Project Properties dialog, which lets you do the following.

n Select a primary table of contents (TOC) for the entire project.
The TOC will be used for all targets in the project. However, you
can also set a primary TOC at the target level. If you do that, the
TOC specified at on the target takes precedence over the
primary TOC set at the project level.

n Select a primary page layout for the entire project.

n Select a primary stylesheet for the entire project.

n Select a language to be used for the project.

n Binding a project to source control.

Builds (generates) the output for the target that is designated as the
"primary" target. When the build process finishes, you are asked if you
want to view the output. ClickYesif you do.

If you click the down arrow, you can select a specific target (not
necessarily the primary target) to generate.

Lets you view the output for the target that is designated as the
"primary" target. If the target has not yet been generated, or if
changes have been made to the project since it was last generated,
you will be asked if you want to build the output. Click Yes if you do.

If you click the down arrow, you can select a specific target (not
necessarily the primary target) to view.
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Publishes the output for the "primary" target to its destination(s). If
the target has not yet been generated, or if changes have been made
to the project since it was last generated, you will be asked if you
want to build the output. Click Yesif you do.

Opens the primary target in the Target Editor.

Opens the primary TOC in the TOC Editor.

Opens the primary stylesheet in the Stylesheet Editor.

Opens the primary page layout in the Page Layout Editor.

Opens the Add File dialog, which lets you create a new topic or import
one from outside the project. .
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Text Format Toolbar
The Text Format toolbar lets you quickly apply formatting to content in your topics and other files.
To see this toolbar, select View > Toolbars > Text Format.

Option Description

Lets you apply a style to the content selected in the topic.

TIP It is likely that you will have certain styles that you
tend to use more than others. You can pin these styles
in various places of the Flare Desktop interface so that
they are always easily accessible.

Lets you select a font type (e.g., Arial, Times New Roman),
applying it to the content selected in the topic.

Lets you select a font size, applying it to the content selected in
the topic.

Applies bold typeface to the content selected in the topic.

Applies italic typeface to the content selected in the topic.

Underlines the content selected in the topic.

Raises the selected content in the topic above the normal line of
text (e.g., X2).

Lowers the selected content in the topic below the normal line
of text (e.g., X2).
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Opens the Font Properties dialog, which lets you edit the font
properties for topic content directly.

Removes local formatting in a selection or even an entire topic.

Lets you choose and apply a color to the selected content.

Lets you choose and apply a color to the background of the
selected content.

You can set redacted text on any kind of content (e.g.,
characters, paragraphs, images, tables). You can do this locally
at the font level by highlighting each piece of content, or you
can specify redaction on a style and then apply that style to
content whenever necessary. It is recommended that you use
styles whenever possible.Redaction occurs when content is
permanently eliminated from a printed or electronic document.
In place of that content, end users will see black rectangles that
indicate where the original content was found.

Aligns the selected content to the left.

Aligns the selected content in the center.

Aligns the selected content to the right.

Spaces the selected content so that both the left and right sides
are aligned.
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Resets the alignment of the selected text to the default
(inherited) setting.
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Lets you select one of several kinds of bullet or numbered lists,
applying it to the selected content.

n Bullet List Applies a bulleted list to the selected content.

n Circle Bullet List Applies a bulleted list to the selected
content. The bullets are circles.

n Square Bullet List Applies a bulleted list to the selected
content. The bullets are squares.

n Numbered List Applies a numbered list to the selected
content.

n Lower-alpha Numbered List Applies a numbered list to the
selected content where lowercase alpha characters are
used (a., b., c., d., etc.)

n Upper-alpha Numbered List Applies a numbered list to the
selected content where uppercase alpha characters are
used (A., B., C., D., etc.)

n Lower-Roman Numbered List Applies a numbered list to
the selected content where lowercase Roman numerals
are used (i., ii., iii., iv., etc.)

n Upper-Roman Numbered List Applies a numbered list to
the selected content where uppercase Roman numerals
are used (I., II., III., IV., etc.)

n
Definition List A definition list is used to create a group of
terms and definitions. It is also sometimes referred to as
a description list, and although it is called a "list," it does
not have bullets or numbers. Instead, it is similar to a
table that doesn't have borders (although it can have
borders, shading, etc. if you edit the necessary styles).

n Custom Format Opens a custom list format that lets you
create a uniquely styled list up to 10 levels deep. You can
also select an existing custom format from this submenu
to apply it to the selected content in your topic or snippet.
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At this time, custom list formats are supported only in
PDF output. After browsers begin to support the CSS3
marker element that makes custom list formats possible,
this feature will automatically be supported in browser-
based outputs as well. Until then, if you want to generate
a browser-based output, you should use the standard
method for creating lists instead.

Lets you shift indented content to the left, thus "outdenting" it.

Lets you shift selected content to the right, thus "indenting" it.
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Lets you apply miscellaneous actions to selected content in a
list. These actions are as follows:

n Merge With Previous List Combines a list with another list
immediately before it.

n Merge With Next List Combines a list with another list
immediately following it.

n Sort List Reorders the items in the list alphabetically.

n Reverse List Reorders the items in the list so that they
appear in reverse order (i.e., first item is last, last item is
first).

n Unbind List Removes the list designation from the
content so that it displays as regular text.

n
Continue Sequence Ensures that the next list you create
in the topic starts with the next number in the sequence
of the list above (even if the two lists are separated by
other content).

EXAMPLE You have a numbered list from 1 to 10
at the top of your topic and you add a few regular
paragraphs (not in a list) after it. If you start
another numbered list and select this option, the
new list will start at 11.

n List Start Number Lets you specify a number to start a
numbered list.

n
Item Number Lets you specify a number to start a
selected item in a numbered list.
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EXAMPLE You have a numbered list from 1 to
10. If you click in the paragraph with the number
7 and then use this option to start numbering at
23, your list would change so the numbering
displayed as 1 to 6, and then 23 to 26.

n Move Up Moves the selected item in the list above the
item before it.

n Move Down Moves the selected item in the list below the
item after it.

n Make Simple Item(s) Lets you return a line in a list from a
paragraph item to a simple item (an <li> tag without a <p>
tag following it). Paragraph items can be used in
numbered or bulleted lists, for example, to add comments
without disrupting the flow of the list.

n Make Paragraph Item(s) Lets you add a <p> tag after the
<li> tag in a numbered or bulleted list. You can then add
more lines after a list item without adding numbers or
bullets to those lines. Paragraph items can be used in
numbered or bulleted lists, for example, to add comments
without disrupting the flow of the list.

If you click on the face of the button, the Insert Table dialog
opens, which lets you insert a table and specify various settings
for it.

If you click the down arrow, you can use a grid to select the
number of rows and columns for a simple table and insert it.
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Review Toolbar
The Review toolbar lets you quickly perform tasks that are part of the review workflow. This
includes sending and importing files for review, inserting and working with annotations, as well as
tracking changes. To see this toolbar select View > Toolbars > Review.

Option Description

Opens the Send File for Review Wizard, which lets you email the active
file (and others) to another person for review.

Opens the File Reviews window pane, which lets you see files that have
been reviewed from others and are pending acceptance.

It also lets you see a list of files that you have sent out for review.

Lets you import a reviewed file into the inbox of the File Reviews
window pane. After that, you can view and/or accept the file. You might
use this feature, for example, if you have received a file from a
reviewer, but rather than immediately sending the file to your inbox
from the email message, you saved it to your local drive.

Enables or disables the track changes feature. 

Opens a sidebar and displays any tracked changes or annotations
(notes) that have been attached to any content in the topic.

Navigates to the previous change or annotation.

Navigates to the next change or annotation.
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Accepts tracked changes or annotations in the active document,
making them part of that document. You can click the down arrow to
accept a single change or all of them.

Rejects tracked changes or annotations in the active document,
removing them from that document. You can click the down arrow to
reject a single change or all of them.

Adds an annotation rectangle, extended to a sidebar to the right, with a
line pointing to the selected content. This rectangle will hold
annotation text after you type it. Also, the selected content is shaded,
indicating that the annotation refers to that text. However, the shading
will not be displayed in the output; it is for internal use only.

Removes annotations from the document. You can click the down
arrow to delete a single annotation or all of them.
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CHAPTER 8

Customizing the Workspace
You can set preferences and customize the workspace in various ways.

This chapter discusses the following:

Accessing Hidden Documents 360

Autohiding Window Panes 361

Customizing Column Information 362

Customizing Column Information in the Builds Window Pane 365

Customizing Window Layouts 369

Minimizing Ribbons 371

Moving, Docking, and Floating User Interface Elements 372

Resizing User Interface Elements 376

Selecting an Interface Color Theme 376

Selecting the Way Tabs are Displayed 377

Switching Between Ribbons and the Tool Strip 379

Using Navigation Buttons in the Title Bar 380
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Accessing Hidden Documents
You can open as many documents as you need in the interface. When you have opened more
documents than can be shown, the hidden documents can be accessed by clicking a drop-down
menu on the right side of the workspace.
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Autohiding Window Panes
In the top-right corner of every window pane, you will see a small button that looks like a pin . If
you click this button, the window pane is hidden (or "pinned" to the edge of the program window).
However, you can still see the title of the window pane along the edge of the program window.
When you hover over the title, the window pane temporarily displays again until you move the
mouse off the window pane. Click the button again to "un-pin" the window pane.
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Customizing Column Information
In certain window panes, information is presented in a grid. You can configure these grids to
change the way the information is displayed. For example, you can hide or show certain columns,
set a background color for a column, or increase the width for a column.

You can use a context menu to simply hide or show certain columns in a window pane, or you can
open the Columns dialog to customize columns even more.

How to Hide or Show Columns From the
Context Menu

1. In the window pane, right-click on any of the column headings.

2. From the context menu, click next to any column name to remove or add the check mark next
to it. If a check mark appears next to a column name, it will be shown in the window pane. If a
check mark does not appear next to it, the column will not be shown.
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How to Customize From the Columns Dialog
1. Open the Columns dialog.

2. Use the options in the dialog to do any of the following.

HIDE A COLUMN

In the Show column, click the check box to remove the check mark next to the column that
you want to hide in the interface.

RESIZE THE COLUMN WIDTH

Double-click in the appropriate Width cell and type the new width in pixels.

SET THE COLOR FOR TEXT IN A COLUMN

a. In the appropriate Color cell, click the down arrow and select Pick Color. The Color
Picker dialog opens.

b. Select the color.

SET THE BACKGROUND COLOR FOR A COLUMN

a. In the appropriate Background cell, click the down arrow and select Pick Color. The
Color Picker dialog opens.

b. Select the color.

CHANGE THE ORDER OF THE COLUMNS

a. Select any of the items in the dialog. The row for that item is highlighted.

b. Click the Move Up or Move Down button to adjust the position of the row.

When you are finished, the item at the top of the dialog will display on the far left in the
final interface. The item at the bottom will display at the far right.

3. Click OK.
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What’s Noteworthy?

NOTE You can also customize column information in the Builds window pane, but the
features are slightly different than those described here.
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Customizing Column Information in
the Builds Window Pane

You can reorder or hide columns in the Builds window pane. There are a few ways to do this.

n First, you can click on a column header and drag it to the right or left, dropping it in a new
location.
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n Second, you can right-click any column header, which displays a menu. Click next to the
column titles (adding or removing check marks) to show or hide those columns in the Builds
window pane.
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n Third, from the right-click menu, you can select Columns. This opens the Manage Columns
dialog.
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Again, you can show or hide columns by adding or removing check marks next to the column
titles. You can also click and drag the rows up or down to change the order of the columns in
the Builds window pane. Finally, you can click Reset to Factory Settings if you want to undo
all of your changes and return to how everything was initially set.

NOTE You can also customize column information in various areas of the user interface,
but the features are slightly different than those described here. See "Customizing Column
Information" on page 362.
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Customizing Window Layouts
When you move window panes, explorers, or editors around in the Flare Desktop interface, the
configuration (or "layout") of the workspace is changed. You can do several things with layouts,
including the following.

How to Save a Window Layout
You can save different layouts of the interface, in case you want to use them for different purposes.

1. Configure the workspace how you want it.

2. Select Window > Save Layout > Save Window Layout As.

3. In the Save Window Layout dialog, enter a name for the layout.

4. Click OK.

How to Auto-Save a Window Layout
You can automatically save the layout of the workspace when you exit Flare Desktop. The next time
you launch Flare Desktop, that same layout will be displayed.

Select Window > Auto-save Layout.

How to Select a Saved Window Layout
You can quickly change the configuration of your workspace by selecting a window layout that you
have saved previously.

Select Window > Layout > [Name of Layout].
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How to Reset the Window Layout
You can return the workspace configuration to the original layout that you saw when you first
installed and launched Flare Desktop.

Select Window > Reset Layout.

How to Reload the Window Layout
You can return the workspace to the saved configuration of the layout. In other words, if you are
working in a particular layout and have opened different interface elements or moved interface
elements around, you can select this option to go back to the saved configuration.

Select Window > Reload Layout.

NOTE Resetting a layout returns the interface to the way it was when you opened Flare
Desktop for the first time. Reloading a layout means returning the interface to your last
saved layout.

How to Delete a Window Layout
You can open the Manage Window Layouts dialog, which lets you select or delete an existing
layout.

1. Select Window > Layout > Layouts.

2. Select the layout that you want to delete.

3. Click Delete.

4. Confirm the deletion by clicking OK.

5. Click Close.
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Minimizing Ribbons
You can minimize the ribbons so that you only see the top portion of the ribbons until you select an
option. To do this, right-click anywhere in a ribbon and select Minimize the Ribbon from the context
menu.
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Moving, Docking, and Floating User
Interface Elements

Simply because a window pane or tab is attached to a particular area of the program window by
default, does not mean it has to stay there.

Floating and Moving Elements
You can float an element that displays with a tab by clicking the tab and dragging it down until it
floats.
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Another way to float an element is to click on it and select Window > Float.

You can move window panes displayed in accordion view by clicking the "Drag Pane" section . To
drag all of the window panes grouped together, click this button in the upper-left corner of the
window pane. To drag a single window pane, click this button in the accordion bar for that window
pane. Hold down your mouse and drag the window panes where you want them. If you drop a
window pane at a random location in the program window, it becomes a "floating" window.
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Docking Elements
Docking an element that is floating means to attach it to a particular part of the program window.
To do this, click in the title bar, drag it to the edge where you want to dock it, and drop it onto one of
the small squares that appear in the interface. The portion of the square that has color indicates
where the window pane will be docked.

Floating Square Description

Dock in center of workspace

Dock on left side of workspace

Dock on right side of workspace

Dock on top side of workspace

Dock on bottom side of workspace
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Resizing User Interface Elements
You can easily resize the program window, dialog windows, and floating window panes in Flare
Desktop by clicking the edge of the element and dragging the mouse to the desired size. You can
also resize drop-down menus in the same way.

Selecting an Interface Color Theme
You can use the Interface tab on the Options dialog (File > Options) to choose a color scheme for
the interface: black, classic, or silver.

How to Select an Interface Color Theme
1. Select File > Options.

2. Select the Interface tab.

3. Click in the Active Theme drop-down and select a color scheme.

4. Click OK.
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Selecting the Way Tabs are Displayed
You can choose how to view window panes in the workspace.

n Accordion Tabs Stacks the document tabs below the window pane or editor.

n Standard Tabs on Top Places the document tabs on the top of the window pane or editor.

n Standard Tabs on Bottom Places the document tabs on the bottom of the window pane or
editor.
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To switch between tab types, right-click in the title bar of the window pane or editor and select a
view.
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Switching Between Ribbons and the
Tool Strip

IMPORTANT The tool strip is deprecated in Flare Desktop, which means that it is slated to
be removed in a future version.

By default ribbons are used when you install and launch Flare Desktop for the first time. However,
you can use the Options dialog to switch back to the classic tool strip, where toolbars and menus
are shown.

How to Switch Between Ribbons and Tool Strip
1. Select File > Options.

2. Select the Interface tab.

3. In the Menu Style section, select Ribbon or Tool Strip.

4. Click OK.
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Using Navigation Buttons in the Title
Bar

Window panes throughout Flare Desktop have a title bar containing options that you can use to
manipulate the interface.

Option Description

Lets you move the window pane from its docked position to another location in the
interface. Simply click on this area and drag the window pane to the new location.

Opens a drop-down menu with commands for moving and resizing the window
pane.

n Close Closes the window pane.

n Dock Attaches the window pane to the interface if it is floating.

n Auto Hide "Pins" the window pane to the side of the interface so that you
have more room for your workspace. You can show the window pane by
hovering over the thin bar on the side of the interface. If you select this
option again, the window pane returns to its previous state (no longer
"pinned" to the side of the interface).

n Float Detaches the window pane from the application so that it becomes a
free-floating element in the interface.

n Standard Tabs (Top) Arranges window panes so that traditional tabs are
displayed at the top.

n Standard Tabs (Bottom) Arranges window panes so that traditional tabs are
displayed at the bottom.

n Accordion Tabs Arranges window panes so that they are stacked with
accordion tabs.

"Pins" the window pane to the side of the interface so that you have more room for
your workspace. You can show the window pane by hovering over the thin bar on
the side of the interface. If you select this option again, the window pane returns to
its previous state (no longer "pinned" to the side of the interface).
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Option Description

Closes the window pane.
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APPENDIX

PDFs
The following PDFs are available for download from the Help system.

Tutorials
Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Flare Online Integration
Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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